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Category
Application
Programming
Interfaces

Name
add_java_class_path

Application
Programming
Interfaces
Application
Programming
Interfaces
Application
Programming
Interfaces
Application
Programming
Interfaces
Application
Programming
Interfaces
Application
Programming
Interfaces
Application
Programming
Interfaces
Application
Programming
Interfaces
Application
Programming
Interfaces
Application
Programming
Interfaces
Application
Programming
Interfaces

enable_protk_xml_schema

Description
Prepends the option value on the java environment variable,
CLASSPATH, used to find classes in J-Link programs. To specify multiple
search paths in the same line, delimit them using ':' on UNIX, and ';' on
Windows NT.
Enables XML-Schema validation for Pro/TK feature XMLs
yes, no

jlink_java2

Option to force use of Java-2 JRE command line ("java" instead of "jre")

prodevdat

Specify the full path to an additional Toolkit registry file.

protkdat

Specify the full path to an additional Toolkit registry file.

toolkit_registry_file

Specify the full path to an additional Toolkit registry file.

web_disable_js_command

Enter a specific javascript command to be disabled

web_link_file_read

PTC Inc.

Values

Default Value

no

off, on

on

Sets Pro/Web.Link permission to read data from the local file system.

yes, no

no

web_link_file_write

Sets Pro/Web.Link permission to write data to the local file system.

yes, no

no

web_link_proe_read

Sets Pro/Web.Link permission to read data from a Creo Parametric
session.

yes, no

no

web_link_proe_write

Sets Pro/Web.Link permission to modify data in a Creo Parametric
session.

yes, no

no

yes, no

yes

web_link_security_autopromp Yes - The Security dialog box is displayed when a Pro/Web.Link function
t
requires security access beyond the current settings.
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Category
Assembly
Assembly
Assembly
Assembly

Assembly
Assembly
Assembly

Name
add_offset_to_constraint_co
mp
advanced_intersection

Description
Adds an offset dimensions to constraints that were created without an
offset during the dragging of a component.
Control the appearance of the intersection tool and scope of available
functionalities.
allow_freeze_failed_assy_co Allow freezing failed assembly components.
mp
allow_package_children
Sets what type of children packaged components can have. ALL Features and components can be a children of packaged component.
FEAT - Only features can be children of packaged components. NONE Packaged components cannot have children.
allow_redo_intersections
Yes - Displays the ReIntersect command in the ASSY FEAT menu.
allow_save_as_instance
Allows the option to save a copy of the active model as a family table
instance.
allow_save_failed_model
Yes - Failed models can be saved. No - Failed models cannot be saved.
Prompt - Let the user decide whether failed models can be saved.

Assembly

allow_update_part_simp_rep Allow updating part Simplified Rep data in session automatically when
_data
switching from one Simp Rep to another. Yes - Allow updating part
simplified rep data. No - Do not update part simplified rep data. Prompt Prompt the user if the current simplified rep should be updated.

Assembly

annot_elem_params_with_un
its
auto_assembly_with_noteboo
ks
auto_constr_always_use_offs
et

Assembly
Assembly

Assembly
Assembly
Assembly
Assembly

PTC Inc.

Values
no

yes, no

no

yes, no

no

all, feat, none

all

yes, no
yes, no

no
no

yes, no, prompt

prompt

yes, no, prompt

yes

Some annotation element virtual parameters which were previous passed
unitless will not be passed as attributes with units.
Yes - Enables automatic assembly. No - Disables automatic assembly.
yes, no

Control whether auto constraint should create offsets. Yes - Auto
constraint alw ays creates offsets. No - Auto constraint snaps align or
mate if surfaces are wi thin tolerance. Never - Auto constraint never create
offsets.
auto_evaluate_simprep_rules If the option is "yes" newly created rep would be updated each time on
retrieve/regeneration.
auto_place_max_number
Set the default value for the maximum number of matches allowed.
auto_update_intersected_mo Control the appearance of the intersection tool and scope of available
dels
functionalities.
autoplace_single_comp
Assembling components with an interface will automatically place the
component at the first position satisfying the interface definitions.
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Default Value

yes, no

1
yes

yes, no, never

no

yes, no

no

yes, no

5
yes

yes, no

yes
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Category
Assembly

Assembly

Assembly
Assembly
Assembly
Assembly
Assembly

Assembly

Assembly
Assembly
Assembly

Name
Description
Values
bump_revnum_on_retr_rege Determines whether or not revision number is increased for generic
yes, no
n
models that regenerate and change during assembly retrieval. Only
applies if new_asm_regen_revnums is yes (otherwise, there will be no
revision number bumping).
can_snap_to_missing_ref
Controls whether to enable snapping to missing references while dragging yes, no
components for placement. Yes - Snapping is enabled while dragging. No Snapping is disabled while dragging.
check_interface_criteria
Check for interfaces when placing a component.
yes, no
check_interference_of_match Show only matches that do not interfere with other components.
yes, no
es
check_same_assy_parts
Determines whether to permit different names for different part
yes, no
occurrences, or not in mirror subassembly UI.
chooser_size_filter_default
Sets the size filter default value as a percentage of the overall assembly
size
comp_angle_offset_eps
Specifies the angle epsilon such that if the desired surfaces are equal or
greater than the epsilon (in degrees), than an angle offset constraint will
be created.
comp_assemble_start
Sets the initial assembly placement behavior when assembling a new
package, constrain_in_window,
component. Default - Default initial position. Package - Define initial
default, move_then_place
position using the Move option. Constraint_in_Window - Use secondary
window. Move_then_Place - Define initial position using the Move option
and then define placement constraints.
comp_placement_assumptio Use placement assumptions when placing components.
yes, no
ns
comp_retr_angular_incremen Sets the accuracy for the selection of external components based on
t
graphic computation.
comp_rollback_on_redef
No - Assembly is not rolled back when the user redefines a component.
yes, no

Default Value
yes

yes

no
yes
yes
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yes
1
yes

Assembly

copy_geom_update_pre_200 Yes - Flags independent copy geom features in a pre-2000i model as
0i_dep
modified when retrieved into Creo Parametric. Save the model
immediately to update the model's copy geom dependency information.

yes, no

Assembly
Assembly

copy_geometry_method
create_temp_interfaces

publish_geometry, references
yes, no

publish_geometry
no

Assembly

dim_inactive_components

never, always, shaded_only

shaded_only

PTC Inc.

Sets the default copy geometry reference(s) type
Allow the automatic creation of interfaces based on previous assembly
instructions.
Display inactive assembly components with stippled transparency and
default color (grey). Default value is shade_only.
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Category
Assembly
Assembly
Assembly

Name
disp_regen_success_msg
enable_advance_collision
enable_assembly_accuracy

Description
Issue successfull regeneration messages for assembly models.
Enables advance collision settings usage.
No - Disables accuracy modification for assembly objects.

Assembly
Assembly

enable_implied_joints
erv_show_external_only

Assembly

fail_ref_copy_when_missing_
orig

Assembly

fix_refs_to_intersections

Assembly
Assembly

force_upd_assem_mp_in_si
mp_rep
grv_default_view

Assembly

ignore_non_displayed_items

Assembly

include_sub_model_interface
s
interface_criteria_mismatch

Allow underconstrained components as mechanism connections.
Yes - Global Reference Viewer will show objects with external references
only; No - all the objects will be visible
Yes - When using a copied geom feature or a backed-up external
reference with the Design Manager, and the reference is missing in the
original, then the copied geom feature fails. No - The feature freezes and
does not update.
Sets remnant removal ability for the ReIntersect command in the ASSY
FEAT menu. Yes - You can remove remnants. No - You cannot remove
remnants.
Update mass properties parameters even when some of the components
of the assembly are not in master rep.
Sets the default view the reference view starts with - Dependencies or
References.
Ignores nondisplayed items when searching the component interface
during component placement.
Includes sub model interfaces as possible references for interface to
interface component placement.
FAIL_PLACEMENT - Fail regeneration upon component interface criteria
mismatch. WARNING_ONLY - A warning message is given during
regeneration for the criteria mismatch only without failure. IGNORE Interface criteria mismatch ignored during regeneration.
Enables the modification of the value of offset dimensions during
component dragging.
Yes - Allows adding an MP_DENSITY column in FT when a material is
assigned to a model. When set may cause the same material to have
different values for the Density parameter in different instances. Does not
affect legacy models.
If set to "Yes" Creo Parametric will automatically convert units in materials
from a library to the model system of units.
Yes - Use Component Chooser base Simp Rep UI, No - Use old Simp
Rep definition UI.

Assembly

Assembly
Assembly

modify_offset_during_comp_
drag
mp_dens_ft_column_mtrl_as
signed

Assembly

mtrl_convert_units

Assembly

new_wf5_simp_rep_ui

PTC Inc.
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Values

Default Value

yes, no
yes, no
yes, no

no
no
yes

yes, no
yes, no

yes
no

yes, no

yes

yes, no

no

yes, no, use_stored

use_stored

references, dependencies

references

yes, no

no

yes, no

yes

ignore, warning_only,
fail_placement

warning_only

yes, no

no

yes, no

no

yes, no

yes

yes, no

yes
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Category
Assembly

Name
package_constraints

Description
Action to take for packaged components in Assembly mode. Update Updates components if assembly changes. Freeze - Does not move
components if assembly changes. Disallow - Does not allow packaged
components in assembly (must be fully constrained).

Values
disallow, freeze, update

Default Value
update

Assembly

package_ref_alert

Control whether alert dialog is given when packaged component is
referenced. Yes - Allow alert when a packaged component is referenced.
No - No Alert is given when a packaged component is referenced.

yes, no

no

Assembly

preserve_comp_color_in_pre Yes - During component placement, component being assembled will
view
retain its normal colors. No - During component placement, component
being assembled is shown in preview color.
regen_notebook_w_assem
Specifies whether or not the notebook will be automatically regenerated
upon assembly regeneration.
replace_comp_name_metho Sets the naming convention used when replacing components.
d
replace_history_rule_order
Set the default order of the history evaluation rule in the replace operation.
Disable - the evaluation rule will be disabled by default. Number - set the
order of the rule relative to other evaluation rules.
replace_interface_rule_order Set the default order of the interface evaluation rule in the replace
operation. Disable - the evaluation rule will be disabled by default. Number
- set the order of the rule relative to other evaluation rules.
replace_sameid_rule_order Set the default order of the same id evaluation rule in the replace
operation. Disable - the evaluation rule will be disabled by default. Number
- set the order of the rule relative to other evaluation rules.
replace_samename_rule_ord Set the default order of the same name evaluation rule in the replace
er
operation. Disable - the evaluation rule will be disabled by default. Number
- set the order of the rule relative to other evaluation rules.
replace_sameparam_rule_or Set the default order of the same parameters evaluation rule in the replace
der
operation. Disable - the evaluation rule will be disabled by default. Number
- set the order of the rule relative to other evaluation rules.

yes, no

no

yes, no

yes

transfer, remove, preserve

transfer

1, 3, 2, disable, 4, 5

3

1, 3, 2, disable, 4, 5

1

1, 3, 2, disable, 4, 5

5

1, 3, 2, disable, 4, 5

2

1, 3, 2, disable, 4, 5

4

yes, no

no

instance_deps_only,
instance_and_generic_deps,
instance_req_generic

instance_req_generic

Assembly
Assembly
Assembly

Assembly

Assembly

Assembly

Assembly

Assembly

Assembly

PTC Inc.

replace_unrelated_automatic Availability of automatic reference pairing in unrelated replace. No Automatic reference pairing is not available. Yes - Automatic reference
pairing is available.
retrieve_instance_dependenc Determines whether to retrieve the dependencies of the generic when an
ies
instance is retrieved.
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Category
Assembly

Name
rv_current_object

Assembly

rv_search_scope

Assembly
Assembly

search_area_for_comp_interf
aces
search_not_retrieved_models

Assembly

sel_insts_on_comp_retrieval

Assembly

show_interference_in_section
s
shrinkwrap_alert

Assembly
Assembly

Assembly
Assembly

Assembly

Assembly

Assembly

PTC Inc.

Description
Will control default option when setting a model or component as the
current object.
Sets the search scope for children when entering the reference viewer.
Session - Search all objects in session. Window - Search objects in the
active window only.
Defines the search area for the component interface as a percentage of
the component size during component placement.
Expands search to include models that have not been retrieved into
session. If Yes, models will be brought into session possibly causing
performance issues.
Yes - If the components used in the assembly instances are themselves
generics, the systems asks if you want to choose an instance as each
component is retrieved. No - The generic model of the component is
retrieved automatically.
Yes - Interference will be shown automatically, No - interference will not be
shown automatically.
Displays the Shrinkwrap alert the first time the quality level is increased.

simple_search_consider_sele Defines whether simple search executes query only inside selected
ct
models (if some models selected) or always in scope of entire top-level
model.
simprep_default_model_statu Determines the default model status while defining a new simplified rep.
s
simprep_ondemand_selectio Determines the rep to be retrieved when selecting a reference. Automatic
n
Retrieves the minimum rep required to perform the operation.

Values
Default Value
model, component, component component + model
+ model
session, window
session

100
yes, no

yes

yes, no

no

yes, no

no

yes, no

yes

yes, no

no

master, geometry, exclude,
graphics, light graphics rep
automatic, master, disable

exclude

simprep_ondemand_settings Determines on-demand retrieval behavior in simplified representation
prompt, disable, never_prompt
views. Prompt - Ask for confirmation before retrieving on-demand.
Never_prompt - Retrieve models on-demand automatically with no
confirmation. Disabled - on demand is disabled.
skeleton_model_default_colo Specifies the color Creo Parametric uses to display new skeleton models.
r
The three decimal values ranging from 0 through 100 specify (in order) the
percentages of red, green, and blue in the resulting color. For example, 0
0 49 specifies medium blue.
snap_to_constraints_during_ Enables the dynamic snapping to constraints during the dragging of
yes, no
drag
components.
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automatic

never_prompt

0.000000 75.000000
100.000000

yes
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Category
Assembly

Assembly Process

Name
Description
update_copy_geom_location Yes-Copy Geometry will try to update location of copied geometry based
on changes to component placements even if some components are
excluded or in graphics rep.
update_rep_refs
"Yes" updates top assembly simplified reps for replacements during
regeneration and upon replacement.
use_3d_thumbnail_in_lwg_re Control the usage of 3D thumbnails when retrieving in light weight graphic
p
representation
use_active_model_in_transfo Transform analysis default behavior: use active model CSYS and units or
rm
not.
curr_proc_comp_def_color
Specifies the default color used to display the current component in a
process assembly.
curr_proc_comp_def_font
Specifies the default font used on the current component in a process
assembly.
display_comps_to_assemble Yes - The design model goes into memory and displays. Pick process
components from the design model or the Model Tree. No - Only the
Model Tree displays. As you pick process components from the Model
Tree, they go into memory.
offset_line_def_color
Specifies the color that offset lines are displayed in drawings.

Assembly Process
Assembly Process

offset_line_def_font
prev_proc_comp_def_color

Assembly Process

prev_proc_comp_def_font

Casting & Mold
Design
Casting & Mold
Design
Casting & Mold
Design
Casting & Mold
Design
Casting & Mold
Design

allow_shrink_dim_before

Specifies the font in which offset lines are displayed in drawings.
Specify the default color for components added to a process assembly in
a previous step.
Specify the default font for previously added components in a process
assembly.
Allow calculation before relations.

default_mold_base_vendor

Default Value for Mold Base vendor.

Assembly
Assembly
Assembly
Assembly Process
Assembly Process
Assembly Process

PTC Inc.

default_shrink_formula

Default option of shrinkage formula: 1/(1-S) - ASME standard or 1+S
(simple).
mold_layout_origin_name
Sets a specified coordinate system as the default for the cavity layout
origin.
mold_vol_surf_no_auto_rollb Do not perform automatic rollback while modifying mold volumes or
ack
parting surfaces.
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Values

Default Value

yes, no

yes

yes, no

yes

yes, no

yes

yes, no

no
0.000000 0.000000
0.000000

yes, no

yes

0.000000 0.000000
0.000000
0.000000 0.000000
0.000000

yes, no

no

futaba_mm, dme, hasco,
dme_mm, hasco_mm
asme, simple

simple

yes, no

no
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Category
Casting & Mold
Design

Name
pro_catalog_dir

Description
Sets the path to the catalog directory containing the catalog menu and the
names of other catalog files, such as ejector pins. For example:
pro_catalog_dir proe_loadpoint/apps_data/mold_data/catalog. Use full
path name to avoid problems.

Casting & Mold
Design
Casting & Mold
Design

pro_cav_lay_rule_dir

Colors

color

Colors

color_ramp_size

Sets the default directory for cavity layout rules. Use the full path name to
avoid problems.
Determines how dimensions are displayed when shrinkage is applied to a final_value, percent_shrink
model with Pro/MOLDESIGN. Percent_shrink - Dimensions appear with
the shrinkage percent.
Turns the colors on or off. Turning colors off displays the model wireframe yes, no
in white.
Specifies the number of shades in a color ramp. Applicable to multi-color,
shaded model displays of simulation / analysis results. System graphics
must support 256 colors and color maps that compress.

Colors

color_resolution

Colors
Colors
Colors
Colors
Colors
Colors
Colors

Colors

PTC Inc.

shrinkage_value_display

Values

Specifies minimum allowable deviation between user-defined colors.
Colors having RGB values within tolerance of existing colors cannot be
created. Decreasing this setting allows more colors that are very similar in
RGB value to be defined.
global_appearance_file
Material Global Appearance file path.
mat_assign_appearance
Control whether default appearance in material definition is automatically yes, no
assigned to a part.
number_user_colors
Specifies the maximum number of different wireframe colors that can
display in the graphics area(s) at any given moment.
pro_colormap_path
Specifies the directory path for a color map (.map) file to be loaded from
disk. Use the full path name to avoid problems.
reflection_analysis_display
Black and White displays reflection as black and white stripes. Surface
black and white, surface color
color - uses the surface color to represent reflection stripes.
suppress_appearance_mess Suppress the Lightworks appearance conversion notification dialog.
yes, no
age
system_background_color
Defines default graphics area background color. The three decimal values
specify (in order) percentage of red, green and blue in the resulting color.
For example, 0 0 49 specifies a medium blue. Change in session using
View>Display Settings>System Colors.
system_colors_file
Specifies the system color file. Use the full path name to avoid problems.
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Default Value

percent_shrink

yes
-1

0.1

yes
-1

black and white
no
0.000000 0.000000
0.000000
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Category
Colors

Colors

Colors

Colors

Colors

Colors

Colors

Colors

Colors

PTC Inc.

Name
system_curves_color

Description
Defines default curve color. The three decimal values specify (in order)
percentage of red, green and blue in the resulting color. For example, 0 0
49 specifies a medium blue. Change in session using View>Display
Settings>System Colors.
system_dimmed_menu_color Defines default secondary highlight color. The three decimal values
specify (in order) percentage of red, green and blue in the resulting color.
For example, 0 0 49 specifies a medium blue. Change in session using
View>Display Settings>System Colors.
system_edge_high_color
Defines default edge highlight color. The three decimal values specify (in
order) percentage of red, green and blue in the resulting color. For
example, 0 0 49 specifies a medium blue. Change in session using
View>Display Settings>System Colors.
system_geometry_color
Defines default color of solid wireframe entities. The three decimal values
specify (in order) percentage of red, green and blue in the resulting color.
For example, 0 0 49 specifies a medium blue. Change in session using
View>Display Settings>System Colors.
system_hidden_color
Defines default color of hidden, wireframe entities. The three decimal
values specify (in order) percentage of red, green and blue in the resulting
color. For example, 0 0 49 specifies a medium blue. Change in session
using View>Display Settings>System Colors.
system_highlight_color
Defines default primary highlight color. The three decimal values specify
(in order) percentage of red, green and blue in the resulting color. For
example, 0 0 49 specifies a medium blue. Change in session using
View>Display Settings>System Colors.
system_letter_color
Defines default color of datum tags. The three decimal values specify (in
order) percentage of red, green and blue in the resulting color. For
example, 0 0 49 specifies a medium blue. Change in session using
View>Display Settings>System Colors.
system_section_color
Defines default section color. The three decimal values specify (in order)
percentage of red, green and blue in the resulting color. For example, 0 0
49 specifies a medium blue. Change in session using View>Display
Settings>System Colors.
system_sheetmetal_color
Defines default color of Sheetmetal parts. The three decimal values
specify (in order) percentage of red, green and blue in the resulting color.
For example, 0 0 49 specifies a medium blue. Change in session using
View>Display Settings>System Colors.
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Values

Default Value
0.000000 0.000000
0.000000

0.000000 0.000000
0.000000

0.000000 0.000000
0.000000

0.000000 0.000000
0.000000

0.000000 0.000000
0.000000

0.000000 0.000000
0.000000

0.000000 0.000000
0.000000

0.000000 0.000000
0.000000

0.000000 0.000000
0.000000
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Category
Colors

Data Exchange

Description
Defines default color of Manufacturing volumes. The three decimal values
specify (in order) percentage of red, green and blue in the resulting color.
For example, 0 0 49 specifies a medium blue. Change in session using
View>Display Settings>System Colors.
use_part_color_for_hidden_li Determines how to color the hidden lines of parts that have user defined
nes
colors. "YES" - Use the dimmed part color for hidden lines.
SYSTEM_HIDDEN_COLOR is ignored if it has been specified.
custom_rainbow
Used to specify fringe colors in Pro/FEM-POST results. Specify blue,
black, cyan, magenta, green, yellow, red, and white. Enter colors as a
dash-delimited string (lowest to highest value). The default is blue-cyangreen-yellow-red-magenta-white.
sim_hyperelastic_material_fit Sets the default method for calculating coefficients for hyperelastic
materials. If set to "normalized", normalized stresses will be used. If set to
"non-normalized", non-normalized stresses will be used.
acis_export_params
For ACIS interface allows to export object, feature and entity level
parameters.
acis_export_units
Allows selection of model units for ACIS export.

Data Exchange
Data Exchange
Data Exchange

afx_enabled
Loads AFX application.
allow_flat_to_screen_note
Allow creation of flat to screen notes when option is set to true
atb_auto_check_on_activate Sets state of ATB 'Auto Check Status On Activate' toggle.

micron, mm, default, in, ft, m,
cm
yes, no
yes, no
off, on

Data Exchange

atb_auto_check_on_retrieve Sets state of ATB 'Auto Check Status On Retrieve' toggle.

off, on

on

Data Exchange

atb_auto_check_on_update

off, on

off

Data Exchange
Data Exchange

atb_ident_cadds_files
Allows to identify CADDS files in the file open browser.
atb_prod_asm_upd_by_comp Allows to update a Pro/DESKTOP assembly based on assembly
_ids
component ids, if set to YES. Otherwise, the update will be based on
component names.
atb_show_foreign_name
Displays foreign source model name in the model tree for imported
models.
atb_show_log
Sets state of ATB 'Show Log' toggle.
auto_associate_dimensions If set to yes, Creo Parametric will attempt to take imported dimensions
that are not associative and link them to geometric entities so that they act
as associative.

yes, no
yes, no

no
yes

yes, no

yes

off, on
yes, no

on
no

Colors

Creo Simulate

Creo Simulate

Data Exchange

Data Exchange
Data Exchange
Data Exchange

PTC Inc.

Name
system_volume_color

Sets state of ATB 'Auto Check Status On Update' toggle.
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Values

Default Value
0.000000 0.000000
0.000000

yes, no

no

normalized, non-normalized

normalized

yes, no

no
default
yes
no
off
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Category
Data Exchange

Data Exchange

Name
board_bend_notes_dflt_displ
ay
board_bend_notes_direction_
down
board_bend_notes_direction_
up
board_bend_notes_order
board_bend_notes_type_for
med
board_bend_notes_type_rolle
d
board_bend_table_directory

Data Exchange

board_design_rules_directory

Data Exchange

board_drive_bend_by_param
eters
board_drive_tools_by_param
eters
board_flange_shape_sketche
s_dir
board_flat_shape_sketches_ Sets path to directory that contains the Flat shapes.
dir
board_parameters_directory Specifies the directory to save/retrieve board parameters files. Use full
name and path to avoid problems.
cadds_import_layer
Allows import of CADDS5 layering.
catia_out_to_existing_model Append - If the selected CATIA model already exists, the new data is
appended to the existing CATIA file. Overwrite - If the selected CATIA
model already exists, the newly exported file overwrites the existing one.

Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange

Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange

Data Exchange
Data Exchange

PTC Inc.

cgm_use_pentable
cri_grafting_enable

Description
Define the default state of bend note display (board mode)

Values
yes, no

Default Value
yes

Defines the down direction symbol for board bend notes.

default

Defines the up direction symbol for board bend notes.
Defines the fields order for board bend notes.
Defines the formed symbol for board bend notes.

&type&direction&angle
default

Defines the rolled symbol for board bend notes.

default

Will be used to set the bend allowance table only. Sets the default
directory of the board bend allowance table files. If not set, the system
supplied bend tables are used. Use the full name and path to avoid
problems.
Will be used to set the design rules file folder only. Will be used by the
design rules manager. Sets the default directory of the board design rules
files. Use the full name and path to avoid problems.
Board bend radius and bend angle values and bend dimension location
yes, no
will be driven by feature-level relations to board parameters.
Drives the board options and values by feature-level relations to board
yes, no
parameters.
Sets path to directory that contains the Flange shapes.

yes

yes, no
append, overwrite

No - Do not use a defined pen table for formatting of CGM export.
yes, no
Activates "Graft features" button under File menu. This allows user to graft yes, no
features created in CRI model to active model.
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no

yes
append

no
no
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Category
Data Exchange

Name
Description
dazix_default_placement_unit Specifies the units to be used for data imported in Dazix files.

Values
micron, mm, thou

Data Exchange

dazix_export_mounthole

yes, no

no

Data Exchange
Data Exchange
Data Exchange

dazix_z_translation
direct_vrml
dwg_export_format

yes
no
2013

Data Exchange

dxf_block_to_pro_symbol

yes, no
yes, no
14, 2000, 2004, 2007, 2010,
2013
yes, no

Data Exchange

dxf_export_format

2013

Data Exchange
Data Exchange

dxf_in_faceted_brep
dxf_out_comments

12, 13, 14, 2000, 2004, 2007,
2010, 2013
yes, no
yes, no

yes
yes

Data Exchange

dxf_out_drawing_scale

yes, no

no

Data Exchange

dxf_out_scale_views

yes, no

no

Data Exchange

dxf_out_sep_dim_w_breaks

YES - Breaks dimensions with breaks on witness lines to separate entities yes, no
and preserves the original picture. No - Exports such dimensions as DXF
DIMENSION entities and removes the breaks on witness lines.

no

Data Exchange

dxfio_in_sjis

yes

Data Exchange

ecad_area_default_import

Determines if the SJIS is supported when importing/exporting DXF files in yes, no
Japanese
Defines how imported ECAD areas are treated. Cosm_area - Treats
3d_volume, cosm_area
imported ECAD areas as cosmetic area features. 3d_volume - Imports
ECAD areas with Z-heights as a 3D enclosed quilt.

PTC Inc.

Yes - Causes the MOUNTHOLE section of a Dazix file to be processed as
a mount hole. No - Causes the MOUNTHOLE section to be processed as
a cut.
Yes - Passes the objects in the .edn files through z translation.
Yes - Enables direct VRML conversion.
Provides the ability to choose DWG file version when exporting from Creo
Parametric drawing.
Specifies whether or not DXF BLOCKS to be imported as Creo Parametric
symbols. Yes - Imports BLOCKS as symbol definitions, No - Imports
BLOCKS as separate entities.
Provides the ability to choose DXF file version when exporting from Creo
Parametric drawing.
Default, faceted boundary representation is allowed in import.
YES - comments (999 group codes) will be created in DXF file exported
from Creo Parametric. NO - DXF file will be created without comment
lines.
Specify whether or not to export drawing scale to the DXF or DWG file.
Yes - Includes a scale factor DIMLFAC in the exported DXF/DWG. No Exports without using a scale for the drawing. Set to Yes when exporting
to read into AutoCAD.
Specify whether or not to scale drawing views when exporting to the DXF
or DWG file. Yes - rescales the entire drawing in such a way that the main
view scale becomes 1:1. No - exports without rescaling.
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Default Value

no

cosm_area
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Category
Data Exchange

Data Exchange

Data Exchange
Data Exchange

Data Exchange
Data Exchange

Data Exchange

Data Exchange
Data Exchange
Data Exchange

Name
Description
ecad_board_csys_def_name Specifies the default coordinate system name added to an ECAD board
being imported. If you do not set this variable, the system prompts you for
a name.
ecad_comp_csys_def_name Specifies the default coordinate system name added to an ECAD
component being imported. If you do not set this variable, the system
prompts you for a name.
ecad_comp_layer_map
Allow layer mapping for ECAD component's import into Assembly.
ecad_comp_naming_convent ECAD_NAME / ECAD_ALT_NAME - Uses the components package
ion
name or part number as the part name.
ECAD_NAME_ECAD_ALT_NAME - Concatenates the component's
package name and part number as the part name.
ecad_comp_xsec_def_name Will allow pre-setting default X-section to be used for component outline
output to *.eda format.
ecad_create_hint_add
Assists in creation of an ecad_hint.map file. Yes - Automatically renames
components, if necessary, each time library of component outlines is
imported to Creo Parametric. This does not create an ecad_hint.map file.
It controls if ecad_hint.add is created.
ecad_default_comp_height
Sets default value and units for an ECAD component being imported.
Units can be: inch, mil (1E-3 inches), thou (1E-6 inches), cm, mm, micron
(1E-6 meters), dsu (1E-8 meters). If not set, the system uses the current
component's units.
ecad_default_comp_place_st Sets default component placement status for export (parameter setting will
atus
override the default).
ecad_edmd_out_version
Set the EDMD output version.
ecad_exp_both_two_areas
Supports the export of ECAD areas with different "Above Board" and
"Below Board" conditions. "yes" - Enables you to export both sided keepin/keep-out ECAD areas as two individual areas (top and bottom).

Values

Default Value

yes, no
ecad_name,
ecad_name_ecad_alt_name,
ecad_alt_name

yes
ecad_name

yes, no

yes

-1.000000
ecad_unit_not_set

unplaced, fixed, placed, mcad,
ecad
2.0, 1.2, 3.0
yes, no

placed
2
no

Data Exchange

ecad_export_cuts_as_holes

Exports Creo Parametric cuts as holes to ECAD systems.

yes, no

yes

Data Exchange

ecad_export_holes_as_cuts

Exports Creo Parametric holes as cuts to ECAD systems.

yes, no

no

Data Exchange

ecad_import_holes_as_featur Import sections specified as DRILLED_HOLE as through-all holes. Boards yes, no
es
created with Creo Parametric drilled holes export with default value of
NPTH for the ECAD_HOLE_TYPE parameter. Create this feature
parameter if a value of PTH is needed (IDF 2.0/3.0).

PTC Inc.
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Category
Data Exchange
Data Exchange

Name
Description
ecad_import_relative_accura Defines the relative accuracy used in ECAD import.
cy
ecad_load_filtered_holes_to_ Controls whether "ECAD import holes configs" (ecad_pin_hole_import &
ecad_via_hole_import) will remove holes completely from the import
ui
(default) or just pre-set the holes filter UI condition.

Values

yes, no

no

Data Exchange

ecad_mapping_file

Data Exchange

ecad_missing_component_st Setup default status for missing components in "Investigate Placement"
keep_missing, delete_missing
atus
Dialog.
ecad_mtg_hole_import
Setup the default for the import of ECAD Holes type MTG (IDF 3.0 or IDX yes, no, as lightweight
ONLY)
ecad_other_outl_csys_def_n Specifies the default coordinate system name for the .OTHER_OUTLINE
ame
section of an IDF 2.0 ECAD component being imported. If you do not set
this variable, the system uses ECAD DEFAULT as coordinate system
name.
ecad_outline_ents_enhanced Enhanced export of special entities to ECAD formats. Yes - Attempt to
yes, no
_exp
approximate arcs and lines. No - Use part accuracy to approximate lines.

Data Exchange
Data Exchange

Data Exchange

Data Exchange
Data Exchange

Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange

PTC Inc.

Default Value
0.0012

Specify the ecad_hint.map file that will be used for ECAD operations.
keep_missing
yes

yes

ecad_outline_holes_exp_met Select how holes that are placed on the board outline be exported.
default, arcs
default
hod
ecad_panel_csys_def_name Specifies the default coordinate system name added to an ECAD panel
being imported. If you do not set this variable, the system prompts you for
a name.
ecad_pin_hole_import
Set up the default for the import of ECAD Holes from type PIN (IDF 3.0 or yes, no, as lightweight
no
IDX ONLY)
ecad_reject_strategy
Configures the way the changes are rejected.
ui_based, as_original, as_base ui_based
ecad_set_intercomm_compat Yes - Set both EDA format version and output method to support
ible
InterComm product, yes or no.
ecad_tool_hole_import
Setup the default for the import of ECAD Holes type TOOL (IDF 3.0 or IDX
ONLY)
ecad_via_hole_import
Set up the default for the import of ECAD Holes from type VIA (IDF 3.0 or
IDX ONLY)
ecadcollab_accept_color
ECAD Collaboration Accept color
ecadcollab_auto_redef_areas Automatically redefine ECAD Areas affected by collaboration changes
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yes, no

no

yes, no, as lightweight

yes

yes, no, as lightweight

yes

yes, no

0.0 255.0 0.0
yes
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Category
Data Exchange
Data Exchange
Data Exchange

Name
Description
ecadcollab_auto_redef_comp Automatically redefine components affected by collaboration changes
s
ecadcollab_auto_redef_holes Automatically redefine holes affected by collaboration changes

Data Exchange

ecadcollab_preview_after_col
or
ecadcollab_preview_before_c
olor
ecadcollab_preview_level
ecadcollab_reject_color
ecadcollab_scan_des_on_ar
ea_chg
ecadcollab_scan_des_on_br
d_chg
ecadcollab_scan_des_on_co
mp_chg
ecadcollab_scan_des_on_hol
e_chg
ecadcollab_supp_failed_feats

Data Exchange

ecadcollab_suppress_cuts

Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange

Data Exchange
Data Exchange
Data Exchange

Data Exchange

Data Exchange
Data Exchange
Data Exchange

PTC Inc.

Values

Default Value

yes, no

yes

yes, no

yes

ECAD Collaboration Preview After color

255.0 127.0 0.0

ECAD Collaboration Preview Before color

0.0 76.0 255.0

ECAD Collaboration preview Level
ECAD Collaboration Reject color
Check for affected objects resulting from ECAD Areas collaboration
changes
Check for affected objects resulting from board collaboration changes

full, partial, light
yes, no

partial
255.0 127.0 127.0
yes

yes, no

yes

Check for affected objects resulting from components collaboration
changes
Check for affected objects resulting from holes collaboration changes

yes, no

yes

yes, no

yes

Suppress of failed features on Object changes

yes, no

yes

yes, no

yes

yes, no

no

yes, no

no

yes, no

no

yes, no

no

yes, no

no

yes, no

no

Automatically suppress cut features in case of board collaboration
changes
enable_acis_export_extensio Enable ACIS export extension.
n
enable_cadra_export
Enables the CADRA command in the EXPORT menu. This enables the
creation of a CADRA specific IGES file.
explode_iges_dimension_not Controls how dimensions are treated when importing an IGES drawing file.
e
Yes - Each IGES dimension explodes into an independent note with the
dimension text and a dimension with an empty note. No - Dimensions are
treated as before.
export_3d_force_default_na Specify whether the Creo Parametric model names should be used for
ming
STEP export. Yes - Use default naming. No - Add suffixes to model file
names.
export_to_shipit
Enable Ship-it interface export.
extend_cvpath
Extends CVPATH search path for CADDS5 data exchanging.
fix_autocad_iges_text_scale Fixes scaling problems with AutoCAD releases earlier than Release 10.
Yes - Repairs AutoCAD files appropriately.
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Category
Data Exchange
Data Exchange

Name
fix_catia_iges_sym_note

Description
Corrects a problem caused by multiple rotations of a note in a CATIA
yes, no
IGES file. Yes - Rectifies any discrepancies.
fix_imported_set_view_orient Sets viewing characteristics for imported CATIA SET files. Yes - Files can yes, no
have translated views. No - Files cannot have translated views.

Values

Default Value
no
no

Data Exchange
Data Exchange

frt_enabled
iges_clip_view_ent

Loads feature recognition application.
yes, no
Determines whether IGES entities are clipped with regards to IGES views. yes, no
YES - Entities outside the view outline are clipped. NO - No clipping.

no
yes

Data Exchange

iges_clip_view_note

no_clip, full_clip, partial_clip

no_clip

Data Exchange

iges_export_dwg_views

yes, no

no

Data Exchange

iges_in_dwg_color

yes, no

no

Data Exchange

iges_in_dwg_line_font

Determines how IGES notes are clipped with regards to IGES views.
No_clip - No clipping. Full_clip - Notes that are partially outside the view
outline are clipped. Partial_clip - Notes completely outside the view outline
are clipped.
Yes - Exports drawing view information. No - Does not export drawing
view information.
Yes - Import RGB information to IGES files. The color definition entities in
the IGES file are imported to the drawings as user-defined colors. No The color-definition entities in the IGES files are ignored when importing to
the drawing.
Controls the import of user-defined line fonts. Yes - Give default names to
user-defined line styles without names in order ("IGES_1," "IGES_2" etc.).
No - Imports the user-defined line fonts as Solid line font.

yes, no

no

Data Exchange

iges_in_group_to_dwg_layer Yes - Converts an IGES group to drawing layers. No - The IGES group is
not converted.
iges_note_disp
Determines what to do when IGES note entities do not point to any views
or the drawing entity. See the configuration option iges_zero_view_disp.

yes, no

no

as_geometry, all_views,
no_views, as_is

all_views

iges_out_all_srfs_as

128, 114, default

default

flat, one_level, all_levels,
all_parts

flat

yes, no

no

Data Exchange

Data Exchange

Data Exchange

Data Exchange

PTC Inc.

Default - Outputs all surfaces as appropriate IGES surfaces. 114 - This
option applies only to representations of surface shape. Trimmed surface
entities (type 144) are exported regardless of setting. 128 - Outputs all
surfaces as IGES B-spline surfaces.
iges_out_assembly_default_ Set default for assembly export via IGES. Flat - Single level model.
mode
One_level - Assy structure with pointers to components. All_levels - Assy
structure with all comps to IGES files. All_parts - Assy to IGES files with
geom info of comps and assy feats.
iges_out_catia_gdt_width
Yes - Enables the desired width of a gtol symbol to be exported to CATIA.
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Category
Data Exchange

Name
iges_out_catia_notes

Data Exchange

iges_out_dwg_color

Data Exchange

iges_out_dwg_line_font

Data Exchange

iges_out_ent_as_bspline

Data Exchange

iges_out_jamais_compliant

Data Exchange

iges_out_mil_d_28000

Data Exchange

iges_out_spl_crvs_as_126

Data Exchange

iges_out_spl_srfs_as_128

Data Exchange

iges_out_start_note

Data Exchange

iges_out_symbol_entity

Data Exchange

iges_out_trim_curve_deviatio Sets the maximum value for the distance between an XYZ trimming curve
n
(boundary) and the underlying surface of a trimmed surface
iges_out_trim_xyz
Controls whether or not XYZ data is output in addition to UV data for
yes, no
trimmed surfaces.
iges_out_trm_srfs_as_143
Yes - Exports all surfaces to IGES entities 141 and 143. This overrides
yes, no
option iges_out_trm_xyz.
iges_zero_view_disp
When IGES geometry does not point to any views or the drawing entity.
all_views, no_views, as_is
All_views - Creates a copy of the entity for each view. No_views - Does
not create the entity at all. As_is - Creates the entity once, using only its
own transformation information.

Data Exchange
Data Exchange
Data Exchange

PTC Inc.

Description
Yes - Breaks a large note (greater than 70 strings) down into smaller
notes, each producing an IGES entity.
Yes - Enables the export of RGB information to IGES files. The userdefined colors in the drawing are exported to an IGES file as color
definition entities. No - Ignores the user-defined colors in the drawing
when exporting IGES file.
Controls the export of user-defined line font through IGES. No - Exports all
geometry as solid font.
True - Exports all geometry entities, other than lines or arcs, as thirddegree B-splines. False - Does not export entities as third-degree Bsplines.
Yes - Specifies IGES output with special JAMA-IS subset specification,
compliant with the version 1.02 of JAMA-IS (Japan Automobile
Manufacturers Association IGES Subset Specification). No - Specifies
normal IGES.
Yes - Specifies IGES output that uses the MIL-D-28000 entity subset.

Values

Default Value

yes, no

no

yes, no

no

yes, no

no

true, false

FALSE

yes, no

no

yes, no

no

Converts all part geometry spline curves to IGES entity 126 (B-spline)
when creating an IGES file.
Converts all part geometry spline surfaces to IGES entity 128 (B-spline)
when creating an IGES file.
Yes - Exports the text specified by system_iges_header_file and
user_iges_header_file as a note on the drawing. To control note
placement, use the configuration file option put_iges_drawing_entity.

yes, no

yes

yes, no

yes

yes, no

no

Exports a drawing symbol as an IGES general symbol entity, IGES type
number 228 (yes), or as its component entities: notes and lines.

yes, no

yes
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Category
Data Exchange

Data Exchange
Data Exchange
Data Exchange

Description
Values
Specifies a value used to determine the neutral bend line for a board part.
This value is always used for non-cylindrical bends. It is used for regular
bends only when no bend table is specified
interface_quality
Sets amount of checking for overlapping lines and collecting lines of same
pen color before exporting plot or 2-D file. 0 - No check or collection. 1 No check, but collection. 2 - Partial check and collection. 3 - Complete
check and collection.
intf_cadds_import_make_soli Allows the user to solidify all closed quilts during import CADDS5 model. yes, no
d
intf_cadds_version
Allows the user to switch between the default and alternate converter
14, 15
version for interface with CADDS5
intf_generate_log_file
Specifies not to generate or generate short or long log files for data
no, long, short
exchange import operations.
intf_in_dwg_pnt_ent
Yes - Converts an IGES or DXF point entity to a drawing point.
yes, no
intf_in_dwg_view
Controls if associativity in an imported IGES view is preserved.
no, 2d_views, 3d_views
3D_VIEWS - tries to create 3D views if 3D model exists in the file.
2D_VIEWS - Imported IGES views work as 2D. No - Imported IGES views
are exploded and become unrelated.
intf_in_extract_profiles
Default, no profiles in a data exchange file will be extracted for use.
all, none, comp
intf_in_granite_direct_enable Allows the user to switch back to the old 'Import Feature' method of
yes, no
reading Desktop .des files and Granite .g files into Creo Parametric. By
default, Creo Parametric directly opens these models.
intf_in_layer_asm_dialog
Yes - Presents a dialog box to control the import of both layers and
yes, no
assemblies. You can choose from the list of layers and/or solids available
in the file to select one or more for import.
intf_in_profile_default
Specifies the name of the existing import profile to use by default.
intf_out_as_bezier
Exports all B-splines as Bezier surfaces.
yes, no
intf_out_asm_mapped_item Export assembly components and instances using MAPPED ITEM entity. yes, no

Data Exchange

intf_out_assign_names

Data Exchange

intf_out_auto_layer_ids

Data Exchange

intf_out_blanked_entities

Data Exchange

Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange

Data Exchange
Data Exchange

Data Exchange

PTC Inc.

Name
initial_board_bend_y_factor

Default Value
0.5

3

no
14
short
no
2d_views

none
yes

no

no
no

Controls how entity names are handled when an object is exported to
no_name, user_name, id_name no_name
STEP format from part or assembly mode. You can give unique names to
Creo Parametric datum points, datum axes, datum curves, surfaces,
edges, and quilts.
Yes - Automatically assigns interface IDs for layers that were not assigned yes, no
no
IDs during export. No - Does not assign interface IDs for layers that were
not assigned IDs during export.
Filters export of entities based on their blank status
yes, no
yes
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Category
Data Exchange
Data Exchange

Name
intf_out_cat_start_model
intf_out_ed_recipe_file

Data Exchange

intf_out_layer

Data Exchange

intf_out_layer_rename_table Enables you to assign interface ids to layers during export

Data Exchange

intf_out_max_bspl_degree

Data Exchange
Data Exchange

Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange

Data Exchange
Data Exchange
Data Exchange

PTC Inc.

Description
Specifies Catia start model to be used for CATIA II .model export.
Sets the Creo View recipe file for export to .ed and .edz formats. For use
with Windchill 8.0 and earlier servers
Layer mapping mechanism providing an ability to group entities to layers
or blocks.

Controls the maximum degree of exported B-spline surfaces when
exporting through IGES
intf_out_pvs_recipe_file
Sets the Creo View recipe file for export to .pvs and .pvz formats. For use
with Windchill 9.0 and later servers
intf_out_text_length
Sets text length in exported 2-D. As_is - Width of each character is width
of strokes. Full_size - Width of each character is width of character text
box. Adjusted - Adjusts spacing so no extra space left and end/start
character do not overlap.
intf_pdf_u3d_create_u3d_file YES - When exporting a Creo Parametric model as PDF U3D file, create a
s
U3D file of the same name as the PDF file.
intf_profile_dir
Specifies the directory where import and export profiles are stored. Use
the full path to avoid problems.
intf_pv_recipe_dir
Sets the directory for user defined Creo View recipe files
intf_ug_version
Sets the version of NX interface.
intf_use_variable_size
Yes - IGES,DXF,STEP files with variable sized sheet information are
imported andput on the appropriate variable-size format. Without a sheet
size, the system tries to apply the correct variable-size format. No - The
IGES,DXF,STEP drawing isplaced on a standard sized format.
intf2d_fit_incompatible_data

Values

none, part_layer, block_layer,
none
block_nested_layer,
block_view_based_layer,
block_nested_view_based_laye
r
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as_is, full_size, adjusted

full_size

yes, no

no

nx6, nx7, nx8
yes, no

nx6
yes

YES - For import and export, fixes compatibility problems between 2-D
yes, no
external formats (such as IGES and DXF) and Creo Parametric.
intf2d_iges_out_hatch
YES - Exports draft xhatching as IGES sectioned area entity. NO - exports yes, no
draft xhatching as separate geometric entities.
intf2d_in_acad_expl_unsupp Yes - ACAD_PROXY_ENTITY and REGION entities are imported as set yes, no
_ents
of draft entities, No - ACAD_PROXY_ENTITY and REGION entities are
ignored.
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Default Value

no
no
yes
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Category
Data Exchange

Data Exchange
Data Exchange

Data Exchange
Data Exchange
Data Exchange

Data Exchange
Data Exchange

Data Exchange

Data Exchange
Data Exchange

Data Exchange
Data Exchange
Data Exchange

PTC Inc.

Name
intf2d_in_acad_ignore_3d

Description
Values
YES - Ignore the 3DSOLID entities, if they exist, in the DXF/DWG file
yes, no
being imported in Drawing mode. Only, the 2D entities are processed. NO
- Create an assembly by processing the 3DSOLID entities in the
DWG/DXF file being imported in Drawing mode. This is the default value
for this option.
intf2d_in_acad_wrap_tbl_text Wrap table texts imported from a DXF or DWG file when set to YES.
yes, no
s
intf2d_in_assoc_dim_geom Controls if imported associative dimensions remain associative. Yes - If
yes, no
the drawing setup option associative_dimensioning is Yes, then
dimensions are imported associative. No - Dimensions do not retain
associativity.
intf2d_in_bottom_margin
Sets the bottom margin in drawing units for imported drawings.
intf2d_in_create_multiline_no Create a single multi-line note on importing multi-line text when is set to
yes, no
te
YES.
intf2d_in_dim
AS_SEP_ENT - Imports each component of a dimension separately.
as_symbol, as_is, as_sep_ent
AS_IS - Imports dimensions as dimensions in Pro/ENGINEER.
AS_SYMBOL - Imports dimensions as symbols in Pro/ENGINEER.
Specifies the mapping file for DXF and DWG import. Absolute or relative
path to the file can be used.
intf2d_in_iges_hatch_bnd_lay Yes - Places all sectioned areas boundary imported from the IGES file in
er
one layer named IGES_HATCH_BOUNDARY. NO - Does not place
sectioned areas boundary in one layer.
intf2d_in_iges_symbols
Controls whether to import IGES symbols as symbols or as entities by
default. Yes - Import IGES symbols as symbols by default. No - Import
IGES symbols as entities by default.
intf2d_in_left_margin
Sets the left margin in drawing units for imported drawings.
intf2d_in_mi_brk_unsupp_di Yes - Breaks unsupported MI dimension types to separate entities, No m
Imports unsupported MI dimension types as different type dimensions that
can look differently.
intf2d_in_mi_lay_parts
Yes - Maps MI drafting parts to layers, No - Imports MI drafting parts as
separate entities.
intf2d_in_mi_mapping_file
Specifies the mapping file for MI import. Absolute or relative path to the file
can be used.
intf2d_in_mi_sym_parts
Yes - Maps MI symbol parts to symbols, No - Imports MI symbol parts as
separate entities.

Default Value
no

no
no

0
yes
as_is

intf2d_in_dxf_mapping_file

20

yes, no

no

yes, no

yes

yes, no

0
no

yes, no

yes

yes, no

yes
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Category
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange

Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange

Data Exchange

Data Exchange
Data Exchange
Data Exchange

PTC Inc.

Name
intf2d_in_mi_view_parts

Description
Yes - Maps MI annotation views to 2D views, No - Imports MI annotation yes, no
views as separate entities.
intf2d_in_open_log_window Yes - Opens Import Log File in a separate window. No - The Log File does yes, no
not appear in the window.
intf2d_in_recompute_dim_val Indicates whether to recompute associative dimensions upon import.
yes, no
ue
intf2d_in_right_margin
Sets the right margin in drawing units for imported drawings.
intf2d_in_std_clrs_as_user_d Yes - standard colors are imported as user-defined colors. No - standard yes, no
ef
colors are mapped to Creo Parametric colors.
intf2d_in_top_margin
Sets the top margin in drawing units for imported drawings.
intf2d_in_white_as_black
If set to yes entities having white color will be imported as black when the yes, no
background color is white.
intf2d_out_acad_brk_tbl_w_b Yes - drawing tables having blanked lines are exported to DXF/DWG as
yes, no
l_ln
separate entities, No - the tables are exported as DXF/DWG tables but the
lines are not blanked.
intf2d_out_acad_mtext
Create a single MTEXT entity for multi-line text notes when is set to YES. yes, no
intf2d_out_acad_ole_as_ima Controls OLE export to DXF/DWG. Yes - exports OLE objects as
ge
DXF/DWG IMAGEs. No - exports OLE objects as separate entities.
intf2d_out_acad_text_align
As_is - Exports notes to DXF/DWG with their original alignment values. Fit
- Exports notes with FIT alignment.
intf2d_out_acad_unicode
Yes - Non-ASCII characters are written in UNICODE encoding.
intf2d_out_blanked_layers
Enables export of blanked layer entities. If an entity is placed on a layer
that is blanked and this option is set to YES, the entity will be exported.
intf2d_out_cgm_old_lfont_ma Yes - Use the old line font mapping in CGM export: hidden lines to type 2,
p
CTRLFONT to type 4, PHANTOMFONT to type 5. No - Use the new
mapping: hidden lines to type 12, CTRLFONT to type 11,
PHANTOMFONT to type 13.
intf2d_out_cgm_ver
Provides the ability to choose CGM metafile version when exporting from
Creo Parametric drawing.
intf2d_out_dxf_mapping_file Specifies the mapping file for DXF and DWG export. Absolute or relative
path to the file can be used.
intf2d_out_enhanced_ents
Controls whether the enhanced entities (SPLINE and HATCHING) are
converted to the corresponding DXF entities or represented as separate
lines and polylines.
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Values

Default Value
yes
no
no
0
yes
0
yes
no

yes

yes, no

yes

as_is, fit

as_is

yes, no
yes, no

no
no

yes, no

no

1, 3

1

none, spline_and_hatch,
spline_only, hatch_only

spline_and_hatch
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Category
Data Exchange
Data Exchange

Data Exchange
Data Exchange

Data Exchange

Data Exchange
Data Exchange
Data Exchange
Data Exchange

Data Exchange
Data Exchange
Data Exchange
Data Exchange

Data Exchange
Data Exchange
Data Exchange
Data Exchange

PTC Inc.

Name
Description
intf2d_out_iges_layers_with_i Yes - Exports interface IDs of layers as IGES levels.
d
intf2d_out_image_format
If set to "png" shaded views will be exported as a PNG image and the
background will be transparent. If set to "jpeg" shaded views will be
exported as a JPEG image and the background will be opaque.
intf2d_out_line_width
YES - Exports line width information to DXF. NO - all entities are exported
with the default width.
intf2d_out_linemerge_ign_lay If set to yes overlapping lines will be merged regardless of their layers
ers
when exporting or plotting a drawing. If set to no overlapping lines
belonging to different layers will not be merged.
intf2d_out_old_quilt_priority Yes - quilt lines have lower priority than hidden lines when exporting or
plotting a drawing. No - quilt lines have higher priority than hidden lines.
intf2d_out_open_log_window Yes - Opens Export Log File in special window. No - the Log File will not
appear in the window.
intf2d_out_pnt_ent
Yes - Exports a drawing point to IGES, DXF or DWG as a point entity. No Exports a drawing point as shape entities.
intf2d_out_splines_to_arcs
Yes - splines geometrically representing arcs will be exported as arcs. No such splines will be exported as splines.
intf2d_out_stroke_text
Strokes == text is converted to lines and dots. "NONE"- Does not stroke
out the text for export. "ALL" - Strokes out all the text. "SPECIAL" Strokes out only special characters.
intf3d_ideas_import_filter
Enables UI to selectively import I-DEAS part and assembly models from
the I-DEAS .mf1 and .pkg container files.
intf3d_ideas_install_dir
Specifies the path for I-DEAS installation. Use the full pathname to avoid
problems.
intf3d_ideas_run_command Specifies the I-DEAS run command. Default command is "ideas".
intf3d_in_enable_layer_join No - Join surfaces on import as geometry is loaded from file. Yes - Use
new method to join surfaces by layer (surfaces contained on the same
layer are joined together first) with a better chance of joining those surface
elements to form closed geometry.
intf3d_in_import_as_facets
Import faceted data for formats that support both facet and Brep
representations.
intf3d_in_lock_redisplay
Gives the option to prevent redisplay of the model while they are in
transitional state during Creo Elements Direct file import.
intf3d_out_anno_as
This option will determine if annotations are exported and, if exported,
whether they will be exported as polyline or semantic.
intf3d_out_cat2_ident_crv
Specifies model parameter IDENT_CRV while exporting to Catia.
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Values

Default Value

yes, no

no

jpeg, png

png

yes, no

yes

yes, no

no

yes, no

no

yes, no

no

yes, no

no

yes, no

yes

all, none, special

none

yes, no

no

yes, no

ideas.cmd
yes

yes, no, default

default

yes, no

no

none, default, graphic, semantic graphic
-1
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Category
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange

Name
intf3d_out_cat2_ident_pt
intf3d_out_cat2_infinity
intf3d_out_cat2_model_sz
intf3d_out_cat2_sag
intf3d_out_cat2_step
intf3d_out_datums_by_defaul
t
intf3d_out_default_option

Data Exchange

intf3d_out_extend_surface

Data Exchange

intf3d_out_force_surf_normal IGES and PDGS export. Controls normals of non-analytic surfaces. Yes - yes, no
s
Forces the surface normals to point in a consistent direction. No - Does
not force the surface normals to point in a consistent direction.

no

Data Exchange
Data Exchange

intf3d_out_jt_auto_lods
intf3d_out_jt_brep

yes, no
no, jt_brep, xt_brep

no
no

per_part, fully_shattered,
monolithic
all, none, designated
yes, no

per_part

Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange

Data Exchange
Data Exchange

PTC Inc.

Description
Values
Specifies model parameter IDENT_PT while exporting to Catia.
Specifies model parameter INFINITY while exporting to Catia.
Specifies model parameter MODEL_SZ while exporting to Catia.
Specifies model parameter SAG while exporting to Catia.
Specifies model parameter STEP while exporting to Catia.
Determines whether datum curves are included when exporting IGES files yes, no
in Batch mode.
Controls the type of 3-D data output through Pro/BATCH to an IGES or
none, wireframe, surfaces,
STEP file.
wireframe_surfaces, solid,
shells
Specifies how surfaces are handled for exporting files to other systems
yes, no

Generate three default Creo Parametric LODs.
No*: Export to JT as facet representation only, jt_brep: Export to JT as
facet and jt_brep representation, xt_brep: Export to JT as facet and
xt_brep representation
intf3d_out_jt_config_name
Name of JT configuration file.
intf3d_out_jt_config_path
Path to JT configuration file.
intf3d_out_jt_structure
Specifies product structure to file structure mapping defined in JT Open
Toolkit.
intf3d_out_parameters
Exports parameters with models.
intf3d_out_prop_chord_heigh Use maximum chord heights proportional to component sizes.
ts
intf3d_out_prop_step_sizes Use maximum step sizes proportional to component sizes.
intf3d_out_surface_deviation Sets maximum allowable deviation between original and resulting surfaces
in the process of converting Creo Parametric surfaces to spline surfaces.
By setting this you convert surfaces with a better approximation than by
using the current model accuracy.
intf3d_out_unicode_to_neutra YES - Unicode strings are exported to the Neutral file, NO - Unicode
l
strings are converted to ascii characters for Neutral file export.
intf3d_out_use_num_names Use numeric layer names as layer export IDs.
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Default Value
-1
-1
-1
-1
-1
no
surfaces

yes

all
no

yes, no

no
-1

yes, no

yes

yes, no

yes
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Category
Data Exchange
Data Exchange

Data Exchange
Data Exchange

Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange

Data Exchange

Name
Description
intf3d_out_use_step_size
Use maximum step size(s).
yes, no
intf3d_parasolid_export_sche Allows user to choose the schema to be used for parasolid export. Default
is SCH_10004. Consult online documentation for other valid schema
ma
settings.
medusa_2d_config_file
Specifies the Medusa 2D Interface config. file. Absolute or relative path to
the file can be used.
mentor_ver_2_0
Yes - Exports the file in IDF 2.0 format. No - Exports the file in IDF 1.0
yes, no
format unless IDF 2.0 is selected from the ECAD FORMAT menu.
pdf_linecap

0 - Butt cap: stroked lines are squared off at the endpoint of the path.
There is no projection beyond the end of the path.
pdf_linejoin
0 - Miter join: outer edges of the strokes for the two segments are
extended until they meet at an angle.
pdf_use_pentable
No - PDF export does not use any defined pentable changes as would be
applied to plotting the drawing.
pro_gplug_dir
Specifies the directory in which Granite application plug-ins are located.
Use the full pathname to avoid problems.
put_iges_drawing_entity
Specifies whether or not to suppress the output of the IGES drawing
entity, #404, to the IGES file. No - The drawing entity is not output.
step_appearance_layers_gro No - Output of Appearances, Layers, and Groups is enabled for STEP
ups
standard AP214. Yes - Output of Appearances, Layers, and Groups is
enabled for STEP standard AP203.
step_export_ap214_asm_def Toggles the default setting of the File Structure field in the STEP Export
_mode
dialog box for supported assembly STEP export files.

Data Exchange

step_export_dwg_views

AS_3D_VIEWS - Export 3-D model geometry with its associative views.
AS_3D_VIEWS_ASSOC_DRAFT - Export 3-D model geometry with its
associative views and view related annotations. NO - Export only 2-D
representations of the 3-D models. This is the default.

Data Exchange

step_export_format

Data Exchange

step_out_asm_val_prop

Data Exchange

step_out_material

Specifies output format when exporting to STEP. AP203_IS - Formats
output to ISO 10303 AP203IS format. AP214_CD - Formats output with
geometry that meets the specification for the long-term schema for
AP214cc1.
Export validation information for assemblies to the STEP file for formats
ap203_e2, ap214_is
Exports the material definition (name and density) to the STEP file for
formats ap203_e2, ap214_is and 203_is_ext

PTC Inc.
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Values

Default Value
no
sch_10004

yes

butt, round, projecting square

butt

round, miter, bevel

miter

yes, no

no

yes, no

<creo3.0_loadpoint>\x86
e_win64\gplugs\
yes

yes, no

no

single_file,
separate_parts_only,
separate_all_objects
no, as_3d_views,
as_3d_views_assoc_draft

single_file

no

ap203_is, ap202_is, ap209_dis, ap203_is
ap214_is, ap203_e2,
ap203_is_ext
yes, no

no

yes, no

no
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Category
Data Exchange
Data Exchange
Data Exchange

Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange

Data Exchange

Data Exchange

Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange

PTC Inc.

Name
Description
step_out_material_as_produc Export the material definition (name and density) to the STEP file as a
t
separate STEP PRODUCT entity
step_out_suppl_geom
Export datum csys, planes, axes, points to the STEP file for formats
ap203_e2, ap214_is
system_iges_header_file
Inserts specified text file into the Start section of IGES files (refer to
user_iges_header_file). When used with user_iges_header_file, the
system text appears first.
tiff_compression
TIFF exports are done without compression.
tiff_type
Determines the type of tiff items are exported to variables refer to color
sets
use_export_2d_dialog
Yes - Opens export options dialog when exporting Creo Parametric
drawing. No - exports file without the options dialog.
use_iges_font_1003
Used to disable the use of IGES font 1003.
use_iges_kanji_font_2001
Specifies whether to convert Kanji notes in Creo Parametric to IGES Kanji
notes (font code) when exporting. Yes - Converts Kanji notes to IGES
Kanji notes. No - Converts using Font 1.
user_iges_header_file
Filename - Insert specified text file into the Start section of IGES file. Valid
parametric note symbols will be replaced during export. For example,
&dwg_name in the text file is replaced by the drawing name when a
drawing is exported.
vda_header
The complete filename of the text file containing VDA header information.
If you intend to use the same header for all VDA files, specify the full
pathname.
vrml_anchor_url
Enables you to place an anchor on a specified VRML component during
the export to VRML. The keywords are optional.
vrml_background_color
Yes - Exports a model to VRML with the Creo Parametric background
color.
vrml_explode_lines
Yes - Exports a model to VRML with explode lines for assembly or
assembly process data.
vrml_export_resolution
Specifies the number of levels of detail (LODs) in models exported in
VRML format.
vrml_export_version
Allows the user to choose between exporting to the VRML 2.0 or 1.0
format.
vrml_file_duplicate_material Yes - Ensures that the model components retain their true color. No - In
some viewers, component colors might not be consistent.
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Values

Default Value

yes, no

no

yes, no

no

none, g4, packbits, deflate
rgb, palette, grayscale, mono

none
rgb

yes, no

yes

yes, no
yes, no

yes
no

yes, no

no

yes, no

yes

high, medium, low

medium

2.0, 1.0

2

yes, no

no
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Category
Data Exchange

Name
vrml_multiple_views

Description
All - Exports top-level and lower-level assembly component views into
VRML format. None - Does not export component views into VRML
format. Top - Exports top-level object view only into VRML format.

Values
all, none, top

all

Default Value

Data Exchange

vrml_parameters

all, none, designated

designated

Data Exchange

vrml_simprep_export

yes, no

no

Data Exchange

www_add_aux_frame

yes, no

no

Data Exchange

www_export_geometry_as

Controls the export of user parameters. Designated - Export only
designated parameters. All - Export all parameters. None - Do not export
parameters.
Yes - Specifies direct and in memory export of top-level assembly
simplified representation to Pro/FLY-THROUGH package files.
Creates additional frame for each process step or for assembly
publication. Yes - Auxiliary files aux.html are created for each step in
assembly process (in each step00 directory) to be replaced by your .html
file. No - Auxiliary files are not created.
Specifies the output format by to one of the values

Data Exchange

www_multiple_views

Data Exchange

all, vrml, cgm, jpg, cgm_vrml,
jpg_vrml, cgm_jpg
All - Writes all views in any component to the appropriate VRML files. Top - all, none, top
Writes only named views that reside in the assembly or process assembly
to top-level VRML files. None - Does not write named views to VRML files.

jpg_vrml

www_tree_location

Specifies the location of the model tree in the browser window. Out Opens model tree in a separate window. In - Includes model tree in the
Web page and removes the Tree checkbox from the control panel.

out

Data Management

allow_import_file_extension

Allow additonal files with extensions to be shown in the import dialog

Data Management

bitmap_size

Data Management

dm_auto_open_zip

Data Management

dm_cache_limit

Data Management

dm_cache_mode

Data Management

dm_checkout_on_the_fly

Works in conjunction with save_bitmap. Determines the size (squared) of
the bitmap image that is stored.
YES - Windchill CAD packages or zip files will open automatically. NO yes, no
User selects which file in contents to open.
Enter amount of disk space (in megabytes) to allocate for local file
storage. The change to the existing setting will take effect after Creo
Parametric is restarted
Indicate which objects will be written to local cache when objects in Creo all, none, modified
Parametric memory are saved.
Controls the default action presented to the user when Check Out on the checkout, continue
fly dialog comes up

PTC Inc.
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out, in

top

200
yes

all
checkout
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Category
Data Management

Data Management

Name
Description
dm_fallback_server_location Specifies the server location where objects will be saved when Creo
Parametric does not provide an ability to specify the target save location.
This option is applicable for Windchill ProductPoint only.
dm_hide_virtual_default_ws Yes - When there is at least one workspace created in any context in
selected server, default workspaces that were never used, will not be
listed. No - (Default value) Default workspaces will be listed for each
context that has no workspace defined.
dm_http_compression_level Set the data compression factor (0-9, 0= no compression) for data
exchange with a Windchill server.
dm_offline_after_event
Allow the user to choose to work offline when there is a loss of server
connection. Staying online will continue to retry server operations.

Values

Default Value

yes, no

no

yes, no

yes

Data Management

dm_offline_options_activated Yes - Synchronize, Download and Upload boxes are checked when going yes, no
online. No - Only Synchronize box is checked when going online.

yes

Data Management

yes, no

no

yes, no

yes

yes, no

yes

Data Management

dm_overwrite_contents_on_u Yes: Windchill Workspace Update will overwrite locally/modified out of
pdate
date objects with the ones in the server. No (Default): Windchill
Workspace Update will update metadata only.
dm_remember_server
Primary server/workspace must be set by user for each Creo Parametric
session.
dm_save_as_attachment
Controls the default option for Save A Copy when models are saved as in
non-Creo Parametric format. Yes - It will by default save it as secondary
content attachment to the original CAD Document. No- It will by default
save it as Primary CAD Document
dm_search_primary_server Search the primary server for dependencies not found in the workspace.

yes, no

yes

Data Management

dm_secondary_upload

Indicate when modified Creo Parametric objects on a secondary server
automatic, explicit
will be moved from the local cache to the user's workspace on the server.

automatic

Data Management

dm_synchronize_in_backgro
und
dm_update_unconfirmed_inst
ances

Yes: Enables workspace synchronization in the background. No (Default): yes, no
Workspace synchronization will happen in the foreground.
Specifies when to force verification and save of unconfirmed assembly
never, always, critical_only
instances to data management system: NEVER
- never;
CRITICAL_ONLY - only to correct or prevent doubtless data corruption;
ALWAYS
- whenever generic is saved
Indicate when modified Creo Parametric objects will be moved from the
automatic, explicit
local cache to the user workspace on the server.

no

Data Management
Data Management

Data Management
Data Management

Data Management

Data Management

PTC Inc.
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never

explicit
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Category
Data Management
Data Management

Data Management
Data Management
Data Management
Data Management
Data Management
Design Manager
Dimensions &
Tolerances
Dimensions &
Tolerances

Dimensions &
Tolerances

Dimensions &
Tolerances
Dimensions &
Tolerances
Dimensions &
Tolerances

PTC Inc.

Name
Description
Values
let_proe_rename_pdm_objec Determines whether an object fetched from a PDM database can be
yes, no
ts
renamed in a Creo Parametric session.
pdm_rev
Specify how the system parameter, PDM_REV, should be formatted. Only pdmrev_fmt_rev_ver,
useful for objects submitted to Pro/PDM or Pro/INTRALINK.
pdmrev_fmt_rev,
pdmrev_fmt_branch_rev_ver,
pdmrev_fmt_branch_rev
read_parameters_of_exclude Allow Creo Parametric designated parameters on excluded objects in
yes, no, common_name_only
d
Simplified Representation to be visible in Model Tree columns.
regenerate_read_only_object Determines whether an object retrieved from PDM database with read
yes, no
s
only status can be regenerated in a Creo Parametric session.
save_bitmap
When performing a save on a model, determines what level of the
none, toplevelonly, alllevels
assembly will have bitmap images created of modified components.
save_bitmap_type
When performing a save on a model, determines the type of image file
cgm, bmp, tiff, gif, jpeg
that is created for that model. Used with "save_bitmap" option.
save_unchanged_pdm_objec Determines how to save in the current working directory an object fetched as_ref, as_copy
t
from a Pro/PDM database into a Creo Parametric session.
dont_show_symbol_nodes
Do not show references derived from relations in Parent/Child viewer.
yes, no
allow_rfs_default_gtols_alway Yes - Enables RFS/Default gtols to be created even when not permitted by yes, no
s
ANSI standard.
ang_dim_in_screen
Yes - If the display is in the default pan/zoom setting
yes, no
(View>Pan/Zoom>Reset), the system checks whether an angular
dimension is visible on the screen. If it is not visible, then the system
moves the dimension to a visible location.
angular_tol
An alternative format for setting default angular tolerance dimensions. The
value sets the number of decimal places, and the tolerance is the actual
tolerance value. For integer dimensions, the value is zero, and the
tolerance is an integer.
angular_tol_0.0
Sets the default tolerance for angular dimensions. Each option sets a
tolerance for a specific decimal place. The value is the place of the last
decimal.
angular_tol_0.00
Sets the default tolerance for angular dimensions. Each option sets a
tolerance for a specific decimal place. The value is the place of the last
decimal.
angular_tol_0.000
Sets the default tolerance for angular dimensions. Each option sets a
tolerance for a specific decimal place. The value is the place of the last
decimal.
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Default Value
no
pdmrev_fmt_rev_ver

no
yes
none
bmp
as_ref
no
no
no

0

5

50

500
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Category
Dimensions &
Tolerances

Name
angular_tol_0.0000

Dimensions &
Tolerances

angular_tol_0.00000

Dimensions &
Tolerances

angular_tol_0.000000

Dimensions &
Tolerances
Dimensions &
Tolerances

create_fraction_dim
default_ang_units

Sets the display of newly created angular dimensions both in the model
and in the drawing. There is no impact on dimensions previously created.
ang_deg - Decimal degrees. ang_min - Degrees and decimal minutes
ang_sec - Degrees, minutes, and decimal seconds

Dimensions &
Tolerances

default_dec_places

Sets the default number of decimal places (0-13) to which to round newly
created dimensions. Unrounded dimensions automatically determine the
number of decimal places required to display their stored value.

Dimensions &
Tolerances

default_dim_num_digits_cha Sets the default number of digits displayed in a dimension to the last
nges
entered value. No - The system defaults to the value specified for the
configuration file option default_dec_places.
default_placement_surfacefin Sets the default placement type for surface finishes within the surface
ish
finish UI.
dim_fraction_denominator
Sets the largest denominator to be used for fractional dimensions. If the
fraction can be reduced, then it converts to the lowest possible
denominator (for example, 4/32 converts to 1/8).
dim_fraction_format
Std - Displays fractional dimensions in the standard Creo Parametric
format. Aisc - Displays fractional dimensions in the American Institute of
Steel Construction (AISC) format and displays architectural units in AISC
format for feet-inches.
dim_offscreen_limit
If more than zero, sets the margin beyond which dimensions are
automatically snapped back onto the screen. For example, a value of .2
lets a dimension be 20% of the window size outside the window. If set to
zero, disables snapping of offscreen dimensions.
display_tol_by_1000
If set to Yes, tolerances for non-angular dimensions will be displayed
multiplied by 1000.

Dimensions &
Tolerances
Dimensions &
Tolerances
Dimensions &
Tolerances

Dimensions &
Tolerances

Dimensions &
Tolerances

PTC Inc.

Description
Sets the default tolerance for angular dimensions. Each option sets a
tolerance for a specific decimal place. The value is the place of the last
decimal.
Sets the default tolerance for angular dimensions. Each option sets a
tolerance for a specific decimal place. The value is the place of the last
decimal.
Sets the default tolerance for angular dimensions. Each option sets a
tolerance for a specific decimal place. The value is the place of the last
decimal.
Yes - All dimensions created will be displayed as fractions.
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Values

Default Value
5000

50000

500000

yes, no

no

ang_deg, ang_min, ang_sec

ang_deg

2

yes, no

yes

with_leaders, on_entity,
normal_to_entity, free

normal_to_entity
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std, aisc

std

0.2

yes, no

no
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Category
Dimensions &
Tolerances

Name
gtol_dim_placement

Dimensions &
Tolerances

linear_tol

Dimensions &
Tolerances

linear_tol_0.0

Dimensions &
Tolerances

linear_tol_0.00

Dimensions &
Tolerances

linear_tol_0.000

Dimensions &
Tolerances

linear_tol_0.0000

Dimensions &
Tolerances

linear_tol_0.00000

Dimensions &
Tolerances

linear_tol_0.000000

Dimensions &
Tolerances
Dimensions &
Tolerances

maintain_limit_tol_nominal

Dimensions &
Tolerances

minimum_angle_dimension

Dimensions &
Tolerances

parenthesize_ref_dim

PTC Inc.

mark_approximate_dims

Description
Values
Controls display of geometric tolerances in Part. Use like drawing set-up on_bottom, under_value
option of the same name. On_bottom - Gtols display at bottom (below
additional lines of text). Under_value - Gtols display under dimension
value (above additional lines of text).
An alternate format for setting default linear tolerance dimensions. First
value sets the number of decimal places. Second value is the actual
tolerance. For example, 6 0.000025 sets tolerance to six decimal places.
The default tolerance is 0.000025.
Specify a range for default tolerances of linear and angular dimensions.
These values affect only models created after the tolerance options are
specified in the configuration file.
Specify a range for default tolerances of linear and angular dimensions.
These values affect only models created after the tolerance options are
specified in the configuration file.
Specify a range for default tolerances of linear and angular dimensions.
These values affect only models created after the tolerance options are
specified in the configuration file.
Specify a range for default tolerances of linear and angular dimensions.
These values affect only models created after the tolerance options are
specified in the configuration file.
Specify a range for default tolerances of linear and angular dimensions.
These values affect only models created after the tolerance options are
specified in the configuration file.
Specify a range for default tolerances of linear and angular dimensions.
These values affect only models created after the tolerance options are
specified in the configuration file.
Maintains the nominal value of a dimension regardless of the changes that yes, no
you make to the tolerance values.
Yes - Displays a tilde (~) in front of a dimension that is set to display as a yes, no
fraction and has an actual value that is not rounded to equate exactly to
the displayed fractional value (the fraction shows 7/32 but the actual value
is .22, not 0.21875).
Controls the minimum angle value under which Creo Parametric assumes
colinearity of the selected items when creating a driven dimension.

Default Value
on_bottom

Encloses reference dimensions in parentheses. No - Follows reference
dimensions with the text "REF".

no
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yes, no

0.000000 -1

1

1

1

1

1

1

no
no

1
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Category
Dimensions &
Tolerances
Dimensions &
Tolerances
Dimensions &
Tolerances

Dimensions &
Tolerances
Dimensions &
Tolerances

Dimensions &
Tolerances
Dimensions &
Tolerances
Dimensions &
Tolerances

Dimensions &
Tolerances
Drawing

Drawing
Drawing

Drawing

PTC Inc.

Name
restricted_gtol_dialog

Description
Determines whether the Geometric Tolerance dialog restricts the user by
graying out elements that are considered "illegal".
round_displayed_dim_values Sets the default status of the Rounded Dimension Value checkbox for
newly created or shown dimensions.
tbl_driven_tol_val_edit
Tbl_driven_tol_val_edit Y/N* - "Yes" allows users to directly edit the
tolerance value of dimensions whose tolerance values are driven by
tolerance tables. Editing the tolerance value of a dimension will make the
dimension non-table-driven. "No" disallows direct editing of the tolerance
values of table driven tolerances.
tol_display
Displays dimensions with or without tolerances.

Values

Default Value

yes, no

yes

yes, no

yes

yes, no

no

yes, no

no

tolerance_class

Sets the default tolerance class for ISO-standard models. The system
uses the tolerance class in conjunction with the dimension value when
retrieving tolerances for General or Broken Edge dimensions.

medium, fine, coarse,
very_coarse

tolerance_standard

Sets the tolerance standard used when creating the model.

ansi, iso

ansi

yes, no

no

yes, no

no

yes, no

yes

yes, no

no

yes, no

no

yes, no

yes

tolerance_table_dir

Sets the default directory for user-defined tolerance tables for ISOstandard models. All Holes and Shafts tables overwrite existing tables
when loaded.
use_major_units
Determines if fractional dimensions are displayed in terms of feet-inches
or meter-mm. Yes - The major units are used. For example, when the
units are inches and 25.125 is converted to a fraction, the dimension
becomes 2' 1-1/8".
use_nom_dim_val_in_expr
Yes - use dimensions' nominal values in expressions. No - use current
values.
allow_move_attach_in_dtl_m Yes - Move and Move Attach commands in drawing mode act together.
ove
No - Move and Move Attach commands in drawing mode do not act
together.
allow_move_view_with_move Disallow the movement of drawing views with the mouse.
allow_refs_to_geom_reps_in Yes - Allows you to create drawing references to geometry
_drws
representations (includes dimensions, notes, and leaders). These
references may become invalid if the referenced geometry changes
resulting in geometry representations not updating in drawings.
allow_vert_select_in_dim_cre Allow highlight of model vertices during dimension placement in drawings
ate
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Category
Drawing

Drawing

Drawing
Drawing
Drawing

Drawing

Drawing

Drawing

Drawing

Drawing
Drawing
Drawing

Drawing

PTC Inc.

Name
Description
auto_constr_offset_tolerance Sets the auto constraint tolerance for creating offset dimensions. If
distance is less than this tolerance multiplied by component size, offset is
set as coincident. Default value is 0.5 .
auto_regen_views
Yes - Automatically repaints the drawing display when changing from one
window to another. No - Update to drawing views will only occur when
manual updates are made via Repaint or View> Update.
autobuildz_enabled
Loads AutobuildZ application.
bom_format
Sets the BOM format file to be used for a customized BOM. Specify name
and path.
create_drawing_dims_only
Yes - Saves all new driven dimensions created in the drawing inside the
drawing as associative draft dimensions. No - Saves driven dimensions
created in Drawing mode on solid geometry in the solid.
default_ang_dec_places
Sets the default number of decimal places (0-13) to which to round newly
created angular dimensions. Unrounded angular dimensions automatically
determine the number of decimal places required to display their stored
value.
default_draw_scale
Sets the default drawing scale for views added with the No Scale
command. The value must be greater than 0. No - The system does not
set a default drawing scale.
default_font_kerning_in_draw Determines initial setting of Font kerning when 2D drawing annotations are
ing
created. Yes - Font kerning is on for new 2D annotations.
disp_trimetric_dwg_mode_vie Displays the model in default orientation when placing a general view on
the drawing. No - Model does not appear until Default is chosen from the
w
Orientation dialog box.
display_dwg_sketch_constrai When set to yes, parametric sketching constraints, such as V for vertical,
nt
are displayed when a drawing object is selected
display_dwg_tol_tags
Sets the display of the tolerance tags that appear in drawings. This option
does not affect the display of tolerances on dimensions.
display_in_adding_view
Controls model display in a drawing when auto_regen_views is No.
Wireframe - Adds new views in wireframe, displays datums.
Minimal_wireframe - Displays in wireframe, no datums, axes, or silhouette
edges. Default - Displays using the Environment setting.
draw_models_read_only
Yes - Drawing model files are read-only. No model changes can be
made. Cosmetic_only - Only cosmetic changes can be made to the
model. Design changes are not allowed. Cosmetic changes include
adding driven dimensions, cross sections, and explode states.
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Values

Default Value
0.5

yes, no

yes

yes, no

no
<creo3.0_loadpoint>\text
\format.bft
no

yes, no

1

-1

yes, no

no

yes, no

yes

yes, no

no

yes, no

yes

default, wireframe,
minimal_wireframe

wireframe

yes, no, cosmetic_only

no
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Category
Drawing

Drawing
Drawing

Drawing
Drawing

Drawing

Drawing

Drawing
Drawing

Drawing

Drawing

PTC Inc.

Name
Description
draw_points_in_model_units Defines the current draft view's coordinate values as model units rather
than drawing units. The GET POINT menu uses the scale of the draft view
and the draft view's model units for relative and absolute coordinate entry
and display in the Message Window.
drawing_ole_image_dpi
Resolution of OLE object images. The range of valid values is 0 to 600
dots per inch.
drawing_setup_file
Sets the default drawing setup file option values for your Creo Parametric
session, otherwise, the system uses the default drawing setup file option
values. Certain parameters in the file are valid only if you have a license
for Pro/DETAIL.
drawing_shaded_view_dpi
Resolution of exported shaded drawing views. The range of valid values
is 0 to 600 dots per inch.
drawing_view_origin_csys
The named coordinate system will be used as the origin of a newly
created view or of a modified view. None - The system will not use a
previously specified coordinate system.
drawing_warn_if_flex_feature Display a warning dialog upon opening a drawing with models that contain
flexible features advising users that annotations may be out of date and
should be verified.
dwg_unicode_conversion_lan Defines the language used during Unicode conversion of pre-Wildfire 4.0
guage
drawings. This option does not affect the conversion of models. File Uses the language stored in the drawing header file; Session - Uses the
language of the current Creo Parametric session.

Values
yes, no

150
<creo3.0_loadpoint>\text
\prodetail.dtl

150
none

yes, no

yes

file, session, english, japanese, file
french, german, russian, italian,
spanish, korean, chinese_tw,
chinese_cn, hebrew, greek,
turkish, czech, polish,
hungarian, slovenian,
portuguese, slovak, usascii

enable_shaded_view_in_dra Yes - shading display is allowed in drawing views. No - shading display will yes, no
wings
be shown in wireframe.
force_wireframe_in_drawings Yes - Displays all views of drawings in wireframe. No - Displays views
yes, no
according to the display set for the session (wireframe, hidden, and so
on).
format_setup_file
Assigns a specified setup file to each drawing format. To assign the
drawing's parameter values to the format, you must retrieve the drawing's
setup file into the format.
highlight_erased_dwg_views Controls the display of erased view outlines (environment option Highlight yes, no
Erased Views). Yes - Highlights erased views. No - Turns off highlighting
for erased views.
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Default Value
no

yes
no

dwgform.dtl

yes
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Category
Drawing

Drawing

Description
In drawing mode, highlights new dimensions in red until you repaint the
screen.
hlr_for_quilts
In Drawing, controls quilt display in hidden line removal. Yes - Includes
quilts in the hidden line removal process (preselects Qlt HLR in the VIEW
DISP menu). Default in the VIEW DISP menu, uses the value you have
set.
make_aux_view_notes
Automatically adds view names to auxiliary views using AUX VIEW*
viewname-viewname. You can modify the view name after adding the view
to the drawing.
make_parameters_from_fmt Determines the handling of values entered in a format table when you
_tables
replace one drawing format with another. Yes - Stores entered values for
format table and copies them with the table. No - Prompts you to re-enter
all the values for the format table.
make_proj_view_notes
Automatically adds view names to projection views in the format "VIEW
viewname-viewname." You can modify the view name after adding the
view to the drawing.
ole_unlimit_zoom
Yes - The OLE object is displayed in any zoom level (could result in
performance degradation). No - The OLE object disappears in high zoomin levels.
pick_chain_tangent_only
Specifies the extent of draft entity chains selected. Yes - Only entities in
the chain that are tangent will be selected. No - All entities connected end
to end will be selected.
preferred_export_format
Set the default preferred export file type for export from drawings.

Drawing

pro_dtl_setup_dir

Drawing

pro_format_dir

Drawing

pro_note_dir

Drawing

pro_palette_dir

Drawing

pro_symbol_dir

Set and automatically create the default directory for saving and retrieving
user-defined symbols. If you do not specify a directory, the system uses
the current working directory. Use full path name to avoid problems.

Drawing

pro_table_dir

Specifies the directory to be used when tables are retrieved or saved. Use
the full path name to avoid problems.

Drawing

Drawing

Drawing

Drawing

Drawing

Drawing

PTC Inc.

Name
highlight_new_dims

Sets the directory for the drawing setup files. If this option is not set, the
system uses the default setup directory.
Sets the default directory for the drawing format library. Use the full
pathname to avoid problems.
Specifies the directory from which to retrieve notes entered from a file.
Use the full path name to avoid problems.
Sets the default directory for drawing symbol palette files.
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Values

Default Value

yes, no

no

yes, no

no

yes, no

no

yes, no

no

yes, no

no

yes, no

no

yes, no

no

cgm, tiff, iges, dxf, step, pdf,
dwg, medusa, stheno

pdf

<dir_name>\dump_x86e
_win64\
<creo3.0_loadpoint>\sy
mbols\palette\
<dir_name>\dump_x86e
_win64\
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Category
Drawing
Drawing

Drawing

Name
Description
Values
remember_last_get_point_op Yes - Sets the default of the GET POINT menu as the last option picked
yes, no
tion
among Pick Pnt, Vertex and On Entity.
save_display
Yes - Stores view geometry and detail items such as solid dimensions.
yes, no
These items are displayed when retrieving the drawing in View-Only
mode.
save_drawing_picture_file
Embed - Embeds a picture file inside a drawing for preview purposes.
no, export, embed, both
Export - Saves a drawing file as a picture file in the working directory when
saving a drawing. Both - Does both embed and export.

Default Value
no
no

embed

Drawing

save_modified_draw_models Determines whether the system saves the model after you have changed
_only
it. No - Saves the model every time that you store the drawing.

yes, no

yes

Drawing

select_hidden_edges_in_dwg Controls selectability of hidden edges in no-hidden drawing views.

yes, no

yes

Drawing

selection_of_removed_entitie Yes - Entities in front of cross-section (planar or offset) can be selected,
yes, no
s
clipped (using Z-clipping), or erased with EDGE DISP menu. No Geometry, datum points or curves, cosmetic features, threads, grooves, or
coordinate systems cannot be erased.
show_annotations_dialog_lim Default value for Annotations dialog box.
it
show_preview_default
This option determines the default behavior for preview in Show/Erase.
remove, keep

Drawing
Drawing
Drawing

no

remove
yes

Drawing

snap_drw_entity_to_snap_lin Yes - Enable snapping of drawing and report entities to snap lines. No yes, no
e
disable snapping of drawing and report entities to snap lines.
switch_dims_for_notes
Yes - Dimensions will be displayed in their symbolic format during drawing yes, no
note creation. No - Dimensions will be displayed in drawing notes as
numerical values.
sym_leader_orient_move_tex With Pro/DETAIL, automatically regroups weld symbol instances after you yes, no
t
move the text.
symbol_instance_palette_file Specifies the location of the symbol instance palette.

Drawing

symbol_palette_input

Controls the display of the special symbol palette during note creation.

yes

Drawing

todays_date_note_format

Controls the initial format of the date displayed in a drawing. The format
for the setting is a string consisting of three portions: the year, the month,
and the date. You can enter the portions in any order.

Drawing

Drawing

PTC Inc.
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yes, no

yes

no

%dd-%mmm-%yy
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Category
Drawing

Name
Description
tol_num_digits_default_drive Yes - The Default check boxes in the number of digits area of the
n
Dimension Properties dialog will be checked when a dimension is created
or first shown. No - The check boxes will be unchecked when a dimension
is created or first shown.
triangulate_filled_areas
Subdivide filled areas into triangles (may affect memory usage and plot
files).
variant_drawing_item_sizes No - Drawing items moved/copied to a different sheet or located on a
changed sheet keep same size and relative orientation on paper. Yes Some items scale/reposition to be the same on paper, and others scale
and/or reposition to be the same on screen.
warn_if_iso_tol_missing
Yes - Returns the user to the dimension properties dialog to select a
different table. No - Applies the tolerance according to existing
functionality.
enable_learning_connector
Enable the Learning Connector, which provides context specific access to
videos, training, help topics, and technical support content. When
enabled, the Learning Connector is added to the ribbon bar next to Help.

Values

Default Value

yes, no

yes

yes, no

no

yes, no

no

yes, no

no

yes, no

yes

Align NEWLY CREATED bundles where they meet or branch out
Allow to create a bundle over a group of flat packing cables.
Allow to retrieve a harness mfg assembly directly.

yes, no
yes, no
yes, no

yes
no
no

Assemble parent connectors on locations referencing a subconnector.

yes, no

yes
yes

Electromechanical

Yes - When regenerating a pre-Release 11.0 cabling assembly, the
yes, no
system automatically creates a separate spool feature for every individual
wire or cable in the assembly. No - An interface for the cable conversion
appears.
auto_xml_on_retrieve
Automatically load Cabling Logical Reference from an XML file when
yes, no
retrieving the cabling assembly
auto_xml_on_save
Automatically create an XML Logical Reference when saving a cabling
yes, no
assembly
autoroute_path_param_name Set the wire parameter to use to select a path during autorouting.

use_path

Electromechanical

boeing_extract_bundle

no

Drawing
Drawing

Drawing

Education & Social
Tools

Electromechanical
Electromechanical
Electromechanical
Electromechanical

align_cable_bundles
allow_bundle_flat_cables
allow_harn_mfg_assy_retriev
al
assemble_parent_connector

Electromechanical

auto_convert_cables

Electromechanical
Electromechanical

Electromechanical

PTC Inc.

Yes - Uses the extract bundle algorithm. No - Does not use the extract
bundle algorithm.
bundle_transition_create_met Control whether bundle transitions are created automatically. Default is
hod
automatic.
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no
no

yes, no
automatic, manual
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Category
Electromechanical
Electromechanical

Electromechanical

Name
Description
cable_bundle_transition_leng Transition length is controlled by the formula Larger Diameter X
th
<percentile>. Default value is 50&#91;0...250]%.
cable_int_portions_for_clr
No - Global clearance checking for internal cable portions is excluded. Yes yes, no
- Global clearance checking for internal cable portions is included.

Electromechanical
Electromechanical

cable_location_override_colo
r
cable_segment_override_col
or
cables_with_hlr
cabling_split_multi_pnt_locs

Electromechanical
Electromechanical
Electromechanical

compact_cables_packing
compare_spools_by_name
cti_class_color_file

Electromechanical

diagram_export_allow

Electromechanical

diagram_pin_edit_multi_line

Electromechanical

display_duplicate_harness_m
sg
display_internal_cable_portio
n

Electromechanical

Electromechanical

Electromechanical

Electromechanical

PTC Inc.

Override the system color of cable locations. Enter RGB values between 0
and 255 separated by space.
Override the system color of cable segments that do not have a color
map. Enter RGB values between 0 and 255 separated by space.
Cables are not hidden behind objects.
Setup whether to convert multiple-location features into single location
features.
Setup whether the new packing of cables should be applied.
Compare spools by names in logical compare.
Sets the CTI class color file for CTI class color display during electrical
clearance and creepage analysis. Use the full pathname to avoid
problems.
YES: Allow user to save a copy of loaded diagrams as DGE file for loading
into Routed Systems Designer, NO: Do not provide option to save a
diagram as DGE.
(Diagram) Determines the Pro/TABLE format used when you are
modifying pin parameters. "yes" - You can add user-defined pin
parameters by including them between the DEFINE and ENDDEF
statements for each pin. "no" - The system uses columnar format and

Display warning message when duplicate harness are identified in the
same assembly.
Yes - Internal cable portions will be displayed for any wires that have been
manually set to Yes in the Cable Paths Setup dialog box for each
individual splice and custom component. This option can be overridden in
the Environment dialog box.
display_route_cable_preview If no then Route Cables tool does not display preview of cables as they
are routed. Otherwise Route Cables tool will show a preview of the path
routed cables will follow.
display_thick_cables
Yes - Display cables and wires with thickness. No - Display the centerline
of cables and wires only. This option can be overridden in the Environment
dialog box.
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Values

Default Value
0.5
no

yes, no
yes, no

yes
yes

yes, no
yes, no

no
yes

yes, no

no

yes, no

no

yes, no

yes

yes, no

no

yes, no

yes

yes, no

no
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Category
Electromechanical
Electromechanical
Electromechanical

Name
enable_cable_channel
fan_significant_locations_onl
y
fan_with_network

Electromechanical

freeze_failed_cable_locations Suspends the cable location at its last known assembly location.

Electromechanical

full_hlr_for_cables

Electromechanical

harn_start_model_dir

Electromechanical

harn_tang_line_display

Electromechanical

hlr_for_xhatches

Electromechanical

ignore_bundles_in_find_cabl
es
network_location_override_c
olor
network_segment_override_c
olor
orthogonal_snap

Electromechanical
Electromechanical
Electromechanical

Electromechanical
Electromechanical
Electromechanical
Electromechanical
Electromechanical
Electromechanical
Electromechanical

PTC Inc.

Description
Activates channel functionality
yes, no
Setup whether only significant locations should be flattened on flattening a yes, no
harness.
Setup whether the network should be included on flattening a harness.
yes, no

Values

yes

yes, no

no

Full - Removes hidden lines from view when cables hide other geometry none, full, partial
(use when Hidden Line active). Partial - Cables hide other non-interfering
cables except when cables route together between same locations. None Display hidden lines (faster).
Provides the complete path to the directory containing harness start parts
and assemblies
Display the tangency lines between cable segments in thick cable display yes, no
mode.
Controls whether HLR to be enabled for crosshatches in drawing mode.
yes, no

Include bundles and overbraids in the query results when the model or
logical data is queried for unrouted items.
Override the system color of network locations. Enter RGB values
between 0 and 255 separated by space.
Override the system color of network segments. Enter RGB values
between 0 and 255 separated by space.
Controls non-90 degree routing in Pro/DIAGRAM. Yes - Turns the Ortho
Snap function on. You can sketch wires only at the default horizontal and
vertical orientation. No - Enables you to sketch wires in drawings at angles
other than the default.
pro_cbltrm_dir
Sets the directory from which terminators are retrieved. Use the full
pathname to avoid problems.
pro_spool_dir
Sets the directory from which spools are retrieved. Use the full pathname
to avoid problems.
report_end_splice
Setup whether the terminal splices of cables are reported.
ribbon_cable_flat_direction
Flat ribbon cables in the y-axis of entry ports.
smaller_bundle_min_bend_ra Setup whether to consider the thickness of the bundle when set up the
d
minimum bend radius.
template_flat_harness
Specify the model used as the default flattened Harness assembly
template.
template_harnesspart
Specify the model used as the default Harness part template.

38

Default Value
no
yes

full

yes
no

yes, no

no

yes, no

yes

yes, no
y_axis, x_axis
yes, no

<dir_name>\dump_x86e
_win64\
no
y_axis
no
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Category
Electromechanical

Name
Description
terminator_table_out_unicode YES - Unicode strings are exported in terminator table files, NO - Unicode yes, no
strings are converted to ASCII characters for terminator table export.

Electromechanical

trace_thru_splice_connector

Report the from/to connectors of cables passing through splices correctly. yes, no

no

Electromechanical

update_harness_mfg_line_co
lor
update_loom_bundle_data
update_pre_130_harness

Update cable line color for harness-mfg part created in release 2000i or
earlier.
Setup whether to update loom bundle data from old harnesses.
Yes - When a cable is added between two previously laid out locations in
a three-dimensional reference harness, display of the new cable will
update automatically in pre-Release 13 flattened cable models.

yes, no

no

yes, no
yes, no

no
no

yes, no

no

Electromechanical
Electromechanical

Electromechanical

Environment
Environment

Environment

Environment
Environment
Environment

update_pre_16_cable_layers Yes - Harnesses containing cables routed prior to Release 16.0 will be
automatically updated upon retrieval to comply with new display
standards.
accuracy_lower_bound
Enter an accuracy value to override the default lower limit. The minimum
value for relative accuracy is 1E-06.
activate_window_automaticall Yes - Execute Activate command automatically after a window is selected.
y
No - Don't execute Activate command automatically after a window is
selected.
bell
Yes - Turns on the keyboard bell that rings after each prompt. No - Turns
off the keyboard bell. To override this setting use the Environment dialog
box on the Tools menu.
clearance_triangulation
Specifies the quality of surface triangulation used to obtain initial guess
points for clearance and interference calculations.
clock
Yes - Displays the clock while Creo Parametric is working.
clr_print_plus_minus
Sets the display of the system accuracy when calculating clearances
between two parts or surfaces. The default is to not display the accuracy.

Environment

company_name

Environment
Environment

default_abs_accuracy
des_exp_confirm_on_save

PTC Inc.

Default Value
yes

0.0001
yes, no

yes

yes, no

no

none, high, medium, low

none

yes, no
yes, no

no
no

Used with the export option iges_out_mil_d_28000. To support MIL-D28000, your company name is required input and the system prompts you
every time you export through IGES unless you set the company name in
your configuration file.
Defines the default absolute part accuracy.
When you use a `Save` command during a Design Exploration session, it yes, no
does not save the session, it prompts to add a new checkpoint.
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Values

0
yes
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Category
Environment

Name
des_exp_create_auto_cps

Description
Set the maximum number of automatically created checkpoints allowed.
Additional checkpoints override previous checkpoints. Type a value from 1
to 99. Type 0 to prevent automatic checkpoint creation.

Environment

des_exp_create_backups

Environment

des_exp_data_path

Back up all models in session when starting Design Exploration and all
yes, no
models opened and modified during the session. When backup is on,
starting a Design Exploration session might take some time.
Sets the directory for the Design Exploration session. The default location
is in a default system folder. Type a valid file path to change the directory
to a user defined one. Data from only one session is stored.

Environment

des_exp_display_type

Environment
Environment
Environment

Environment
Environment

Environment
Environment
Environment

Environment

PTC Inc.

Set the default display of the Checkpoint Tree. 'Tree' - Displays all
branches in the Checkpoint Tree. 'Timeline' - Displays checkpoints in
chronological order (des_exp_display_type).
des_exp_show_cp_props_dia Open the Checkpoint Properties dialog box when you add a new
log
checkpoint, or turn an automatic checkpoint into a regular one.
display_annotations
Determines whether or not annotations are displayed in 3D models.
display_full_object_path
Controls the display of the object's full file name (including its object-type
suffix and its version number) and file path in the window title and Model
Info display. Yes - Displays full file name and file path. No - Displays object
name only.
display_model_anls_selectio Determines whether or not to highlight the selected components during a
n
Model Analysis.
enable_absolute_accuracy
Controls display of the ACCURACY menu. Yes - ACCURACY menu
always appears when you choose Accuracy from the PART SETUP menu.
No - The menu appears only if the part is currently defined with absolute
accuracy.
flip_arrow_scale
Sets a scale factor for enlarging the size of the flip arrow that appears for
feature creation direction (default = 1).
highlight_geometry
Yes - Items selected in the model tree are highlighted in the geometry
area.
info_output_format
Setup the default format type for information presentation. Text information will be output as simple text. HTML - information will be output
as html data.
info_output_mode
Sets default method for presenting information. Both - View information on
screen and write information to file. Screen - View information on screen
only. File - Write information to file only. Choose - Select method from the
INFO OUTPUT menu.
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Values

Default Value

no

tree, timeline

tree

yes, no

yes

yes, no
yes, no

yes
no

yes, no

no

yes, no

no

1
yes, no

yes

text, html

html

both, choose, screen, file

both
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Category
Environment

Environment

Description
Enables Intelligent Fastener. You must restart Creo for the setting to take
effect.
mass_property_calculate
Calculate mass properties upon regeneration, upon save or by user
request
mathcad_automapping
Toggles Mathcad analysis automapping of variables
mdx_collision_num_triangles The number of mesh triangles which are used to approximate model in
collision detection.
measure_sig_figures
Sets the number of significant figures displayed as results when using the
Measure dialog box from the Info menu.
model_grid_balloon_display Controls the display of grid balloons.

Environment

model_grid_neg_prefix

Environment

model_grid_num_dig

Environment
Environment

model_grid_spacing
model_notes_as_labels

Environment

model_tree_start

Environment
Environment

modelcheck_enabled
Enable ModelCHECK
mp_auto_update_precreo_m no - Creo does not recalculate the mass properties of legacy parts upon
odels
retrieval of a model. yes - Creo recalculates mass properties of legacy
parts upon retrieval of a model except for legacy parts with no assigned
density.
part_mp_calc_ignore_alt_mp Yes (default) - Creo uses the calculated mass (mass=volume*density) to
calculate part mass properties. No - Creo uses the user-defined value of
PRO_MP_ALT_MASS if the value of PRO_MP_SOURCE is Geometry
and Parameters or Fully Assigned.

Environment
Environment
Environment
Environment

Environment

Name
intelligent_fastener_enabled

Environment

prehighlight

Environment

prehighlight_tree

PTC Inc.

Values
yes

automatic, by_request,
check_upon_save
yes, no

by_request
no
1000
6

yes, no

Enables you to specify the prefix to use for negative numbers in the
balloon capture of the grid.
Controls the number of decimal places displayed in the balloon capture. 0 Only integers display.
Sets the default model grid spacing.
Gives the option to display notes as either full text or as label. Can also be yes, no
toggled with environment option "Display Notes as Names."
Toggles display of the Model Tree. Yes - Displays the Model Tree window yes, no
along with its model. No - Does not display the Model Tree window.

yes
-

1.5
no
yes

yes, no
yes, no

yes
no

yes, no

yes

Yes - Selectable items beneath the pointer are highlighted prior to being
yes, no
selected. No - Selectable items beneath the pointer are not highlighted
prior to being selected.
Default value for "Preselection Highlighting" option in the model tree, layer yes, no
tree, detail tree and layout tree. When enabled, selectable items are
highlighted prior to being selected in the tree.
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Default Value

yes, no

no
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Category
Environment

Name
pro_unit_length

Description
Sets the default units for new objects.

Environment

pro_unit_mass

Sets the default units for mass for new objects.

Environment

pro_unit_sys

Specifies the default system of units for new models.

Environment

proe_memory_buffer_size

Environment

Environment
Environment
Environment

Environment

Environment
Environment
Environment
Environment
Features

Features

PTC Inc.

Specify the size in megabytes of the memory buffer to be reserved by
Creo Parametric for system out of memory condition. You must restart
Creo Parametric for the change to take effect.
regen_backup_directory
Specifies the directory in which the system stores regen_backup models.
(See regen_backup_using_disk.) The primary default is the current
directory, but if that directory is read-only, the secondary default is the /tmp
directory.
regen_backup_using_disk
Specifies whether or not the system backs up the current model to disk
before each regeneration.
save_section_surfaces
Yes - Save section surfaces with models. No - Do not save section
surfaces with models.
select_on_dtm_edges
All_modes - Select a datum plane by clicking on its visual boundary.
Sketcher_only - Select a datum plane by clicking on its tag in modes other
than Sketcher. If you use Query frequently, set this option to
Sketcher_only.
show_dim_sign
No - Dimension values always appear positive. Negative value creates
geometry to opposite side. Yes - Entering negative value for dim displayed
as negative creates geometry to same side. Dims for csys and datum
point offsets always show neg/pos value.
show_selected_item_id
Show id of Creo Parametric and Sketcher geometry in query selection bin,
collector and tool tip.
spin_center_display
Determines whether or not the spin center symbol displays.
start_appmgr
Determines whether or not the application manager starts when Creo
Parametric is started.
startup_check_for_visualizati Determines whether or not the visualization components are checked for
on
installation upon startup.
allow_anatomic_features
Allow the creation of pre-Pro/ENGINEER 2000i geometry features
including ear, neck, lip, slot, flange, shaft, local push, radius dome and
section dome.
allow_fully_dependent_copy Enables the usage of advanced copy/paste functionality to control degree
of dependency on the pasted object.
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Values
unit_inch, unit_foot, unit_mm,
unit_cm, unit_m
unit_ounce, unit_pound,
unit_ton, unit_gram,
unit_kilogram, unit_tonne
mks, cgs, mmns, fps, ips,
proe_def, mmks

Default Value
unit_inch
unit_pound
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yes, no

no

yes, no

yes

all_modes, sketcher_only

all_modes

yes, no

no

yes, no

no

yes, no
yes, no

yes
yes

yes, no

yes

yes, no

no

yes, no

yes
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Category
Features

Features
Features
Features

Features

Name
Description
allow_udf_style_cosm_thread Defines the Cosmetic Thread user interface. Yes - Creates a Cosmetic
yes, no
s
Thread as a UDF. No - Creates a Cosmetic Thread as a Cosmetic Thread
feature.
angle_grid_interval
Modify grid space in angular units for handle movement.
auto_add_remove
Allows Creo Parametric to automatically switch from add to remove of
yes, no
material for solid extrude and revolve during feature creation.
autohide_copied_group_af
If set to yes, copying a feature group containing an Annotation feature will yes, no
automatically hide the Annotation Features in the new group.

Default Value
no

1
yes
no

Features
Features

If set to yes, a Sketch feature is automatically hidden after being used as
external sketch for a sketch based feature.
autoround_max_n_chains_pe Determines the maximum number of edge chains that the Auto-Round
r_feat
algorithm will attempt to round in each Auto-Round member
centimeter_grid_interval
Modify grid space in centimeter units for handle movement.
copy_set_datum_attr
If set to yes, allow to copy set datum associated with datum features..

yes, no

0.1
yes

Features
Features
Features

default_dep_copy_option
display_draggers
dynamic_preview

full_dep, dep_dim
yes, no
no, attached, unattached

dep_dim
yes
attached

yes, no
yes, no

yes
yes

yes, no

yes

yes, no

no

yes, no

no

Features

Features
Features

Features

Features

Features

PTC Inc.

autohide_external_sketch

Values

Sets Full Dependent Copy as a default copy option.
Display Dragger for Edit mode.
Controls the default state of geometry preview within a feature tool.
Attached/Unattached - Dynamic attached/unattached geometry preview
will be enabled. No - Geometry preview will not be enabled.
enable_auto_regen
Enable Auto Regeneration for Unified Edit Mode.
enable_remove_notifications Presents a notification dialog when the result of a Remove feature creates
a surface with a flipped normal, an intersection with non-adjacent
geometry or geom check errors. Setting this option to no will not issue
the notification.
enable_tapered_extrude
Enables you to add a taper to an extrude feature by displaying the Add
taper check box and the taper degree value box on the Extrude tab
Options tab. yes - The Add taper check box is displayed. no - The Add
taper check box is not displayed.
fail_unattached_feature
Handles unattached protrusion and cuts, when retrieving pre-Release 15
models. Yes - When a part is retrieved, the system fails an unattached
protrusion or cut. No - When a part is retrieved, the system does not fail
an unattached protrusion or cut.
feature_create_auto_begin
In feature creation, determines whether or not the Define button is
automatically activated when you open the dialog box. Yes - Button is
activated automatically. No - You select the button.
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yes, no

yes
20
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Category
Features

Features

Features
Features
Features

Name
feature_create_auto_ok

Description
In feature creation, determines whether or not the system activates the
dialog box OK button automatically when the last required element is
defined. Yes - Button is activated automatically. No - You select the
button.
feature_type_default
It sets the solid or surface default type for feature creation. The Advanced
option sets the default type for Extrude and Revolve to solid, and all others
to Surface.
flex_maintain_solution_topolo Initial value for the "Maintain solution topology" option in created flexible
gy
modeling features.
foot_grid_interval
Modify grid space in foot units for handle movement.
hole_diameter_override
No- Uses hole-table-driven standard hole diameter value. Yes - Allows
specifying the drilled hole value instead of the standard value.

Features

hole_file_resolution

Specify Hole tool to use external hole parameter (.hol) files.

Features

hole_parameter_file_path

Specifies the directory path for a standard screw-size parameters (.hol) file
to be loaded from disk. Use the full path name to avoid problems.

Features
Features

inch_grid_interval
keep_info_datums

Features
Features
Features
Features
Features

Features
Features
Features
Features
Features

PTC Inc.

Values
no

solid, advanced, surface

solid

yes, no

no

yes, no

0.083333
no

replace_with_external,
use_internal

Modify grid space in inch units for handle movement.
Sets the initial state of how the system treats datums and features created yes, no
at run time.
max_regen_time_attach_pre Sets the maximum regeneration time for the dynamic attached preview.
view
merge_type
Sets the default merge type surface merge operations.
join, intersect
meter_grid_interval
Modify grid space in meter units for handle movement.
millimeter_grid_interval
Modify grid space in millimeter units for handle movement.
pro_group_dir
Sets the default directory for the user-defined feature (UDF) library. If not
specified, your current working directory is the default. Use the full
pathname to avoid problems.
ratio_grid_interval
Modify grid space in percentage units for handle movement.
show_geom_checks_on_cre Yes - The SHOW ERRORS menu appears at the end of feature creation yes, no
ation
when the feature being created has Geometry Checks.
troubleshooter_show_info_gc When set to Yes this option will add a "Show info items" filter to the View yes, no
heck
panel in the Troubleshooter.
udf_af_name_postfix
If set to yes, a sequential number will be appended to the name of
yes, no
annotation feature in group from Copy and UDF placement.
user_defined_grid_interval
Modify grid space in user defined length units for handle movement.
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Default Value

yes, no

replace_with_external

0.03125
yes
0.5
intersect
0.001
0.1

0.05
no
no
yes
0.5
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Category
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval

File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval

File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval

PTC Inc.

Name
Description
analysis_crt_tmp_file_on_reg Determines whether regeneration of analysis features creates/updates
en
tmp files
browser_favorite
Specifies the directories visible in the file browser for quick navigation.
Use the full path to avoid problems.
compress_output_files
Yes - Stores object files in a compressed format. Note: Compressed files
are usually smaller, buy may be larger, than uncompressed files.
Compressed files are slower to read and to write to.
dir_cache_max
Specify the maximum number of directories to cache. Larger values can
speed up file access, but use more memory.
disable_search_path_check Controls whether the search path is checked for name conflicts when
creating, renaming, or copying models. Name conflicts should be avoided
because different models with the same name cannot be together in
session.
excel_analysis_directory
Sets the default directory for the MS Excel files to be used for Excel
analysis calculations. Use the full pathname to avoid problems.
excel_family_table_keep_file Yes - in case of editing family table with excel, if saved excel file exist , will
always update it.
exec_prog_on_assem_retr
Execute pro/program for models during assembly retrieval.
external_analysis_directory
file_open_default_folder

file_open_default_view
file_open_preview_default
file_open_preview_delay

Sets the default directory for the files to be used by External Analysis
calculations. Use the full pathname to avoid problems.
Sets default dir for File>Open. Working_directory - Search working
directory. In_session - Search objects in session. Pro_library - Use only if
Pro/LIBRARY is installed. Workspace - Use only with Pro/INTRALINK.
Commonspace - Use only with Pro/INTRALINK.
Specify the initial Views setting as List or Details in the File dialog boxes.
Controls whether the preview area is expanded by default when the file
open dialog or local file browser is displayed.
The delay before a file selection is previewed, in tenths of a second.

Values
yes

yes, no

no

256
yes, no

no

yes, no

no

yes, no

no

default, working_directory,
in_session, pro_library,
my_documents, desktop,
workspace, server
list, details

list

expanded, collapsed

collapsed

force_new_file_options_dialo Force the use of the New File Options dialog.
yes, no
g
generate_viewable_on_save Controls whether updated Creo View .edz files are automatically exported yes, no
every time a model is saved.
geometry_analysis_color_sch Specifies the location of the geometry analysis color scheme file.
eme
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Default Value

yes, no

no
no
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Category
File Storage &
Retrieval

File Storage &
Retrieval
File Storage &
Retrieval

Name
Description
instance_search_exhaustive Specifies extent of instance search. Yes - Include file type when entering
instance name in File>Open: type in input panel (e.g. inst_name.prt) or
select in drop-down list. If no .idx files are found, only working dir is
searched; each generic is not.
lang_propagate
Specifies language storage options. The option provides flexibility for
objects that use a different language than the current
mathcad_analysis_directory Sets the default directory for the Mathcad files to be used for Mathcad
analysis calculations. Use the full pathname to avoid problems.

File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval

menu_show_instances

File Storage &
Retrieval

modified_objs_in_new_dir

File Storage &
Retrieval
File Storage &
Retrieval

File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval

PTC Inc.

mfg_start_model_dir
model_rename_template

Determines whether instance names listed in instance index files appear
in file lists.
Provides the complete path to the directory containing mfg start
assemblies.
Sets the default renaming convention for copied assemblies. The default
new name is the old name appended with an underscore (_). Adding a
template such as &#91;*a1*=*b1*] changes every occurrence of a1 to b1
(e.g. TOP_A1_BRACKET copies to TOP_B1_BRACKET).

Values
no

yes, no

yes

yes, no

yes

Yes- During Save a Copy operations, any modified object that is not
yes, no
renamed will be saved in the new directory. No- Any modified object that
is not renamed will be saved to the retrieval directory.
open_draw_simp_rep_by_def Set to "Yes" to always invoke the open rep dialog when opening a
yes, no
ault
drawing.
open_simplified_rep_by_defa Retrieves a model in a specified representation. Yes - uses Open Rep
dialog. No - retrieves the Master representation. Specified Name ult
retrieves the model in the specified representation name if it exists or the
Default representation.
override_store_back
Forces the storage of objects retrieved from other directories to the
yes, no
current working directory.
placement_rep_by_default
Retrieves the assembled component in a specified representation. None retrieves the representation specified in configuration option
open_simplified_rep_by_default.
preferred_save_as_type
Allows customizing the order of the Type selections found under File >Save A Copy.
pro_crosshatch_dir
Specifies a default directory for your cross-hatch library in which you can
save cross-hatching patterns for later retrieval. Its value is the full path
name of the default directory.
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Default Value

yes, no

no

no
no

no
none
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Category
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval

File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval

PTC Inc.

Name
pro_font_dir

Description
Sets the default font directory (Creo Parametric will load all fonts in this
directory into the drawing regardless of the contents of the system and
working directories).
pro_library_dir
Sets the default directory for the Creo Parametric libraries (or any libraries
you have built containing the proper index menu files). Use the full
pathname to avoid problems.
pro_material_dir
Sets the default directory for the part material library. Use the full
pathname to avoid problems.
pro_surface_finish_dir
Sets the default directory for your user-defined surface finish symbols.
Use the full pathname to avoid problems.
prompt_on_erase_not_disp Specifies whether or not to display a prompt allowing you to save your
undisplayed objects. This option is used in conjunction with the Erase >
Not Displayed command on the File menu.
propagate_change_to_parent When saving objects with option save_objects set to Changed or
s
Changed_and_specified, Creo Parametric verifies which models are. Yes Any model that is a parent of a changed model is considered to be a
changed model when determining what to save.
read_famtab_file_on_retrieve No - Ignores filename.ptd. Yes - Creates and saves filename.ptd and uses
that file when retrieving the generic.
regen_simp_retrieve
Regenerate the assembly when retrieving an assembly simplified
representation. Yes - Regenerates the assembly on retreival. No - The
assembly is not regenerated on retrieval.
rename_drawings_with_objec Controls whether the system copies associated drawings automatically
t
with parts and assemblies.
retain_display_memory
Determines if the display of an object currently on the screen is kept in
memory when you quit the window. Doing so (yes) makes the retrieval of
objects in memory faster.
save_clipped_view
Yes - clipping status is saved with model. No - clipping status is not saved.
save_dialog_for_existing_mo Controls whether the Save dialog is shown for models whose storage
dels
location is already known.
save_file_iterations
Yes - Iterations of a file will be saved. No - Iterations of a file will not be
saved.
save_instance_accelerator
With family tables of solid parts, determines saving instance accelerators.
None - Accelerator files not used. Explicit - Save when instance is
explicitly saved. Saved objects - Save when objects were modified. Always
- Always save.
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Values

Default Value
<creo3.0_loadpoint>\text
\fonts\

yes, no

<creo3.0_loadpoint>\sy
mbols\surffins\
no

yes, no

no

yes, no

no

yes, no

no

none, both, part, assem

none

yes, no

yes

yes, no

no

yes, no

no

yes, no

yes

none, explicit, always,
saved_objects

saved_objects
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Category
File Storage &
Retrieval

Name
save_model_display

Description
Values
Sets amount of graphical data stored. Wireframe - Wireframe data.
wireframe, shading_low,
Shading_high - Most detail (shaded). Shading_low - Least detail (shaded). shading_high, shading_lod
Shading_lod - Detail determined by View Performance dialog (shaded).

Default Value
shading_lod

File Storage &
Retrieval

save_object_in_current

Use with the override_store_back option. Yes - Objects retrieved from a
directory where you do not have write permission will be stored in the
current directory. No - These objects are not saved at all.

yes, no

no

File Storage &
Retrieval

save_objects

Determines when an object and its dependent objects (such as a part
used in an assembly) are stored.

changed_and_specified

File Storage &
Retrieval
File Storage &
Retrieval

saving_model_thumbnails

Enables saving of model thumbnails.

all, changed,
changed_and_specified,
changed_and_updated
yes, no

search_path

File Storage &
Retrieval

search_path_file

File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval

set_model_types_to_save

Specifies list of directories to search (in order) for object/file retrieval.
These directories, the working directory, and directories in search.pro file
(refer to search_path_file) are Creo Parametric's search path. Use full
path name to avoid problems.
Specifies path to text file search.pro (a list of directory path names). The
directories listed in search.pro, the working directory, and directories
specified by search_path are Creo Parametric's search path. Use full path
name to avoid problems.
Determines which model types are used in the Save Changed command.
The format is a list of extensions separated by spaces.
Provides the complete path to the directory containing start parts and
assemblies.
Specify the model to use as the default new ECAD board template.

PTC Inc.

start_model_dir
template_boardpart
template_designasm

yes

asm prt drw sec mfg gph
ipf cem

template_drawing

Specifies the designated template assembly. Use full path to avoid
problems.
Specify the drawing used as the default drawing template.

template_ecadasm

Specify the model used as the default ECAD assembly template.

template_ecadpart

Specify the model used as the default ECAD part template.

template_mfgcast

Specify the model used as the default manufacturing cast template.

inlbs_mfg_cast.asm

template_mfgcmm

Specify the model used as the default manufacturing cmm template.

inlbs_mfg_cmm.asm
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inlbs_asm_design.asm
c_drawing.drw
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Category
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval

Freestyle Feature
Layers
Layers
Layers

PTC Inc.

Name
template_mfgemo
template_mfgmold

Description
Specify the model used as the default manufacturing expert machinist
template.
Specify the model used as the default manufacturing mold template.

Values

Default Value
inlbs_mfg_emo.asm

template_mfgnc

Specify the model used as the default manufacturing assembly template.

inlbs_mfg_nc.asm

template_module

inlbs_asm_module.asm

template_mold_layout

Specifies the default module template file. Use full pathname to avoid
problems.
Specify the mold layout assembly used as a default template.

template_new_ecadasm

Specify the model to use as the default new ECAD assembly template.

template_sheetmetalpart

Specify the model used as the default sheetmetal part template.

template_solidpart

Specify the model used as the default part template.

inlbs_mfg_mold.asm

inlbs_mold_lay.asm

inlbs_part_sheetmetal.pr
t
inlbs_part_solid.prt

update_accelerator_in_verify No* - Does not update existing accelerators upon family table verification
for changes. Yes - Update existingaccelerators upon family table
verification for changes
use_outdated_accel_in_geo This option controls the usage of outdated accelerator files during retrieval
m_rep
of instances in geometry representation. Yes - Provides the fastest
retrieval. No - Ensures accurate Retrieval.
use_temp_dir_for_inst
Explicitly makes Creo Parametric use the Temp directory for regenerating
instances of models.
verify_on_save_by_default
Yes - "Verify Now" action will be selected in the conflict dialog by default
when an unverified family table instance is to be saved in PDM
workspace. No - "Verify Now" action will not be selected by default. The
user may explicitly specify the "Verify Now" action in the conflict dialog.

yes, no

no

yes, no

no

yes, no

no

yes, no

no

freestyle_drag_performance

yes, no

yes

yes, no

no

yes, no

no

Yes - Improve performance during drag by temporarily reducing graphics
quality. No - No reduction in graphics quality during drag.
add_lower_level_comps_to_l Setting this option to yes will check off the Favor Current Layer option,
ayer
which allows lower level components to be added to top level layers.
blank_layer
Blanks specified layers when you begin a Creo Parametric session. The
value is the layer ID.
create_numbered_layers
Yes - Creates default layers named 1 through 32.
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Category
Layers

PTC Inc.

Name
def_layer

Description
Specifies default layer names for different types of items. The first value
string is the layer type. The second value string is the layer name.
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Values
layer_assem_member,
layer_assy_cut_feat, layer_axis,
layer_chamfer_feat,
layer_comp_design_model,
layer_comp_fixture,
layer_comp_workpiece,
layer_copy_geom_feat,
layer_corn_chamf_feat,
layer_cosm_round_feat,
layer_cosm_sketch, layer_csys,
layer_curve, layer_curve_ent,
layer_cut_feat, layer_datum,
layer_datum_plane,
layer_datum_point,
layer_detail_item,
layer_dgm_conn_comp,
layer_dgm_highway,
layer_dgm_rail,
layer_dgm_wire, layer_dim,
layer_draft_constr,
layer_draft_dim,
layer_draft_dtm,
layer_draft_entity,
layer_draft_feat,
layer_draft_geom,
layer_draft_grp,
layer_draft_hidden,
layer_draft_others,
layer_draft_refdim,
layer_driven_dim,
layer_dwg_table,
layer_ext_copy_geom_feat,
layer_feature, layer_geom_feat,
layer_gtol, layer_hole_feat,

Default Value
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Category

Name

Layers

default_layer_model

Layers

display_layer

Layers

floating_layer_tree

Layers

highlight_layer_items

Layers

layer_item_highlight_limit

PTC Inc.

Description

Values
layer_intchg_funct,
layer_intchg_simp,
layer_nogeom_feat, layer_note,
layer_parameter_dim,
layer_part_refdim, layer_point,
layer_protrusion_feat,
layer_quilt, layer_refdim,
layer_ribbon_feat,
layer_rib_feat,
layer_round_feat, layer_sfin,
layer_shell_feat,
layer_skeleton_model,
layer_slot_feat, layer_snap_line,
layer_solid_geom,
layer_surface, layer_symbol,
layer_thread_feat,
layer_trim_line_feat,
layer_weld_feat,
layer_all_detail_items,
layer_annotation_element,
layer_axis_ent, layer_csys_ent,
layer_set_datum_tag,
layer_3d_items,
layer_ae_driving_dim,
layer_draft_xsec,
layer_hole_thread

Name of the model which is used to drive rule-based layer placement of
new items in all models of the same type in session.
This causes the specified layers to display when you begin a Creo
Parametric session. The variable "value" is the layer Id.
Set to yes if user wants to see a layer tree dialog separated from
yes, no
navigator.
Yes - Items selected in the layer tree are highlighted in the geometry area. yes, no
Set the upper limit of items in a layer for highlighting. If items in a layer
exceeds this number, highlighting will not occur.
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Default Value

no
yes
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Category
Layers

Layers

Layout

Name
save_display_status_in_sub
model

Description
If set to no, the top level assembly will store sub model layer display
status, allowing lower level display status to be stored without having to
save the sub models.
save_hidden_items_w_status The items on the "Hidden Items" temporary layer are stored permanently
when layer display status is saved with Save Status command.

Layout
Layout
Layout

layout_feat_copied_geom_thi
ck
layout_scroll_bars
layout_snap
layout_symbol_dir

Manufacturing

allow_mfg_in_assem_mode

Manufacturing

assy_mfg_open_mode

Manufacturing

autodrill_udf_dir

Manufacturing
Manufacturing

campost_dir

Manufacturing

chk_part_surfs_profpock

Manufacturing

cl_arrow_scale

Manufacturing

cl_rotate_sign_convention

Default Value
yes

yes, no

yes

Layout feature - Copied geometry thickness.

1, 3, 2, 4, 5, 1.5, 2.5, 3.5, 4.5

1.5

Show/Hides scroll bars.
Enable/Disable snapping to geometry and guides.
Set and automatically create the default directory for saving and retrieving
user-defined symbols. If you do not specify a directory, Layout will use the
same directory as Creo Parametric drawings. Use full path name to avoid
problems.
Allows a manufacturing model to be opened in assembly mode from the
file open dialog. Use "Open In Assembly Mode" option in "File Open"
dialog.
No Default Application set for opening Assembly NC Models.

yes, no
yes, no

yes
yes
<dir_name>\dump_x86e
_win64\

yes, no

no

mfg, process, feature,
any_mode

any_mode

Storage directory for holemaking MUDF's that are used by Pro/NC Autodrilling functionality
autodrilling_config_filename Retrieve automatically and load the configuration file for the auto-drilling
table.
autodrilling_holestyle_param Parameter name included in hole features of a manufacturing reference
model. The parameter value identifies the MUDF for holemaking that is
automatically applied in Pro/NC to drill these holes.

Manufacturing

PTC Inc.

Values
yes, no

Specifies the CAM-Post load point directory to enable you to directly setup the post-processors and generate MCD files.
Yes - Includes all reference part surfaces as check surfaces for profiling
and pocketing NC sequences.
Enables you to control the size of the tool path arrow for contouring NC
sequences. 0 - The arrow does not display. Any other value - The arrow
scales accordingly.
TOOL or TABLE - defines ROTATE sign direction convention based with
respect to either rotation table or cutting tool.
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autodrilling

yes, no

no
1

table, tool

table
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Category
Manufacturing
Manufacturing

Manufacturing
Manufacturing

Name
Description
cmm_custom_tool_param_fil Defines the file that contains the user-defined tool parameters' list.
e
display_mfg_icon_for_mfg_a Yes- Display manufacturing icon for manufacturing assembly files in
yes, no
Open/Save dialogs. No- the manufacturing assembly files have assembly
ssy
icons.
enable_2x_traj_multi_loops Enables selection of loops on surfaces for curve trajectory sequence.
yes, no

Default Value

no

no

yes, no

yes

yes, no

no

yes, no

no

yes, no

yes

Manufacturing

mfg_auto_ref_prt_as_chk_srf Yes - In 3, 4, and 5 axis contour and conventional mill sequences, the
entire reference part is selected as check surfaces by default when
computing the NC sequence toolpath for those sequences. No - You
select the check surfaces.
mfg_auto_retract_clear_dist Specifies distance between automatically created retract plane and step
coordinate system. Will be applied to the new steps created in process
manager if operation retract cannot be used.
mfg_comments_text_area_si Controls the number of lines available for comments without scrolling in
ze
NC steps dashboard UI.
mfg_custom_tool_param_file Defines the file that contains the user-defined tool parameters' list.

Manufacturing

mfg_customize_dialog

yes, no

yes

yes, no

yes

top_left, bottom_right

10
top_left

all, none, misc, cutting

none

Manufacturing
Manufacturing
Manufacturing
Manufacturing

Manufacturing

Manufacturing

Manufacturing
Manufacturing
Manufacturing
Manufacturing

Manufacturing

PTC Inc.

enable_param_n_tool_upd_di Enable parameters and tool updation dialog.
alog
gpostpp_dir
Specifies the directory containing the post processor files to be used by
Pro/NCPOST (GPOST).
ignore_templ_pos_for_new_t Ignore pocket number from template for tools added to a workcell. Use
ool
first available pocket.
mfg_auto_ref_mfg_template Enable/Disable auto referencing for Manufacturing template

Values

Yes - Uses the new customize dialog box for customizing NC sequences.
No - Uses the Release 19.0 menus.
mfg_cutline_save_mesh
Yes - Save / Retrieve Mesh for subsequent cutline recalculations, No New Mesh will be computed for each cutline recalculations.
mfg_ijk_num_digits
Sets the number of digits for i, j, k data points in a CL data file.
mfg_info_location
top left /bottom right -Position of the mfg. Info dialog box.
mfg_modal_command_file
Enables you to make some of the APTn index topics modal, which means
that you repeatedly get a list of major keywords corresponding to this topic
upon completing a command line.
mfg_param_auto_copy_from Do not copy any parameter of the tool to the sequence parameter tree.
_tool
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Category
Manufacturing
Manufacturing

Manufacturing
Manufacturing
Manufacturing
Manufacturing
Manufacturing

Manufacturing

Name
mfg_process_print_dir

Description
Specifies the directory where Mfg Process html page get stored. Use the
full pathname to avoid problems.
mfg_process_sync_by_defaul Specifies whether all steps created in the Process Manager get
yes, no
t
automatically synchronized with features in the Pro/NC assembly. You can
change steps later in the dialog box open during the session.
mfg_process_table_setup_dir Specifies the directory where Mfg Process Table settings get stored. Use
the full pathname to avoid problems.
mfg_process_template_dir
Specifies the directory where Mfg Process Templates get stored. Use the
full pathname to avoid problems.
mfg_setup_dir
Specifies the directory which contains all manufacturing related setup files
for the current session.
mfg_stock_display_show_def Sets the default visibility status of the Stock Model after creation.
yes, no
ault
mfg_tbl_comment_from_retr_ Controls whether the mfg tool comment is getting copied from
yes, no
tool
TOOL_COMMENT parameter of the retrieved tool to the tool manager
table comment.
mfg_template_dir
Specifies the storage directory for NC templates. Specify full path to avoid
problems. NC templates are used in Expert Machinist. Templates store
the recipe for a toolpath as the method of tool retrieval.

Default Value

yes

no
no

Manufacturing
Manufacturing

mfg_tool_dialog_setup_file
mfg_tool_preview_by_pick

Manufacturing

mfg_udf_info_setup_file

Manufacturing

mfg_workpiece_transparency Controls the workpiece transparency in shaded model display. You can
change the value in the range between 0.1 and 1. The bigger the value,
the more transparent the workpiece. The default value is 0.5.

0.67

Manufacturing
Manufacturing

mfg_xyz_num_digits
nc_autodoc_param_dir

10

Manufacturing

nc_autodoc_report_dir

Manufacturing

nc_autodoc_setup_dir

PTC Inc.

Specifies the XML based file to setup Tool Dialog.
Enables preview of a milling tool at a specified location on the tool path or yes, no
geometry of the part.
Specify name and path of the file containing udf and mfg criteria values .

Values

Sets the number of digits for x, y, z data points in a CL data file.
Location of the setup file that describes which process parameters are
included in the parameter table.
Location for storing the report and images generated by the shop floor
documentation tool.
Location for documentation setup files that describe which process
parameters are included in the parameter table.
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Category
Manufacturing

Manufacturing

Description
Location of the style sheet and default images used for shop floor
documentation.
nccheck_type
Vericut will be used for NC material removal simulation.
ncl_file_extension
Sets the default file extension for Pro/MFG CL data files. Enter the file
extension only (without the preceding "."). For example, apt produces
filename.apt.
ncmdl_bar_stock_part_path Sets path for storage and retrieval of stock instances for creating
workpiece in NC Model. Specify full path, including part name, to avoid
problems.
ncmdl_billet_stock_part_path Sets path for storage and retrieval of stock instances for creating
workpiece in NC Model. Specify full path, including part name, to avoid
problems.
ncpost_type
Set to GPOST to access the default post processor supplied with
Pro/NCPOST.
ncseq_outbound_curve
Yes - Create out bound curve.
new_turn_scan_type
Allows to use New turn scan types for Turning NC sequences.
pro_mdb_dir
Sets the default directory for the Machinability Database (MDB) files. Use
the full pathname to avoid problems.
pro_mf_cl_dir
Sets the default directory for the manufacturing CL data files.Use the full
pathname to avoid problems.
pro_mf_clamp_dir
Specifies the directory where the manufacturing clamps can be found.

Manufacturing

pro_mf_param_dir

Manufacturing

pro_mf_tape_dir

Manufacturing

pro_mf_tprm_dir

Manufacturing

pro_mf_workcell_dir

Manufacturing

pro_mfg_cmdsyn_dir

Manufacturing

profile_output_utils

Manufacturing

proncpost_dbf

Manufacturing
Manufacturing

Manufacturing

Manufacturing

Manufacturing
Manufacturing
Manufacturing
Manufacturing
Manufacturing

PTC Inc.

Name
nc_autodoc_template_dir

Values

vericut, nccheck

vericut
ncl

<creo3.0_loadpoint>\text
\ncmdl_data\ncmdl_bar.
prt
<creo3.0_loadpoint>\text
\ncmdl_data\ncmdl_billet
.prt
gpost, ncpost
yes, no
yes, no

Sets the default directory for the manufacturing parameter files. Use the
full pathname to avoid problems.
Sets the default directory for the manufacturing TAPE data files.Use the
full pathname to avoid problems.
Sets the default directory for the manufacturing tool files. Use the full
pathname to avoid problems.
Sets the default directory for the manufacturing workcell files. Use the full
pathname to avoid problems.
Sets the default directory for the syntax menu files in Pro/MFG. Use the
full pathname to avoid problems.
Affects CL-Data output for profile milling sequences. Yes - Sequence
yes, no
parameter output_point is available with options: tip - Toolpath is output
with respect to the tool center; on_profile - Toolpath is output with respect
to the profile of the tool.
Enter directory path to NCPost database file.
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Default Value

no
yes

no
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Category
Manufacturing

Manufacturing

Manufacturing

Name
Description
prorembatch_queue_manage Enables toolpath computation on a separate host machine. Required
r
values are Processor name, Remote machine's hostname, Type of
transport (always 0), RPC processor number (same as that of remote
processor), Version of queue manager.
reverse_spiral_finish_type
If the option value is 1, the tool path is obtained from standard one by
reversing it; if the option value is 2, the tool path starts from an inner circle.

Manufacturing

No - Does not process reference parts when generating the shaded image
(to save time). Yes - Shades reference parts when generating shaded
images.
store_tool_path_file
Specifies how tool path information is computed. Yes - Tool path
information stored in file filename.tph (filename is manufacturing model
name). No - Tool path is computed each time manufacturing model is
retrieved or parameters are changed.
tool_motion_list_length
Controls the number of rows visible in the tool motion list without scrolling.
This value is applied to dashboard based NC Steps.
tool_path_preview_default
Sets tool path preview default mode to OFF.
turn_avoid_holder_interferen Yes - Tool holder interference will be ignored during Turning toolpath
ce
calculation.
wcell_fixt_info_setup_file
Specify name and path of the file containing workcell and fixture name
info.
workpiece_instances
Cut out are created in Workpiece but not the family table instances.

Mechanism
Mechanism
Mechanism
Mechanism
Mechanism

mdo_cl_executable
mdo_integration_method
mdo_spring_wire_radius
mdx_belt_icon_width
mechanism_significant_digits

Mechanism

motion_envlp_alert

Manufacturing

Manufacturing
Manufacturing
Manufacturing
Manufacturing

Mechanism
Miscellaneous

PTC Inc.

shade_mfg_ref_models

Values

yes, no

yes

yes, no

yes

7
off, on, auto
yes, no

auto
no

none, operations, steps,
operations_and_steps

none

Path for Custom Load executable.
Select integration method for dynamic analyses.
explicit, implicit, auto
Spring wire radius for dynamics spring icons.
Width of belt transmission icons.
The number of significant digits of mantissa for real double values in
mechanism mode. Can be set in interval from 6 to 16. Default value is 12.

Displays the Motion Envelope alert the first time the quality level is
increased.
move_mechanism_in_nonge Allow mechanism operations in non geometrical representations.
om_reps
allow_ply_cross_section
Yes - Enables Pro/COMPOSITE to create a cross-section of composite
plys.
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Default Value

auto
0.15
5
12

yes, no

yes

yes, no, exclude_to_move

yes

yes, no

yes
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Category
Miscellaneous
Miscellaneous

Miscellaneous
Miscellaneous

Name

Description
Stores a keyboard macro. Use File > Options > Environment > Mapkey
Settings to create, edit and delete mapkeys.
mapkeys_execution
Mapkeys execution behavior. No Feedback - The mapkey is executed with
no feedback, Execute with Feedback - A warning message is given upon
failure during execution, Stop at failure - The execution stops at failure and
a feedback message is provided.
relation_text_trail_output
No - Disable trail output from Text layout in Relation Parameter UI if it
hasn't been changed.
relation_tool_mapkey_behavi Will control how mapkeys will be executed in relation tool / dialog.
or
Incremental will add/remove text incrementally to the current set.
Full_output will record the original set state and replace the current one
with it. Note: this config is dependent on relation_text_trail_output.

Values

Default Value

mapkey

no_feedback,
execute_with_feedback,
stop_at_failure

no_feedback

yes, no

yes

increment, full_output

increment

Miscellaneous

show_cav_fit_loc_sys

Model Display

allow_solid_perspective_hlr

Model Display

yes, no

yes

Model Display

animate_component_placem Animate the transition between component states in placement.
ent
animate_explode_states
Animate the transition between explode states and mold opening steps.

yes, no

yes

Model Display

blended_transparency

yes, no, independent

independent

yes, no

yes

yes, no
dot, cross, circle, triangle,
square

yes
cross

yes, no

yes

wireframe, hiddenvis,
hiddeninvis, shade,
shadewithreflect,
shadewithedges
yes, no

shade

Model Display
Model Display
Model Display
Model Display
Model Display
Model Display

Model Display

PTC Inc.

Allows the printing of the transformation matrix of a Pro/Verify Fit into a
yes, no
file.
Yes - Allows a solid to be displayed with hidden lines while in perspective. yes, no

Yes - Transparent colors will appear using alpha blending (if supported)
when the model is shaded.
capped_clip
Yes - Displays the model as a solid when shaded and clipped. No Displays the model as surfaces when shaded and clipped.
clip_always
Yes - Display clipping after Visibilities dialog box is closed.
datum_point_symbol
Specifies the shape of datum point symbols displayed in Part or Assembly
mode.
default_ramp_size
Specifies a number of shades of gray to show shading of non-colored
objects.
disp_comp_name_in_symb_r Displays the names of components in symbolic representations.
ep
display
Wireframe - All solid edges in white. Hiddenvis - Hidden lines in grey.
Hiddeninvis - Hidden lines removed. Shade - Display shaded surfaces.
Settings are reflected in printing and some export modes.
display_axes

Displays or hides datum axes.
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no
yes

yes
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Category
Model Display
Model Display

Name
display_axis_tags
display_coord_sys

Model Display

display_coord_sys_tags

Model Display

display_florin

Model Display

display_plane_tags

Model Display

display_planes

Model Display

display_point_tags

Model Display

display_points

Model Display
Model Display

display_silhouette_edges
display_z_extension_lines

Model Display

edge_display_quality

Model Display
Model Display
Model Display
Model Display
Model Display

Model Display
Model Display

PTC Inc.

Description
Displays or hides datum axis name tags.
Yes - Coordinate systems will be displayed. No - Coordinate systems will
not be displayed.
Yes - Coordinate system name tags will be displayed. No - Coordinate
system name tags will not be displayed.
Yes: display of the florin (international currency symbol) where possible.
No: use the euro symbol exclusively.
Yes - Datum plane name tags will be displayed. No - Datum plane name
tags will not be displayed.
Yes - Datum planes will be displayed. No - Datum planes will not be
displayed.
Yes - Datum point tags will be displayed. No - Datum point tags will not be
displayed.
Yes - Datum points and their names will be displayed. No - Datum points
and their names will not be displayed.
Sets the display of silhouette edges for wireframe display only.
Controls the display of dimension z-extension lines. Yes - z-extension
lines will be displayed; No - z-extension lines will not be displayed.

Controls display quality of an edge for wireframe and hidden-line removal.
Normal - Normal quality of edge display. High - Increases tessellation by
2. Very_high - Increases tessellation by 3. Low - Decreases tessellation
from normal, speeds up display.
enable_ambient_occlusion
Enable ambient occlusion. This simulates the effect of light radiating from
a real model by darkening the occluded areas.
enable_hlr_hashing
Enables hlr hashing
enable_transparent_text_bg Yes - Clear background before displaying text. No - Do not clear text
background.
explode_animation_max_tim Sets the maximum amount of time for an animation between explode
e
states.
fast_highlight
Yes - Use simplified highlighting which redisplays more quickly at the
expense of certain details. This option may increase memory usage
slightly.
fasthlr
Specifies whether fast hidden line removal is on/off by default.
frames_per_sec
Determines whether view is animated.
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Values

Default Value

yes, no
yes, no

no
yes

yes, no

yes

yes, no

no

yes, no

no

yes, no

yes

yes, no

no

yes, no

yes

yes, no
yes, no

yes
yes

high, low, normal, very_high

normal

yes, no

no

yes, no
yes, no

no
yes
1

yes, no

yes

yes, no
yes, no

no
no

PTC Creo 3.0 Parametric Configuration Options

PTC Creo 3.0 Parametric Configuration Options
Category
Model Display

Name
frames_per_sec_value

Model Display

lods_enabled

Model Display

lods_value

Model Display

max_animation_time

Model Display

max_image_dimension

Model Display
Model Display

mesh_spline_surf
min_animation_steps

Model Display

model_detail_options_file

Model Display

orientation

Model Display

real_time_rendering_display

Model Display

save_triangles_flag

Model Display

shade_moving_comp

PTC Inc.

Description
Used to set the smoothness of view animation changes. Higher numbers
provide more frames/sec, and giving you a smoother animation. Lower
numbers cause the view to change more quickly.
Determines whether or not the system uses Level of Detail in shaded
models during dynamic orientation (panning, zooming and spinning).

Values

Default Value
3

yes, no

no

When lods_enabled is Yes, this value specifies the default value used to
display LODs. The value is a percentage of the edge size vs the total size
of the model.
When the orientation, or zoom state, of the Creo Parametric window
changes, an animation sequence of a predefined duration takes place.
This option controls the maximum time the system spends animating.

50

Set the upper bound dimension on images loaded into Creo Parametric.
4096, 1024, 2048, 8192, 16384
Images larger than this limit will be rescaled to this upper bound during
loading.
Turns the blue mesh surface lines on or off.
yes, no
When the orientation, or zoom state, of the Creo Parametric window
changes, an animation sequence of predefined duration takes place. This
option controls the minimum number of frames used in the animation
sequence.
Sets the path to the file which contains the default model detail option
values for new models.
Establishes the initial standard view orientation. User_default - System
isometric, trimetric, user_default
uses X-axis and Y-axis values defined by options x_axis and y_axis.

16384

1

no
6

<creo3.0_loadpoint>\text
\3d_inch.dtl
trimetric

Set the realtime rendering to project shadows/reflections on a transparent transparent_floor, room_display transparent_floor
floor.
Spinning shaded images with software graphics only. Note: This option
yes, no
no
has no effect if your system uses hardware graphics.
Yes - Shades assembly components while they are being moved. No yes, no
yes
Displays components in wireframe while they are being moved.
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Category
Model Display

Name
shade_quality

Description
Values
Model shade quality is used to decide how much to subdivide surfaces for 12, 13, 14, 1, 3, 23, 24, 25, 26, 3
shading purposes. Higher shade quality is slower but produces better
2, 4, 5, 15, 6, 7, 8, 9, 10, 11, 16,
17, 18, 19, 20, 21, 22, 27, 28,
pictures.
29, 30, 31, 32, 33, 34, 35, 36,
37, 38, 39, 40, 41, 42, 43, 44,
45, 46, 47, 48, 49, 50

Model Display
Model Display

shade_surface_feat
shade_windows

yes, no
all_windows, one_window

yes
all_windows

Model Display
Model Display
Model Display

shade_with
show_axes_for_extr_arcs
skip_small_surfaces

no, curves
yes, no
yes, no

curves
no
yes

Model Display

spherical_map_size

Controls the shading of surface features.
Enables shading of objects in all windows. This option does not also
enable color shading.
Controls the display of datum curves on shaded objects.
Determines if axes are created for newly extruded arcs.
Gives the user the option not to display small shaded surfaces. Disabling
this option will improve display quality at the expense of speed. It is most
useful for creating screen snap shots.
Size of Spherical map texture image used for environment mapping.
Bigger size will have better image quality but will be slow to regenerate.

Model Display
Model Display

spin_rate_zoom_sensitive
spin_with_notes

yes, no
yes, no

no
yes

Model Display

spin_with_part_entities

yes, no

no

Model Display

spin_with_silhouettes

yes, no

no

Model Display

tan_angle_for_disp

Model Display

tangent_edge_display

Allows slower spinning when zoomed in on a model.
Yes - 3D feature and model notes are displayed during dynamic spinning
of a model.
Yes - Datum features will be displayed during dynamic spinning of a
model.
Yes - Silhouette lines will be displayed during dynamic spinning of a
model.
For display purposes only. Sets the angle between two quilt surfaces
below which the edge will be displayed as tangent. Enter an angle
between 1.5 and 15 degrees.
Determines how edges between tangent surfaces are displayed.

Model Display
Model Display
Model Display

texture
texture_search_path
transparency

Yes - Applied textures will be displayed when the model is shaded.
Appends a directory to the search path for textures.
Yes - Transparent colors will appear as such when the model is shaded.

Model Display

update_old_appearance

Update pre-Creo 3.0 appearances to their latest values. Always - update
without warning, Never - do not update, Prompt - issue a warning dialog
allowing users to choose to update or not.

PTC Inc.
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Default Value

256x256, 512x512, 1024x1024 256x256

0.02618

no, solid, centerline, phantom,
dimmed
yes, no

solid
yes

yes, no

yes

never, always, prompt

always
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Category
Model Display

Name
use_pre_wildfire_text_font

Notification Manager nmgr_dont_show_all

Description
Yes - Use the old stroke-based PTC font as the default font. No - Use a
yes, no
True Type font as the default font.
Sets the default view orientation for models (appears in the Orientation
dialog box). The default orientation is the last option, x_angle, y_angle, or
orientation, in the configuration file.
Sets the default view orientation for models (appears in the Orientation
dialog box). The default orientation is the last option, x_angle, y_angle, or
orientation, in the configuration file.
Show notifications for models/features that are affected by Creo direct
yes, no
modifications.
Ignore current configurations and do not display any notifications.
yes, no

Model Display

x_angle

Model Display

y_angle

Notification Manager nmgr_failed

Show notifications for failed features/components.

yes, no

yes

Notification Manager nmgr_misssing_mdl

Show notifications for models that could not be reterived.

yes, no

yes

Notification Manager nmgr_modified_in_dma

Show notifications for models/features that were modified in Creo Direct.

yes, no

yes

Notification Manager nmgr_outdated_mathcad

Show notifications for models that contain MathCad Sheet with values
different from Creo values.
Show notifications for non-native models that are not up-to-date with
respect to source.
Show notifications for models that are not up-to-date with recent PDM
model version.
Models that were modified in Creo Direct and not reviewed. The changes
should be accepted or rejected in the View Creo Changes dialog

yes, no

yes

yes, no

yes

yes, no

yes

yes, no

yes

Show notifications for models/features whose references were changed
since last regeneration.
Notification Manager nmgr_reference_out_of_sess Show notifications for models/features with references not in session.
ion
Photorender
default_scene_filename
Complete path to the scene file to be used as default scene file.

yes, no

yes

yes, no

no

Photorender

yes, no

<creo3.0_loadpoint>\gra
phiclibrary\scenes\/creo_def
ault_scene.scn
yes

Notification Manager nmgr_affected_by_dma

Notification Manager nmgr_outdated_non-native
Notification Manager nmgr_outdated_pdm
Notification Manager nmgr_pending_dma

Notification Manager nmgr_reference_changed

PTC Inc.

photorender_capability_warni Allows the user to disable warnings about PhotoLux only capabilities.
ngs
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Values

Default Value
no
0

0

yes
no
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Category
Photorender

Name
photorender_default_height

Description
Sets the default height (in pixels) for the custom size rendered output

Photorender

photorender_default_width

Sets the default width (in pixels) for the custom size rendered output

Photorender

photorender_memory_usage Sets the memory limit that Pro/PHOTORENDER allows for model
processing. Do not use commas in the memory value, as Creo Parametric
interprets these as decimals. The minimum allowed value is 64 and
maximum value is 5120.
photorender_preview_scale Allows user defined size ratio at which Pro/PHOTORENDER will render,
using the default Render To: Full Window Preview setting. Increasing the
value creates higher quality rendering with slower performance. Reducing
the value produces reverse results.
pro_texture_library
Allows the user to specify a different graphics library.
room_rotation_lock
Default room rotation setting at session start. studio - Lock room rotation
to studio. model - Lock room rotation to model.
save_scene_with_file
Yes - Automatically update the model with current scene information when
saving the model; No - Scene information embedded in model must be
updated manually.
save_texture_with_model
Yes - Embed applied texture and tracesketch bitmap files into the model
file.
window_gamma
Gamma correction to apply to images created by renderer. Default value
is 1.0.
aec_dwg_anno_attrpar_spec Specifies the aec drawing annotation attribute/parameter specification file
_file
name.
aec_object_type_file
Specifies the aec object type file name.
display_thick_insulation
Yes - Display insulation in thick mode. No - Display insulation in centerline
mode. This option can be overridden by the Thick insulation option in the
Model Display dialog box.
display_thick_pipes
Yes - Display pipes in thick mode. No - Display pipes in centerline mode.
This option can be overridden by the Thick pipes option in the Model
Display dialog box.
isogen_attribute_map_file
Specifies the mapping between isogen parameter and attribute name.

Photorender

Photorender
Photorender
Photorender

Photorender
Photorender
Piping
Piping
Piping

Piping

Piping

PTC Inc.
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Values

Default Value
450
600
256

0.5

studio, model

studio

yes, no

no

yes, no

no
1

yes, no

aec_dwg_anno_attrpara
m_spec.ptd
aec_object_type.ptd
yes

yes, no

no

<creo3.0_loadpoint>\text
\piping_data\isodata\isog
en_attribute_map.ptd
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Category
Piping

Name
isogen_endtype_map_file

Description
Specify name of file mapping Pro/Piping endtypes with ISOGEN endtypes

Piping

isogen_mandatory_attr_file

Specify file containing mandatory attribute filenames used by ISOGEN.

Piping

isogen_nominal_size_map_fil Specify name of file mapping Pro/Piping Size with Nominal Sizes in MM
e
and Inches

Piping
Piping

isogen_output_files_dir
Specify directory to save the PCFs created by ISOGEN interface
isogen_pcf_filename_format Specify format to create filenames of PCF files being created

Piping

isogen_symbol_map_file

Piping

pipe_3d_bend_theor_int_pts Yes - Displays theoretical intersections and bends in three-dimensional
models.
pipe_bend_locations_csys_u Define which assembly units will be used for the piping bend locations
nits
calculations. Yes - to use coordinate system assembly units. No - to use
pipeline assembly units.
pipe_pre_22_bendinfo_conv Convert bend report information generated prior to Pro/ENGINEER 2000i2 to current saved analysis format.
pipe_solid_centerline
Yes - Display Pro/PIPING centerlines. No - Do not display Pro/PIPING
centerlines.
pipe_solid_label_format
Specify the pipe solid label format that will be used to automatically
generate pipeline labels.

Piping

Piping
Piping
Piping

Piping

Piping

Piping

PTC Inc.

Values

isogen.fls
<creo3.0_loadpoint>\text
\piping_data\isodata\isog
en_nominal_size_map.p
td
mnemonic,,specification,-,number
<creo3.0_loadpoint>\text
\piping_data\isodata\isog
en_symbol_map.ptd

Specify name of file for mapping Pro/Piping selection names with ISOGEN
symbol keys (SKEY)s

yes, no

no

yes, no

no

yes, no

yes

yes, no

yes

pipe_update_pre_20_int_pts Yes - Pipelines created prior to Release 20.0 are updated with intersection yes, no
point entities. The entities are created in session by Info>Regen Info or
when you retrieve the model.
pipeline_assembly_library_dir Sets the default pipeline assembly library directory.

pipeline_assembly_name_for Sets the default pipeline assembly name format.
mat
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Default Value
<creo3.0_loadpoint>\text
\piping_data\isodata\isog
en_endtype_map.ptd

size,-,specification,,mnemonic,-,number,,insulation
no

<creo3.0_loadpoint>\text
\piping_data\pipelinelib\
mnemonic,-,number
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Category
Piping

Name
pipeline_label_format

Description
Specify the pipeline label format that will be used to automatically generate
pipeline labels.

Piping

pipeline_solid_start_part_na
me
pipeline_spool_label_format

Sets the default pipeline solid start part name.

Piping

Piping

Values

Specify the pipeline spool label format that will be used to generate the
spool labels during pipeline spool generation.

Default Value
size,-,specification,,mnemonic,-,number,,insulation
pipeline_solid_start.prt
mnemonic-numberprefix&#91;0]spoolnum&
#91;01]suffix&#91;]
pipeline_start.asm

Piping

pipeline_start_assembly_nam Sets the default pipeline start assembly name.
e
piping_appearance_map_file Sets the default piping appearance map filename.

Piping

piping_bolt_nut_select_file

Piping bolts and nuts selection file.

Piping

piping_design_method

Sets the current Piping design method for pipeline modeling.

Piping
Piping

piping_enable_designate_rep Enable designatable reports for spec-driven piping.
ort
piping_end_compatibility_file Sets the default piping end compatibility filename.

Piping

piping_extend_dim_scheme

Specify a dimension scheme for piping extend segment.

cartesian, cylindrical, spherical

<creo3.0_loadpoint>\text
\piping_data\master_cat
alog\piping_end_compat
ibility.ptd
cartesian

Piping

piping_extend_show_csys

Control whether small preview CSYS is shown at end of pipe when
defining extend features in cartesian / spherical / cylindrical schemes.

yes, no

no

Piping
Piping

piping_fitt_angle_tolerance
Sets the default piping fitting angle tolerance value.
piping_fitt_category_map_file Sets the default piping fitting category map filename.

PTC Inc.
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<creo3.0_loadpoint>\text
\piping_data\master_cat
alog\piping_appearance.
map
<creo3.0_loadpoint>\text
\piping_data\master_cat
alog\piping_bolt_nut_sel
ect.ptd
non_spec_driven, spec_driven, non_spec_driven
user_driven
yes, no
yes

1.5
<creo3.0_loadpoint>\text
\piping_data\sample_pro
ject\piping_fitt_category_
map.ptd
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Category
Piping

Name
piping_fitt_library_dir

Description
Sets the default piping fitting library directory.

Piping
Piping

piping_fluid_parameter
piping_insulation_dir_file

Enables/disables the Parameters tab in Create Pipeline Dialog
Sets the default piping insulation directory filename.

Piping

piping_joint_fitting_clearance Sets the piping joint minimum fitting clearance value.

Piping
Piping

piping_joint_fitting_offset
piping_manufacture_dir_file

Sets the piping joint minimum fitting offset value.
Sets the default piping manufacture directory filename.

Piping

piping_material_file

Sets the default piping material filename.

Piping

piping_material_source

Piping

piping_mcat_dir

Sets the source for material information. Note Material_dir requires
pro_material_dir to be set.
Sets the default piping master catalog directory.

Piping

piping_mcat_dir_file

Sets the default piping master catalog directory filename.

Piping

piping_min_bolting_clearance Sets the default piping minimum bolting clearance value.

1

Piping

piping_project_data_dir

Sets the default Project data directory.

Piping
Piping

piping_schematic_driven
piping_schematic_xml_dir

Set the Schematic Driven Pipeline Modeling ON/OFF
Specify directory with full path containing schematic information XML
file(s).

<creo3.0_loadpoint>\text
\piping_data\sample_pro
ject\
no
<dir_name>\dump_x86e
_win64\

PTC Inc.
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Values

yes, no

Default Value
<creo3.0_loadpoint>\text
\piping_data\fittinglib\
no
<creo3.0_loadpoint>\text
\piping_data\sample_pro
ject\piping_insulation_dir
.ptd
1
1
<creo3.0_loadpoint>\text
\piping_data\master_cat
alog\piping_manufacture
_dir.ptd
<creo3.0_loadpoint>\text
\piping_data\master_cat
alog\piping_material.ptd

weight_length, material_dir

weight_length
<creo3.0_loadpoint>\text
\piping_data\master_cat
alog\
<creo3.0_loadpoint>\text
\piping_data\master_cat
alog\piping_mcat_dir.ptd

yes, no
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Category
Piping

Name
piping_spec_dir_file

Description
Sets the default piping specification directory filename.

Piping
Piping

Sets the default piping model tree format.
Sets the default piping thumb wheel increment value.

mnemonic
1

Sets the default piping thumb wheel ratio increment value.

0.01

Piping

piping_system_tree_format
piping_thumb_wheel_increm
ent
piping_thumb_wheel_ratio_in
c
piping_wildfire_convert

manual

Piping

pro_insulation_dir

Piping
Piping

pro_pip_fitt_dir
pro_pip_lnstk_dir

Piping

units_system_dic_file

Always ask before converting old piping assemblies to update the network never, automatic, manual
structure.
Specifies the directory to search for insulation files used in Pro/PIPING.
Use full path name to avoid problems.
Specifies the directory to search for fittings used in Pro/PIPING.
Specifies the directory to search for linestock files used in Pro/PIPING.
Use full path name to avoid problems.
Specifies the file containing the mapping for MCAT filename and units.

Printing & Plotting

acrobat_reader

Printing & Plotting

delete_after_plotting

Printing & Plotting

din_std_line_priority

Printing & Plotting

gerber_360_interpolation

Printing & Plotting

pen_slew

Printing & Plotting

pen_slew_xy

Printing & Plotting

pen_table_file

Printing & Plotting

pen1_line_weight

Piping

PTC Inc.

Sets the Adobe Acrobat Reader command path. This value will be used to
launch the reader after exporting a PDF document.
Yes - A plot file is automatically deleted from the directory in which it
yes, no
resides when it has been successfully plotted.
If set to YES line priority in plotting or export is determined according to
yes, no
DIN standard
Yes - Arcs and circles included in outputted Gerber plot files will take this yes, no
format.
Sets the pen speed for both x and y directions for plotters that are
compatible with this option. Consult your plotter's user guide for more
information.
Sets the pen speed for the x and y directions individually for plotters that
are compatible with this option. The first value is the x value and the
second, the y value. They should be separated by a space.
Specifies a default pen mapping table which supersedes other pen
mapping information.
Sets the weight of entities plotted with pens using an electrostatic plotter.
The weight is a range from 1 (thinnest) to 16 (thickest).
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Values

Default Value
<creo3.0_loadpoint>\text
\piping_data\sample_pro
ject\piping_spec_dir.ptd

<creo3.0_loadpoint>\text
\piping_data\master_cat
alog\piping_units_syste
m_dic_file.ptd

no
no
-1.000000 0.000000

-1.000000 0.000000

table.pnt
4
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Category
Printing & Plotting

Name
pen2_line_weight

Printing & Plotting

pen3_line_weight

Printing & Plotting

pen4_line_weight

Printing & Plotting

pen5_line_weight

Printing & Plotting

pen6_line_weight

Printing & Plotting

pen7_line_weight

Printing & Plotting

pen8_line_weight

Printing & Plotting

plot_carberry_extends

Printing & Plotting

plot_file_dir

Printing & Plotting
Printing & Plotting

plot_linestyle_scale
plot_names

Printing & Plotting

plot_proceed_dialog

Printing & Plotting

plot_to_scale_full_window

Printing & Plotting
Printing & Plotting

plotter
plotter_command

Printing & Plotting

plotter_handshake

Printing & Plotting

postscript_compression

PTC Inc.

Description
Sets the weight of entities plotted with pens using an electrostatic plotter.
The weight is a range from 1 (thinnest) to 16 (thickest).
Sets the weight of entities plotted with pens using an electrostatic plotter.
The weight is a range from 1 (thinnest) to 16 (thickest).
Sets the weight of entities plotted with pens using an electrostatic plotter.
The weight is a range from 1 (thinnest) to 16 (thickest).
Sets the weight of entities plotted with pens using an electrostatic plotter.
The weight is a range from 1 (thinnest) to 16 (thickest).
Sets the weight of entities plotted with pens using an electrostatic plotter.
The weight is a range from 1 (thinnest) to 16 (thickest).
Sets the weight of entities plotted with pens using an electrostatic plotter.
The weight is a range from 1 (thinnest) to 16 (thickest).
Sets the weight of entities plotted with pens using an electrostatic plotter.
The weight is a range from 1 (thinnest) to 16 (thickest).
When plotting to a raster format (jpg, tiff, etc), set to YES to ignore the
view border and produce output sized to the smallest rectangle that
includes the drawing items.
Specifies the directory where plot files should be written. Use the full
pathname to avoid problems. For example /home/users/plotfiles.
Specifies the scaling factor for the DOTFONT line style in a plot.
Yes - Plot files are given descriptive extensions when created. No - All plot
files are simply given the extension .plt.
Yes - Enables the Plot Proceed dialog which provides a choice for
delaying the printing of plot files. This is useful for large plots when using
lp print commands. The lp command may not access the plot file before it
is removed resulting in no output.
Provides the ability to exclude empty window space when plotting the
model to scale.
Establishes the default plotter for making plot files.
Sets the command that you use to start a plot on your system; for
Windows NT or Windows 95, windows_print_manager option configures
Creo Parametric to plot to a recognized device in the Windows NT or
Windows 95 print manager.
Specifies the type of plotter handshake initialization sequence generated
in the plotter files.
Specifies whether or not to compress exported shaded PostScript files.
Yes - A shaded postscript file created with File>Export will be
compressed. This will increase processing time.
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Values

Default Value
1
2
3
2
3
1
4

yes, no

no

1
yes, no
yes, no

no

yes, no

windows_print_manager

hardware, software
yes, no

no
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Category
Printing & Plotting

Name
pro_plot_config_dir

Printing & Plotting

ps_output_with_pagesize

Printing & Plotting

raster_plot_dpi

Printing & Plotting

rotate_postscript_print

Printing & Plotting
Printing & Plotting

Printing & Plotting
Printing & Plotting
Printing & Plotting

Printing & Plotting
Printing & Plotting
Reference Control
Reference Control

Reference Control
Reference Control

PTC Inc.

Description
Sets the directory of your user-defined plotter configuration file. Use the
full pathname to avoid problems.
Specifies whether or not to include pagesize information when generating yes, no
postscript files from Creo Parametric. No - Creo Parametric will omit
Adobe level 2 pagesize information from the header of the postscript file.

Values

yes

Determines the resolution for plotter outputs variables are in dots per inch. 100, 200, 300, 400

Specifies rotation for printing. Yes - Rotates a PostScript plot 90 degrees
counterclockwise. Use when you are plotting a landscape drawing on a
portrait-type laser printer, or a portrait drawing on a landscape-type laser
printer.
shaded_postscript_backgrou Specifies how background colors are handled in Postscript files of shaded
nd
objects.
ttf_handling_for_plot_files
Defines how annotations using True Type Fonts are written to the plot file.
Using True Type Fonts reduces the plot file size, but font substitution may
occur due to device settings. Annotations that do not use True Type Fonts
are unaffected by this option.
u3d_create_color_surfaces
YES- Exports color of each surface of model. NO- Exports one color per
model. Default NO.
use_8_plotter_pens
Specifies whether to support up to 8 plotter pens. The initial default is 4
pens.
use_software_linefonts
Yes - The exact line style used in Creo Parametric is plotted, stroked out
dot by dot, dash by dash, and space by space. No - plots lines using the
line font it supports which most closely resembles the font used in Creo
Parametric.
variable_plots_in_inches
No - Variable plot sizes may be entered in millimeters.
versatec_cutter_installed
Yes - Indicates that a cutter is installed on a Versatec plotter.
allow_direct_ref_to_layout_fil Allow direct references to layout files through layout feature.
e
allow_ref_scope_change
No - Displays the message "Reference scope changes are prohibited by
the configuration file settings" when the Ref Scope user interface is
changed.
def_comp_ref_ctrl_exception Default setting for newly created components that allows/disallows
referencing entities forbidden by Reference Control settings.
def_multiple_backup_prompt Number of selected components that will invoke confirmation before multi_num
component backing up placement references.
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Default Value

100

yes, no

yes, no

no

stroke all fonts, use true type
fonts

use true type fonts

yes, no

no

yes, no

no

yes, no

no

yes, no
yes, no
yes, no

yes

yes, no

yes

yes, no

yes

no

100
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Category
Reference Control

Reference Control

Reference Control
Reference Control
Reference Control
Reference Control
Reference Control
Reference Control
Reference Control

Reference Control
Reference Control
Reference Control

Reference Control

Reference Control

PTC Inc.

Name
Description
Values
def_obj_feat_refs_to_backup Default setting that controls the level of feature backup for newly created none, other_models,
models. Other_models: all references to other models will be backed up, non_permitted
Non_permitted: only references that were created despite the initial
restrictions will be backed up.
def_obj_place_refs_to_backu Default setting that controls the level of placement backup for newly
all, none, other_models,
p
created models. Other_models: all references to other models will be
non_permitted
backed up, Non_permitted: only references that were created despite the
initial restrictions will be backed up.
def_obj_ref_ctrl_exception
Default setting for newly created models that allows/disallows referencing yes, no
entities forbidden by Reference Control settings.
default_comp_geom_scope Set thespecified Shared Geometry reference control conditions to newly
all, none, pg
added components.
default_comp_module_geom Set the specified Shared Geometry reference control conditions to newly all, none, pg, tagged
_scope
added components for configurable structure.
default_comp_scope_setting Set the specified Accessible reference control conditions to newly added all, none, subassemblies,
components.
skeleton_model
default_comp_skel_geom_sc Set the specified Shared Geometry reference control conditions to newly all, none, pg
ope
added Skeleton components.
default_comp_skel_scope_se Set the specified Accessible reference control conditions to newly added all, none, subassemblies,
tting
Skeleton components.
skeleton_model
default_ext_ref_scope
Set default scope for externally referenced models. All - Any model. None - all, none, subassemblies,
Only current model and children. Skeletons - Any component in model's
skeleton_model
assembly and higher skeletons on branch. Subassembly - Only
components and children in model's assembly.
default_geom_scope
Default value for Geometry Scope allowed for referencing.
all, pg_if_exists, pg_only
default_obj_constraints_scop Set the specified Shared Placement reference control conditions to newly all, none, interfaces
e
created models if template models were not used.
default_obj_module_constr_s Set the specified Shared Placement reference control conditions to newly all, none, interfaces, tagged
cope
created models for configurable structure if template models were not
used.
default_obj_module_geom_s Set the specified Shared Geometry reference control conditions to newly all, none, pg, tagged
cope
created models for configurable structure modules if template models
were not used.
default_object_geom_scope Set the specified Shared Geometry reference control conditions to newly all, none, pg
created models if template models were not used.
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Default Value
non_permitted

non_permitted

yes
all
tagged
all
all
all
all

all
all
tagged

all

all
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Category
Reference Control

Reference Control
Reference Control
Reference Control

Reference Control
Reference Control
Reference Control
Reference Control
Reference Control
Reference Control
Reference Control
Reference Control
Reference Control
Reference Control
Sheetmetal
Sheetmetal
Sheetmetal
Sheetmetal

PTC Inc.

Name
Description
default_object_scope_setting Set default condition for reference control. All - Any model. None - Only
current model and children. Skeletons - Any component in model's
assembly ang higher skeletons on branch. Subassembly - Only
components and children in model's assembly.
default_placement_scope
Default value for Component Placement Reference filter.
feat_references_to_backup Level of backup for feature references
ignore_all_ref_scope_setting Controls whether object-specific reference scope settings are ignored or
s
not. Environment scope settings will still be enforced. See also
allow_ref_scope_change and default_ext_ref_scope
ignore_export_geom_declara Ignore Export Geometry settings.
tion
model_allow_ref_scope_chan Yes - Users can change the scope setting of components.
ge
placement_references_to_ba Level of backup for placement references
ckup
ref_control_allow_exceptions Check to allow referencing components that are not permitted by the
above setting
ref_scope_copy_color
Set the color of backed up references according to RGB values. Enter
RGB values between 0 and 100 separated by space.
ref_scope_copy_color_chang Enable changing colors of backuped references during selection.
e
ref_scope_no_pick_to_copy Disable selecting references backuped by references control.
ref_scope_no_pick_to_prohib Disable selecting references prohibited by references control.
it
ref_scope_prohibit_color
Set the color of prohibited references according to RGB values. Enter
RGB values between 0 and 100 separated by space.
ref_scope_prohibit_color_cha Enable changing colors of prohibited references during selection.
nge
close_corner_relief
Closes the gap between the bend surfaces of a corner that is a result of
intersecting walls in the form state.
die_models_directory
Sets path to directory that contains the die models.
enable_flat_state
Enables the creation of a flat state instance of the model. The instance
can be fully flat or fully formed.
flange_shape_sketches_dire Sets path to directory that contains the Flange shapes.
ctory
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Values
all, none, subassemblies,
skeleton_model

Default Value
all

all, intrf_if_exists, intrf_only
none, other_models,
non_permitted
yes, no

all
non_permitted

yes, no

no

yes, no

yes

all, none, other_models,
non_permitted
yes, no

non_permitted

no

yes

yes, no

55.000000 55.000000
55.000000
yes

yes, no

no

yes, no

yes

yes, no

45.000000 45.000000
45.000000
yes

yes, no

no

yes, no

no
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Category
Sheetmetal
Sheetmetal

Name
Description
flat_shape_sketches_director Sets path to directory that contains the Flat shapes.
y
initial_bend_y_factor
Specifies a constant used to determine the neutral bend line for a sheet
metal part. This value is always used for non-cylindrical bends. It is used
for regular bends only when no bend table is specified.

Values

Default Value

0.5

Sheetmetal

material_upd_smt_bend_tabl Defines whether assignment of material to the model via Creo Toolkit will
e
overwrite existing bend table data and y factor value. Always Replace Overwrites existing data. Never Replace - Keeps existing data

always_replace, never_replace always_replace

Sheetmetal

merge_smt_srfs_without_sea Yes - no edge left at the merge if the sheetmetal surfaces being merged
m
are same surfaces. No - edge is left even between same sheetmetal
surfaces.
pro_sheet_met_dir
Sets the default directory of your user-defined bend tables. If not set, the
Pro/SHEETMETAL supplied bend tables are used. Use the full path name
to avoid problems.
pro_smt_params_dir
Specifies the directory to save/retrieve Sheet metal parameters files. Use
full path name to avoid problems.
punch_axis_points
Yes - Enables the creation of punch axis points in Sheetmetal cuts and
punches.
punch_models_directory
Sets path to directory that contains the punch models.
smt_add_bends_on_sharp_e Determines if bends will be added automatically on edges with sharp
dges
geometry in the wall creation tools. Yes - bends will be added
automatically. No - sharp geometry of edges will be kept.
smt_allow_flip_sketch
Yes - Allows flipping the sketch in Flat and Flange tools. No - Disables the
ability to flip the sketch in Flat and Flange tools.
smt_bend_notes_dflt_display Define the default state of bend note display (sheetmetal mode)

yes, no

yes

yes, no

no

yes, no

yes

yes, no

no

yes, no

yes

Sheetmetal

Sheetmetal
Sheetmetal
Sheetmetal
Sheetmetal

Sheetmetal
Sheetmetal
Sheetmetal
Sheetmetal
Sheetmetal
Sheetmetal
Sheetmetal

PTC Inc.

smt_bend_notes_direction_d
own
smt_bend_notes_direction_u
p
smt_bend_notes_order
smt_bend_notes_type_forme
d
smt_bend_notes_type_rolled

Define the down direction symbol for bend notes (sheetmetal mode)

default

Define the up direction symbol for bend notes (sheetmetal mode)

default

Define the fields order for bend notes (sheetmetal mode)
Define the formed symbol for bend notes (sheetmetal mode)

&type&direction&angle
default

Define the rolled symbol for bend notes (sheetmetal mode)

default
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Category
Sheetmetal
Sheetmetal

Sheetmetal

Name
smt_crn_rel_display

Description
Yes - Corner relief notes will be displayed. No - Corner relief notes will not yes, no
be displayed.
smt_drive_bend_by_paramet Sheetmetal bend radius and bend angle values and bend dimension
yes, no
location will be driven by feature level relations to Sheetmetal parameters.
ers

Values

Default Value
yes
no

smt_drive_tools_by_paramet Drives the Sheetmetal options and values by feature-level relations to
yes, no
ers
Sheetmetal parameters.
smt_form_abort_on_fail_plc Yes - will always fail the Sheetmetal Form feature if there is a problem with yes, no
its placement .
smt_mp_method
MASS - Suppressed Flat Pattern and Flatten Forms will be temporary
both, mass, cg
resumed before mass properties calculation of sheetmetal part. CG Mass Properties calculation will be performed on current state of
sheetmetal part. BOTH - Both methods will be used one after the other.

yes

Sheetmetal

smt_outside_mold_lines

no

Sketcher

2d_palette_path

Sheetmetal
Sheetmetal

Sketcher
Sketcher
Sketcher
Sketcher

Sketcher
Sketcher
Sketcher
Sketcher

PTC Inc.

Yes - Outside Mold Lines will be created during Flat Pattern creation.

yes, no

Sets the default directory for the user sketcher shape library. Use the full
path name to avoid problems.
dma_sketcher_guide_width_f Guide width as a proportion of sketched line width
actor
grid_snap
Yes - Makes pick points snap to a grid. No - Turns the grid snap off so that yes, no
any location can be picked.
section_color
Specifies the color of sketched sections.
default, drawing_color,
sketch_color
sket_import_geometry_line_s Determine if the original line style and color should be preserved on
yes, no
tyle
Copy/Paste, Sketcher Palette and Import from file. Yes - Preserve original
line style and color.
sketcher_alignment_constr
Yes - Alignment constraints will be used by Intent Manager; No yes, no
Alignment constraints will not be used.
sketcher_animated_modify
No - The section is not animated as modifications are regenerated.
yes, no
sketcher_auto_create_refere This option controls the automatic reference creation from selected
yes, no
nces
background geometry.
sketcher_auto_create_refs
The option values are: 2: the system automatically creates 2 dimensioning 1, 2
references; 1: the system automatically adds the orientation reference as
a dimensioning reference; 0: the system does not automatically create
dimensioning references.
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Category
Sketcher

Sketcher
Sketcher

Sketcher

Name
Description
sketcher_blended_backgroun This option controls whether the blended background should be used in
yes, no
d
3D Sketcher. The option has no effect if blended background is turned off
generally.
sketcher_collinear_constr
Yes - collinear constraints will be used by Intent Manager; No - collinear
yes, no
constraints will not be used by Intent Manager.
sketcher_default_font_kernin Automatically set kerning for text entities in Sketcher. Yes - Kerning will be yes, no
g
set for new text entities. No - Kerning will not be set automatically.

Sketcher

Yes - Diagonal constraints will be used; No - Diagonal constraints will not
be used.
sketcher_dim_of_revolve_axi If this option is set all dimensions created by Intent Manager to Axis of
s
Revolution will be diameter dimensions.
sketcher_dimension_autolock Automatically lock strong sketcher dimensions.

Sketcher

sketcher_disp_constraints

Sketcher
Sketcher
Sketcher
Sketcher

sketcher_disp_dimensions
sketcher_disp_grid
sketcher_disp_guides
sketcher_disp_vertices

Sketcher

sketcher_disp_weak_dimensi
ons
sketcher_equal_length_const
r
sketcher_equal_radii_constr

Sketcher

Sketcher
Sketcher
Sketcher
Sketcher
Sketcher
Sketcher
Sketcher
Sketcher

PTC Inc.

sketcher_diagonal_constr

sketcher_grid_angle
sketcher_grid_line_quantity
sketcher_grid_radius_spacin
g
sketcher_grid_type
sketcher_highlight_open_end
s
sketcher_import_exact_geom

Shows the constraints when sketching in Sketcher Mode; for example, H
for horizontal, V for vertical, and so on.
No - Suppresses the display of all dimensions while in sketcher.
Specify whether or not to display the sketcher grid.
Shows guides when sketching.
No - Suppresses the display of yellow points on all vertices while in
sketcher.
Yes - weak dimensions will be displayed; No - weak dimensions will not be
displayed.
Yes - equal length constraints will be used by Intent Manager; No - equal
length constraints will not be used by Intent Manager.
Yes - equal radii constraints will be used by Intent Manager; No - equal
radii constraints will not be used by Intent Manager.
Enter a grid angle value to override the default grid angle value.
Enter number of radial lines for radial grid.
Enter a radial grid spacing value to override the default radial grid spacing
value.
Set grid type to be Cartesian or Polar.
Yes - Highlights open ends of sketched entities in Sketcher. No - Does not
highlight open ends of sketched entities in Sketcher.
During import in sketcher use exact geometry.
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Values

Default Value
no

yes
no

yes, no

no

yes, no

yes

yes, no

no

yes, no

yes

yes, no
yes, no
yes, no
yes, no

yes
no
yes
yes

yes, no

yes

yes, no

yes

yes, no

yes
0
12
1

cartesian, polar
yes, no

cartesian
yes

yes, no

yes
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Category
Sketcher
Sketcher

Name
Description
sketcher_known_dim_on_ref YES - create known dimensions on known geometry, NO - create
_ent
reference dimensions on known geometry
sketcher_lineup_hor_constr Yes - line up horizontal constraints will be used by Intent Manager; No line up horizontal constraints will not be used by Intent Manager.

Sketcher

sketcher_lineup_ver_constr

Sketcher

sketcher_lock_modified_dims

Sketcher

sketcher_midpoint_constr

Sketcher

sketcher_parallel_constr

Sketcher

sketcher_perpendicular_cons
tr
sketcher_point_on_entity_co
nstr
sketcher_refit_after_dim_mo
dify
sketcher_same_point_constr

Sketcher
Sketcher
Sketcher

Yes - line up vertical constraints will be used by Intent Manager; No - line
up vertical constraints will not be used by Intent Manager.
Yes - modified dimensions will be locked; No - modified dimensions will
not be locked.
Yes - midpoint constraints will be used by Intent Manager; No - midpoint
constraints will not be used by Intent Manager.
Yes - parallel constraints will be used by Intent Manager; No - parallel
constraints will not be used by Intent Manager.
Yes - perpendicular constraints will be used by Intent Manager; No perpendicular constraints will not be used by Intent Manager.
Yes - point on entity constraints will be used by Intent Manager; No - point
on entity constraints will not be used by Intent Manager.
Refits section after dimension modification in 2D section or when creating
the first feature.
Yes - same points constraints will be used by Intent Manager; No - same
points constraints will not be used by Intent Manager.
This option controls whether section files should be saved with embedded
image information which can be used to preview sections in File/Open
dialog.
"Dynamic" - grid spacing is determined by the system based on zoom
factor, "Static" - grid spacing is fixed and set by the user.
Enter the number of grid lines per major line in x axis.
Enter an x-grid spacing value to override the default x-grid spacing value.

Values

Default Value

yes, no

yes

yes, no

yes

yes, no

yes

yes, no

no

yes, no

yes

yes, no

yes

yes, no

yes

yes, no

yes

yes, no

yes

yes, no

yes

yes, no

no

dynamic, static

dynamic

Sketcher

sketcher_save_preview_imag
e

Sketcher

sketcher_set_grid_method

Sketcher
Sketcher

sketcher_set_grid_x_major
sketcher_set_grid_x_spacing

Sketcher
Sketcher

sketcher_set_grid_y_major
Enter the number of grid lines per major line in y axis.
sketcher_set_grid_y_spacing Enter a y-grid spacing value to override the default y-grid spacing value.

5
1

Sketcher

sketcher_shade_closed_loop yes-closed loops in sketcher will be displayed as shaded, no-closed loops yes, no
s
in sketcher will not be displayed as shaded
sketcher_snap_sensitivity
Adjusts the sensitivity of the snapping to geometry.
high, medium, low, very_high,
very_low

yes

Sketcher

PTC Inc.
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Category
Sketcher

Sketcher
Sketcher
Sketcher
Sketcher

Style Feature
Style Feature

Name
sketcher_starts_in_2d

Description
Defines initial model orientation in Sketcher mode. Yes - (2D orientation)
Looking directly at section (sketching) plane. No - (Orientation unchanged)
Sketch directly on the 3D part.
sketcher_symmetric_constr Yes - symmetric constraints will be used by Intent Manager; No symmetric constraints will not be used by Intent Manager.
sketcher_tangent_constr
Yes - tangent constraints will be used by Intent Manager; No - tangent
constraints will not be used by Intent Manager.
sketcher_undo_reorient_view Controls the ability to Undo view reorientation while in Sketcher. Yes - it is
possible to Undo view reorientation in Sketcher.
sketcher_undo_stack_limit
Sketcher saves a copy of each function performed. The number of
possible saved functions depend on the number specified in the option.
The undo menu can be used to remove the stored functions.
advanced_style_surface_edit Use advanced options by default for Surface Edit in Style.

Style Feature
Style Feature
Style Feature

keep_style_items_hidden_on
_exit
style_auto_regen_curves
style_auto_regen_shaded_su
rface
style_auto_regen_surface
style_connection_arrow_scal
e
style_default_connections
style_display_grid
style_grid_spacing

Style Feature
Style Feature

style_merge_surfaces
style_surface_mesh_display

Style Feature

style_surface_mesh_quality

System
System

allow_float_opt_checkout
auto_traceback

System

browser_limit_to_ie9_mode

Style Feature
Style Feature
Style Feature
Style Feature

PTC Inc.

Values

Default Value

yes, no

no

yes, no

yes

yes, no

yes

yes, no

no
200

yes, no

no

Keep style entities hidden after exiting of the Style feature definition.

yes, no

no

Yes - Enable autoregeneration of curves.
Yes - Enable autoregeneration of shaded surfaces.

yes, no
yes, no

yes
yes

Yes - Enable autoregeneration of surfaces.
Set scale factor of surface connection arrow. Number should be greater
then 0.
Yes - Add connections to a newly created Style surface.
Yes - Display grid for active datum plane.
Set the number of lines to display on the grid. Number should be equal or
greater than 2.
Merge surfaces on exit from the Style Feature
On - Display surfaces mesh. Off - Do not display surfaces mesh. Off
When Shaded - Display surfaces mesh except when shaded.
Sets the quality of the surface mesh. Values range is between 0.1 to 10.

yes, no

yes
1

yes, no
yes, no

yes
yes
5

yes, no
off, on, off when shaded

yes
off when shaded

Yes - Allows checkout failure for floating modules.
"always": a traceback file will be generated when a fatal error occurs.
"yes", "ask": ask the user whether to generate a traceback. "no", "never":
no traceback will be generated.
Limit Internet Explorer to IE9 standard mode even if higher version is
installed.

yes, no
yes, no, never, ask, always

no
always

yes, no

no
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Category
System

Name
cmdmgr_trail_output

System
System

cpus_to_use
csv_format_delimeter

System

display_ie8_warning_dialog

System

enable_tree_indep

System

export_report_format

System

general_undo_stack_limit

System

overlays_enabled

System

pick_aperture_radius

System

protable_in_background

System

saveunders_enabled

System
System
System
System

set_trail_single_step
tablet_device_name
trail_delay
trail_dir

System

train_file_path

System

web_browser_history_days

PTC Inc.

Description
Trail file and mapkey output will include system instructions that are
independent of user interface configuration when available (typically menu
bar and toolbar options).
Set up the number of threads including main thread
Define the delimeter character in BOM format file: Comma, TAB,
Semicolon, Space or other user-defined
Show/Hide the warning dialog related to Internet Explorer 8 running in
Compatibility Mode
Setup whether tree customization will allow separating the tree window
from Creo Parametric window.
Controls the format of the exported reports displayed in the embedded
browser. Rich Text - Exports the report in Rich Text format, Comma
Delimited - Exports the report in Comma Delimited format.

Values
yes, no

Default Value
yes

2
comma, tab, semicolon, space
yes, no

yes

yes, no

no

comma_delimited, rich_text

comma_delimited

Setup the default number of entries in the top level Undo/Redo (default =
50).
Yes - Enables Creo Parametric screens and menus to be placed on
yes, no
different overlay layers of the hardware graphics card. This frees memory
for Creo Parametric use.
Specifies the size of the area about the mouse when making selections.
Units are 1/1000 of screen size.
Yes - Starts Pro/TABLE editor in the background. Reduces time between yes, no
pressing a menu button that uses Pro/TABLE and entering the data.

50

Yes - Enables Creo Parametric popup helptext and menus to retain the
portion of the window they obscure to be used to restore the window
image when they are dismissed.
Yes - Enables a trail file to be single-stepped by entering <CR>.
Specifies the name of a digitizing tablet.
Sets a delay in seconds between trail file steps.
Instructs Creo Parametric to create its trail file in the specified directory
rather than in the startup directory.
Specifies the default directory for training files. The path name must start
from the root of the directory, for example, /home/users/library/training.

yes, no

yes

yes, no

no

Enter number of days to store history records.
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Category
System

Name
web_browser_homepage

System

web_browser_in_separate_wi Specifies whether Creo Parametrics web browser should be launched as
ndow
a separate window. When set to Yes the browser will be displayed as a
separate window. The default, No, will result in the browser being
embedded in the Creo Parametric application window

yes, no

Default Value
<creo3.0_loadpoint>\hel
p\usascii\resource_cent
er_index.html
no

System
Update Control

windows_browser_type
child_of_layout_backup_upda
te
copied_feat_refs_update_stat
e
copied_place_refs_update_st
ate
direct_child_of_layout_update

ie_browser
manual, auto, notify

ie_browser
auto

manual, auto, notify,
no_dependency
manual, auto, notify,
no_dependency
manual, auto, notify

auto

yes, no
manual, auto, notify

yes
auto

manual, auto, notify

notify

yes, no, ignore_missing

no

dependent, independent

dependent

yes, no

no

yes, no

yes

yes, no

yes

Update Control
Update Control
Update Control
Update Control
Update Control
Update Control
Update Control
User Interface

User Interface
User Interface

Select the type of embedded browser to use.
Set the default update state for a child referencing the layout feature's
geometry.
Copied Feature References Update
Copied Placement References Update

Set the default update state for a child directly referencing the layout
model through layout feature.
individual_child_update
Allow individual update control for children of layout feature.
new_cg_update_state
Set the default update state for newly created Copy Geometry features
relative to the reference model.
new_layout_feature_update_ Define the default update state of a new DSF created.
state
retrieve_data_sharing_ref_pa Automatic reference parts retrieval for dependent data sharing features.
rts
ae_propagate_detail_depend Sets the AE detail dependency for AE's that are locally propagated. If set
ency
to independent, the AE's parameter call outs will update to other
propagated AEs parameters.
af_copy_references_flag
Toggle display of Copy References column in Annotation Feature
definition dialog
allow_confirm_window
Display a confirmation window when exiting Creo Parametric. This
enables you to use the mouse to confirm/cancel exiting Creo Parametric.

User Interface

auto_ae_param_file

User Interface

auto_include_annot_plane

PTC Inc.

Description
Enter location of Creo Parametric browser home page.

Define path and file name of external file used to define parameters that
are automatically created in all Annotation Elements.
Control the default setting of the check box in the Propagate annotation
dialog box which controls whether to pass all annotations plane
references.
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Category
User Interface

Name
auto_propagate_ae

User Interface
User Interface

auxapp_popup_menu_info
bm_graph_tool

User Interface
User Interface

bmgr_pref_file
button_name_in_help

User Interface

default_font

User Interface

dialog_translation

User Interface

enable_popup_help

User Interface

fonts_size

User Interface

help_translation

User Interface

iconify_entire_pro

User Interface

kbd_cmd_abbreviation

User Interface

kbd_selection

User Interface

load_ui_customization_run_di Enables the loading of the UI customization file (.ui) if located in the run
r
directory
mdl_tree_cfg_file
Specifies the Model Tree configuration file to be loaded when Creo
Parametric is started.

User Interface

PTC Inc.

Description
Yes - causes the automatic, local propagation of AE's after a supported
feature has been created.
Enable display of popup menu info in the trail file.
BMX graph tool
Specifies the location of the Graph Tool preference file.
Yes - The name and menu of any selected menu option displays, in
English, in the help text associated with that button.
Sets font for text other than menu bar, menus and their children, and popup menus and help. Add comma-delimited variables in any order (italic
bold, 24, times or 24, times, italic bold have the same effect). Any omitted
variable uses standard setting.
Specifies the language in which the dialog display when running nonEnglish version of Creo Parametric.
Controls pop-up help in dialog boxes. Yes - Help enabled. No - Help
disabled.
Determines the relative size of the text in menus and dialog boxes. You
must restart Creo Parametric for the change to take effect.
Specifies the language in which the short help messages display when
running non-English versions of Creo Parametric. Yes - Display in native
language. No - Display in English.
Determines how many other Creo Parametric windows/menus are
iconified when one window is iconified. Yes - All the windows and menus
are iconified. No - Only the selected window is iconified.
On - Enables use of abbreviations when entering menu commands from
the keyboard.
Provides the ability to select locations in the graphics area via the
keyboard. Yes - Selection in the graphics area may be performed via the
keyboard. No - Selection in the graphics area requires a mouse.
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Values

Default Value

yes, no

no

yes, no
default, excel_linked,
excel_embedded

no
default

yes, no

no

yes, no

yes

yes, no

yes

medium, small, large
yes, no

yes

yes, no

yes

off, on

off

yes, no

no

yes, no

no
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Category
User Interface

menu_font

Name

User Interface

menu_manager_position

User Interface

menu_mapper_location

User Interface

menu_translation

Description
Specify font used in the Creo Parametric menu bar, menus, and all their
children. Specify the comma-delimited variables in any order (italic bold,
24, times or 24, times, italic bold have the same effect). Any omitted
variable uses the standard setting.
Controls the position of the Menu Manager. outside - Top left corner of
Menu Manager is aligned to top right corner of window, inside - Top right
corner of Menu Manager is aligned to top right corner of graphics area,
adaptive - Menu Manager is positioned outside if there is enough room,
otherwise it is positioned inside.
Specify your own URL for the Menu Mapper button in the help menu.

User Interface
User Interface
User Interface

Specifies the language in which the menus display when running nonEnglish version of Creo Parametric.
modeltree_show_gen_of_inst Determines whether the generic name is displayed as an extension of the
ance
instance name in the model tree and other model name lists.
msg_translation
Specifies language in which Messages are displayed when running nonEnglish version of Creo Parametric.
native_kbd_macros
Specifies support of keyboard macros written in native language (for
example, German).
new_parameter_ui
Enable the new parameter editor and user interface.
new_relation_ui
Enable the new relations editor and user interface.
online_resources_location
Specify your own URL for the Online Resources button in the help menu.

User Interface

open_window_maximized

User Interface
User Interface
User Interface

Values

inside, outside, adaptive

adaptive

yes, no, both

yes

yes, no

yes

yes, no

yes

yes, no

no

yes, no
yes, no

yes
yes

User Interface
User Interface

Open any new Creo Parametric window maximized by default. This config yes, no
will override "reserve_menu_space" option.
param_dec_places
Sets the number of decimal places (0-14) to display in parameters.
parameter_dialog_setup_file Setup for the parameter dialog configuration file.

User Interface

part_table_editor

User Interface

pattern_relations_copy

User Interface

popuphelp_font

PTC Inc.

Sets the editor that is used to edit notebook parameter tables. Protab Use Pro/TABLE. Editor - Use the system editor (refer to
pro_editor_command).
Determines whether relations of pattern leader are inherited by pattern
members.
Specify font used in the Creo Parametric pop-up help. Add the commadelimited variables in any order (italic bold, 24, times or 24, times, italic
bold have the same effect). Any omitted variable uses the standard
setting.
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Default Value

no
6

protab, editor, excel

yes, no

yes
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Category
User Interface

User Interface
User Interface
User Interface

User Interface
User Interface
User Interface
User Interface
User Interface

User Interface
User Interface
User Interface
User Interface

User Interface

User Interface

User Interface

PTC Inc.

Name
pro_editor_command

Description
Enables use of an editor other than the system editor when the option
editor has been specified as the value for the options part_table_editor or
relation_file_editor.
prompt_on_exit
Determines if you are prompted to save objects when exiting a Creo
Parametric session.
propagate_inactive_annotatio Yes - causes the propagation of inactive annotation.
n
provide_pick_message_alwa No - A message describing the (pre)selected item is provided only while
ys
querying. Yes - A message describing the selected item is provided in all
cases (i.e. even when Query is not used).
relation_file_editor
Sets the editor used to edit relations.
reserved_menu_space
Reserves space for extra menus to the right of the Creo Parametric
window (0.0-4.0). This option overrides windows_scale.
right_mouse_button_popup Specify whether or not the right mouse button pop up menu is available or
not.
selection_dragger_display_m Threshold for the number of simultaneously selected items to not display
ax
draggers.
set_menu_width
Determines width of menu manager panels. Default value is equivalent to
8 character widths. Acceptable range is from 8 to 20. Values lower than 8
and higher than 20 are ignored.
summary_help
Refers to the one-line help Messages that are either displayed or not
displayed.
suppress_dlg_license_expire Suppresses "License expired: List of options and expiration days" dialog
d
suppress_license_loss_dialo Yes - Suppresses the 'Regained Floating License' dialog box. No - The
g
'Regained Floating License' dialog box will display.
terminal_command
Specifies the full path to the terminal emulator command (the command
that starts shell windows). Use the command for your system. Enter the
complete path name and the terminal command.
thermo_position_hint
Enables you to position the thermometer-type scales whenever they
appear, so that they do not overlap the Creo Parametric windows (if space
permits, for example, if windows have been scaled).
visible_mapkeys
No - Mapkeys will run without displaying picks being made in the Menu
Manager menus. This does not affect the display of picks being made in
menu bar menus or dialog boxes.
visible_message_lines
Sets the default number of visible message lines in the Creo Parametric
message area.
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Values

Default Value

yes, no

no

yes, no

yes

yes, no

no

protab, editor

editor
1

yes, no

yes
100
-1

yes, no

no
7

yes, no

no

no_window_overlap,
window_overlap

window_overlap

yes, no

no

2
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Category
User Interface

Name
windows_scale

Weld

add_weld_mp

Weld

pro_weld_params_dir

Weld

weld_ask_xsec_refs

Weld

weld_color

Description
Scales Creo Parametric windows with a given coefficient. A value of 0.85
is usually adequate to allow dynamic menus to display to the right of the
Creo Parametric window.
Yes - System includes welds when calculating mass properties and
approximates lightweight weld mass properties. No - System excludes
welds when calculating mass properties.
Specifies the directory to search when a weld parameter file is needed.

Values

Default Value
1

yes, no

no

No - Do not ask for X-section references when creating weld features. Yes yes, no
- Ask for X-section references when creating weld features.

no

Defines default weld color. The three decimal values specify (in order)
percentage of red, green and blue in the resulting color. For example, 0 0
49 specifies a medium blue. Change in session using
Tools>Colors>System.
weld_dec_places
Sets the default number of decimal places (0-10) to display in weld
parameters.
weld_edge_prep_driven_by Determines if the edge preparation feature is created in the part or the
part, assembly
assembly level.
weld_edge_prep_groove_ang Specifies an initial default value for the angle cut edge preparation.
le
weld_edge_prep_groove_dep Specifies an initial default value for the edge preparation depth.
th
weld_edge_prep_instance
Controls whether a family table instance is created for edge preparation. yes, no
Yes - Instances of the components that receive edge preparation are
created.
weld_edge_prep_name_suffi Specifies the suffix name for the instance that will be created during edge
x
preparation. Part name plus extension makes the instance name.

0.000000 0.000000
0.000000

Weld

weld_edge_prep_root_open

Specifies an initial default value for the root opening edge preparation.

0.25

Weld

weld_edge_prep_visibility

Weld
Weld

weld_geom_type_default
weld_notch_corner_radius

Applies only if weld_edge_prep is set to Yes. Generic - Edge preparation
features are resumed in the generic and suppressed in the instance.
Instance - Edge preparation features are suppressed in the generic and
resumed in the instance.
Sets the default weld geometry type.
Specifies an initial default value for the radius at weld notch corner.

Weld
Weld
Weld
Weld
Weld

Weld

PTC Inc.
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Weld
Weld
Weld
Weld

Category

Name
weld_notch_height
weld_notch_radius
weld_notch_width
weld_ui_standard

Without category

accessory_window_above

Without category

accessory_window_display

Without category
Without category
Without category

acis_out_version
aec_parameter_file
allow_delete_many_in_drawi
ngs

Description
Specifies an initial default value for the weld notch height.
Specifies an initial default value for the weld notch radius.
Specifies an initial default value for the weld notch width.
Specifies standard for welding user interface. ANSI - Use ANSI standards. ansi, iso
ISO - Use ISO standards.
Yes - Displays and keeps the accessory window above the active window. yes, no
No - Does not keep the accessory window above the active window.

Without category
Without category
Without category

atb_search_path

Extends search path for ATB Update and ATB Check Status commands.

Without category

attach_menumanager

Setup menu manager attachment to the main Creo Parametric window.

Without category

auto_center_dimension

Without category
Without category

Without category

PTC Inc.

Default Value
0.4
0.5
0.5
ansi
no

Docked - Displays the accessory window embedded in the active window. undocked, docked
Undocked - Displays the accessory window as a standalone window.

Allows the user to choose ACIS export version.
Specifies the file name of the user defined piping parameter codes.
Make the Delete Many command available in drawing mode. The Delete
Many command is not supported by undo but can improve performance
when deleting a significant number of items.
allow_workpiece_silhouette Determines if the workpiece is allowed for Silhouette Mach Window
creation. NO - only reference part is allowed; YES - both workpiece and
reference part are allowed; AUTO - only workpiece is allowed.
animation_imported_pbk_dir Sets the default directory for the playback files to be used for Imported
Animation.
arc_radius_limit
Sets the upper limit for a radius in a CIRCLE statement of NCL file. The
value must be positive. If not, 10*part_size is used.
ask_designate_owners
Show the both required and optional owners to be designated.
assemble_module_in_rep
Retrieves the assembled module to CSA in a specified representation.

Without category

Values

docked

4, 5

5

yes, no

no

yes, no, auto

no

-1
yes, no

yes
representative module
variant

yes, no

no

Automatically centers the dimension text between witness lines. For
yes, no
common reference dimensions, controls the centering of the first
dimension only.
auto_clean_shown_dimensio This option controls whether the clean dimensions routine is automatically yes, no
ns
applied for newly shown dimensions. When set to NO the dimensions will
be shown using their default locations from the model.

no
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Category
Without category

Name
Description
auto_eval_current_cnfg_rule If the option is "yes" simplified representation would be updated each time yes, no
on retrieve/regeneration if it contains current configuration rule.

Without category

auto_show_3d_detail_items

Without category
Without category

Without category
Without category
Without category
Without category
Without category
Without category

Without category

Without category
Without category
Without category

Without category

PTC Inc.

When set to yes, AEs parallel to the view will be displayed while creating a
new view.
auto_update_default_dwg_m Automatically update the default drawing model to one shown in a view on
odel
the current sheet.
backup_reference_informatio Yes-Backup the reference information of a feature once the feature
n
regenerates successfully. No- Do not save the reference information of a
feature.
bmx_param_restrictions
Restricted parameters automatically violate constraints in any Design
Study
check_udf_int_key
Yes - updates UDF internal keys upon group's retrieval. No - skips keys
update.
collect_dims_in_active_layer This config options allows dimensions to be collected on the active layer.

Values

Default Value
yes

yes, no

yes

yes, no

yes

yes, no

yes

yes, no

yes

yes, no

yes

yes, no

yes

combined_views_customizati Enable / Disable combined views customization.
on
comp_assemble_with_interfa Settings for assembling component with interface(s).
ce
comp_interface_placement
Sets the default interface placement type. Interface to geometry - place
the component using component interfaces and assembly geometry.
Interface to Interface - place the component using assembly and
component interfaces.
comp_normal_offset_eps
Specifies the angle epsilon such that if the desired surfaces are equal or
less than the epsilon (in degrees), then a normal constraint will be created.

yes, no

yes

none, default_multi,
default_single, from_list
interface_to_interface,
interface_to_geom

default_multi

comp_placement_legacy_mo Show the legacy Move tab in the Component Placement dashboard
ve
comp_snap_angle_tolerance Specify the angle tolerance for snapping while freeform dragging
components. Default value is 30.0 degrees.
comp_snap_dist_tolerance
Specify the distance tolerance for snapping while freeform dragging
components. Default value is 0.1 (relative to size of component being
assembled).
confirm_on_edit_foreign_mo Provides a confirmation dialog when attempting to make design changes
dels
to foreign models

yes, no
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yes
30
0.1

yes, no

no
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Category
Without category

Without category
Without category
Without category
Without category

Without category
Without category
Without category
Without category
Without category

Without category
Without category

Without category
Without category
Without category
Without category
Without category
Without category

Without category

PTC Inc.

Name
Description
constraint_reference_redefin keep_constraint_type - Adjusts the component position to keep the same
e
constraint type. reset_constraint_type - Automatically changes the
constraint type to keep the position of the component.
contact_surfaces_gap
Sets the maximum allowable gap between weld contact surfaces.
convert_to_wf3_replace
Convert to Wildfire3 replace functionality.
cosmetic_thread_match_toler Sets the tolerance, which is used in the analysis to match standard thread
ance
type and standard radius, to the selected thread surface.
create_drw_sheet_thumbnail Controls whether thumbnail images of drawing sheets will be generated
s
and displayed with the drawing sheet tabs. Setting this option to No may
improve performance with large drawings.
creotkdat
Specify the full path to an additional Toolkit registry file.
default_cable_axis_location Sets the location type for axis. Choose Along to create one location at
each end of the axis.
default_geom_analysis_type Default save type for geometry analysis.
default_ref_current_module_ Allow references to current design solution only.
vrnt
des_exp_folder
Sets the directory for the Design Exploration session. The default location
is in a default system folder. Type a valid file path to change the directory
to a user defined one.
designate_model_item_para When an object is designated, all parameters belonging to that object will
ms
be automatically designated as well.
disp_in_open_rep_create
Simplified Rep to display initially in Open Rep Create: "No" for none, "Yes"
for graphics rep, or "Default Rep" to display the rep indicated by option
"open_simplified_rep_by_default".
display_all_dims
Controls the display of dimensions during dynamic edit.
display_combined_views
Display combined view tabs by default
display_images
Display images outside of Style feature
display_mapkeys_dialog_on_ Controls whether mapkeys dialog will be displayed always on top (yes) or
top
behind the main window (no).
display_pdm_server_quick_vi Yes - display summary view of PDM information for items in session. It
ew
applies to ProductPoint only.
display_popup_viewer
No- disable popup viewer, File_Open_Only: display popup viewer only in
the file open dialog, Yes: display popup viewer in file open dialog, model
tree and in Server Quick View dialog
display_sketch_dims
Controls the display of sketch dimensions during dynamic edit.
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Values
keep_constraint_type,
reset_constraint_type

Default Value
keep_constraint_type

yes, no

0
no
0.001

yes, no

yes

on, along

on

quick, saved, feature

quick

yes, no

yes

yes, no

no

yes, no, default rep

no

yes, no
yes, no
yes, no
yes, no

yes
no
yes
no

yes, no

yes

yes, no, file_open_only

file_open_only

yes, no

yes
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Category
Without category
Without category

Without category

Without category
Without category
Without category
Without category
Without category

Without category

Without category
Without category
Without category
Without category
Without category
Without category

Without category
Without category
Without category
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Name
Description
dm_enable_simple_import_e Enable a simplified method of import/export between disk and Workspace.
xport
dm_nc_process
Sets output of NC process information as content on the NC Assembly
CAD Document in XML Format. Yes - Outputs the file whenever CAD
Document is Saved. No - Does not output the file.
dm_nc_references
Sets whether reference relationships will be created in Windchill between
the manufacturing model and its deliverables(CL file, tape file and DMIS
file).
dm_preview_searches_serve Search for files on the server while previewing.
r
drw_prompt_for_combined_s Determines whether the combined state prompt will appear in a drawing
tate
when creating a view.
dwg_unicode_conv_lang_sco Specifies scope of the option 'dwg_unicode_conversion_language'. '2D' to
pe
apply to 2D models only, 'ALL' to apply to all models.
edge_tess_quality
Set the accuracy level for arc tessellation.
enable_3dmodelspace_brow Yes - Display 3D ModelSpace tab in the browser when Creo Parametric
ser_tab
starts. No - Display 3D ModelSpace tab only when you click a 3D
ModelSpace link in the navigator.
enable_face_preselection
Controls the ability to "pre-select" faces/datums as an entry to Sketch
based features such as Extrude, Revolve (input to the internal sketch).
enable_face_thread_turning
enable_fsaa
enable_obsoleted_features
enable_offset_fan_curve
enable_opengl_shader
esr_mass_properties

Allows/disallows face option for thread turning sequence.
Enable OpenGL full screen anti-aliasing.

Enables fan curve option for offset tool.
Enable OpenGL Phong lighting.
Defines whether to include all immediate components of external
simplified rep into Mass Properties calculations or only defined state of
design assembly.
expand_all_with_nested_laye Yes - expand all including nested sub layers.
rs
fasthlr_drawing
Specifies whether fast hidden line removal is on/off by default.
file_dialog_units_class
Sets the units for manikin attributes displayed in the File Open dialog.
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Values

Default Value

yes, no

yes

yes, no

no

yes, no

yes

yes, no

yes

yes, no

yes

all, 2d

2d

high, medium, low
yes, no

low
yes

yes, no

yes

yes, no
off, 2, 4, 8, 16, 32
yes, no
yes, no
yes, no
design_only, extended

no
off
no
no
yes
design_only

yes, no

yes

yes, no
mks, ips

no
mks
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Category
Without category

Name
file_timestamp_format

Without category

flex_display_dflt_bounding_e
dge
flex_dma_reduce_solution_n
umber
flex_tan_propagation_default

Without category
Without category
Without category

Without category

Without category
Without category
Without category
Without category
Without category
Without category
Without category
Without category

Without category

Without category

PTC Inc.

Description
Controls the format of time stamps in file dialogs and the folder browser.
The format for the setting is a string consisting of up to seven portions: the
year, the month, and the date, the hours, minutes, seconds and am/pm
designator. You can enter the portions in any order.

Turns on/off highlighted display of default bounding edges in flexible
modeling features that can have multiple solutions.
Reduces the number of default solutions found in Flex features, when
modifying geometry with mixed convexity contours.
Defines default state of the Tangency Propagation option in Flexible
Modeling features.
group_repl_with_recycle
Yes - enables new UDF replacement with family table instances that
prevents children failures. No - UDF replacement will work in the same
manner as Wildfire 3.0 and earlier releases.
group_replace_rename
Yes - updates replaced group name with replacement group name. No preserves existing name of the group being replaced if it is a user-given
name.
hdic_export_v5_secondary_c In HDIC export for CATIA V5 allows to attach CGR as a secondary
gr
content
hdic_export_v5_to_ws_enabl Enables HDIC export for CATIA V5 to Workspace.
e
idd_repair_tangency
Sets the default state of the "Repair Tangency" checkbox in the Repair
and Match tools
include_all_tools_in_list
Show/hide inapplicable cutting tools in mfg sequence UI.
intf_nx_version
Sets the version of NX interface.
intf3d_out_catia_v5_version Allows the user to switch between the default and alternate converter
version for export to CATIA V5
intf3d_out_nx_version
Allows the user to switch between the default and alternate converter
version for export to NX
jlink_java_command
Specifies a command to start JRE for J-Link. May contain arguments and
environment variables. Overrides the default, see also jlink_java2.
js_error_policy

Control the display and execution of the java script error dialogs. If the
dialog is presented, the user can choose whether to stop or continue
running the script.
keep_model_in_open_windo Controls whether a model is displayed in its window when the accessory
w
window is open.
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Values

Default Value
%dd-%mmm-%yy
%hh:%mi:%ss %pm

yes, no

yes

yes, no

yes

off, on

off

yes, no

yes

yes, no

yes

yes, no

no

yes, no

no

yes, no

no

yes, no
6, 7, 8
16, 17, 18, 19, 20, 21, 22

no
6
16

3, 5, 7

3

show, suppress_continue,
supress_stop
yes, no

no
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Category
Without category

Name
last_session_directory_path

Description
Sets the directory that holds the temp files for the session recording
mechanism.

Without category

last_session_retrieval

Without category

layer_rule_retrieve_objects

Without category
Without category
Without category
Without category

layout_data_sharing
layout_guides
layout_precision_decimals
layout_precision_panel

Without category

layout_smart_constraints

Yes - Activates recording mechanism that enables the session to be
retrieved during the next session. No - The recording mechanism is not
available and the session can not be retrieved.
This option controls whether or not the system will retrieve additional
objects needed to evaluate a layer rule. OK tells the system to retrieve the
objects. Cancel stops evaluation of the rule.
Allows to change the default ce entity type to be public or private.
Enable/Disable layout guides.
Display 0 to 5 decimal places in precision panels
Yes - Precision Panel will be shown; No - Precision Panel will not be
shown.
To improve the user experience, specific entity types are appropriately
constrained by default (i.e. - fillets with tangency constraints). Yes specific entity types will be created with appropriate constraints by default;
No - constraints will never be automatically created for any entity type.

Without category

layout_symbol_inst_palette_fi Specifies the location of the layout symbol instance palette. If you do not
le
specify a directory, layout will use the same palette as Creo Parametric
drawings. Use full path name to avoid problems.
layout_template_dir
Specifies the default directory for layout template files. Use full pathname
to avoid problems.
lda_batch_mapping_option
Specifies the options for mapping in LDA from dBatch.
all, model_only, views_only,
annotations_only,
model_and_views,
views_and_annotations
lda_map_file
Path to the file containing the list of matching drawings and solid models.

Without category
Without category

Without category
Without category
Without category

Values

yes, no

Default Value
<work_dir>\appdata\roa
ming\ptc\proengineer\wil
dfire\.wf\.settings
yes

ok, cancel, promt

promt

private, public
yes, no
1, 3, 2, 4, 5
yes, no

private
yes
2
yes

yes, no

yes

all

Without category

lda_model_dir
Path to the directory containing the solid models.
lda_overall_view_map_time_l Specifies LDA overall view mapping time limit in seconds.
imit
lda_prefix_in_basic_dim_box Add prefix to basic box while converting the dimension to basic.

yes, no

no

Without category

lda_show_entities_default

yes, no

no

PTC Inc.

Speicify whether to show mapped draft entities by default in Validate
Association Dialog.
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Category
Without category
Without category
Without category
Without category

Without category
Without category
Without category
Without category

Without category
Without category
Without category

Without category
Without category

Name
lda_view_map_time_limit
manikin_drag_auto_locks
manikin_drag_legacy_rotate

Description
Specifies LDA single view mapping time limit in seconds.
Manikin drag auto locks
Controls the Manikin Rotate Around Axis drag mode: Legacy (YES) or
direct joint angle control (NO)
manikin_flexibility
Sets the level of flexibility that is allowed when dragging a manikin. FULL All Manikin segments are articulated. NONE - Manikin is calculated as a
single body. DEFAULT - Manikin finger segments are locked to a single
body.
manikin_replace_keep_postu Controls whether a manikin's existing posture is applied to a replacement
re
manikin.
mass_prop_load_from_file
Controls whether to take into the account values from mass properties file.
measure_auto_replace_mod Automatically switches to Replace mode for the last reference in
e
appropriate Measures (Distance, Angle, Transform)
measure_dec_places
This configuration option controls the number of digits after the decimal
point. If value = -1, this configuration is ignored and measure_sig_figures
is used
measure_dialog_expand
Determines default look of measure dialog (expanded or collapsed)
measure_ref_option_status Determine As Object (As Center et al.) checkbox option behavior in
Measure Tool
measure_show_feattab
Controls initial display of the Feature tab in Measure Tool. Yes - feature
tab is always displayed by default. No - feature tab state is saved for the
duration of the session upon closing of the dialog.
mfg_cl_euc_japanese_encod Yes - Output cl-file Japanese characters in EUC encoding.
e
mfg_paste_special_dep_defa Controls the default state of the following option in Paste Special dialog:
ult
"Make copies dependent on dimensions of originals". This configuration
option has an effect only for manufacturing assemblies.

Without category

mfg_tap_mat_rem_coef

Without category

model_tree_font

PTC Inc.

The factor is used to consider the threading of tapping tool. The estimate
removed material value of tapping sequence is presented as estimate
removed material value multiplied by this factor. The factor should be
greater than 0 and upto 1.0.
Specify font used in the Creo Parametric Model Tree. specify the commadelimited variables in any order (italic bold, 24, times or 24, times, italic
bold have the same effect). Any omitted variable uses the standard
setting.
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Values

Default Value

yes, no
yes, no

60
yes
no

none, default, full

default

yes, no

yes

by_request, always

by_request

yes, no

no
-1

yes, no
no
default, all_on, all_off, keep_last default
yes, no

yes

yes, no

no

yes, no

yes

1
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Category
Without category
Without category
Without category

Name
Description
modelcheck_dir
Specifies path to the ModelCHECK configuration files.
module_variant_cross_refs
Allow references between design solutions in Module
mp_analysis_default_source Specifies the default source for mass properties calculation via Analysis.

yes, no
no
geometry, assigned, mp_source

Without category
Without category
Without category

mp_calc_level
multiple_skeletons_allowed
nc_jobman_visible

Specifies the level of mass properties calculation.
Allows/restricts multiple skeleton.
Yes - make "Submit Path" and "Abort Path" visible. No - make "Submit
Path" and "Abort Path" invisible.
new_ref_part_name_disabled Disallow redirecting data sharing feature missing reference model to a
model with different name.
old_style_set_datum
Yes - datum properties dialog has button for old-style set datum. No datum properties dialog does not have button for old-style set datum.

assembly_only, all_models
yes, no
yes, no

assembly_only
no
no

yes, no

yes

yes, no

yes

open_builder_in_mt_mode
orientation_style
output_mfg_xml

yes, no
anchored, dynamic
yes, no

no
dynamic
no

Without category
Without category

Without category
Without category
Without category

Without category

Open the variant builder in Model Tree Selection mode
Set spin orientation style to dynamic or anchored.
Allows export/import mfg model to/from xml file. Yes - make
Export/Import options visible. No - make them invisible.
pdm_server_quickview_rows Sets the default number of rows for the pdm quick view list.
_num
plot_names_with_sheet
Yes - Plot file names are appended with _(sheet number) before file
extension.
popup_refpairintch_window Bring forward the window being used with the reference pairing table.

Without category

prime_analysis_directory

Without category
Without category

prime_automapping
propagate_by_default

Without category

ptc_manikin_comforts_path

Sets the default directory for the Creo Parametric manikin comfort angles.
You must restart Creo Parametric for the change to take effect.

Without category

ptc_manikin_library_path

Sets the default directory for the Creo Parametric manikin library (or
custom manikin libraries you built containing the proper index menu files).
Use the full path name to avoid problems. You must restart Creo
Parametric for the change to take effect.

Without category
Without category

PTC Inc.

Sets the default directory for the Prime files to be used for Prime analysis
calculations. Use the full pathname to avoid problems.
Toggles Prime analysis automapping of variables
Yes - If the modified geometry belongs to a geometry pattern, a pattern
recognition feature or a symmetry recognition feature, the modification is
automatically propagated to all pattern/symmetry members.
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Values

Default Value

7
yes, no

no

yes, no

no

yes, no
yes, no

no
no

<creo3.0_loadpoint>\ma
nikin_lite\
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Category
Without category

Name
ptc_manikin_posture_path

Without category

qty_balloon_change_warning Sets the warning style when quantity balloons have changed in a drawing.
Dialog displays the warning in a dialog box, Message displays the warning
in the message area only.
quick_print_drawing_templat Specify the path and name of a drawing template to be used by the File >
e
Quick Print command.
quick_print_plotter_config_file Specify the path and name of the default plotter config file to be used by
the File > Quick Drawing command.
radial_hole_linear_dim
YES - Option for creation of radial hole with a linear dimension will be
available.
record_mapkey_comment_to Controls whether a comment is written to the trail file whenever a mapkey
_trail
is executed.
regen_failure_handling
Specifies whether to enter resolve mode when regeneration failures occur.
Resolve_mode - Enter resolve mode when regeneration failures occur.
No_resolve_mode - Don't enter resolve mode when regeneration failures
occur.
regen_int_mdls_on_retr
Yes to regen models intersected with assem feats during assembly
retrieval.
regen_solid_before_save
Controls whether to regenerate top model, or promot user before
regeneration if it is required
relations_ang_eval_diff_chec Check for differences in the evaluation of relation sets evaluated and
k
saved in versions of Creo 2.0 prior to M110. Warn_message Check and
give a warning in the message area. Warn_dialog Check and give a
warning in a message window. Ignore Skip the check and warning.

dialog, message

dialog

yes, no

no

yes, no

yes

resolve_mode,
no_resolve_mode

no_resolve_mode

yes, no

no

yes, no, prompt

prompt

ignore, warn_message,
warn_dialog

warn_message

relations_num_const_units

yes, no

no

yes, no

yes

yes, no

yes

yes, no

yes

Without category
Without category
Without category
Without category
Without category

Without category
Without category
Without category

Without category
Without category

Without category
Without category

PTC Inc.

Description
Sets the default directory for the Creo Parametric manikin postures (or
custom posture libraries you built). Use the full path name to avoid
problems. You must restart Creo Parametric for the change to take effect.

Specifies whether diagnostic should be issued when an unitless numeric
value causes relation expression evaluation trouble.
relations_units_sensitive
Set the default unit sensitivity (ignore or take into account
parameter/dimensions units) in creation of new relation data (legacy
relation data will not be unit sensitive until "converted" to one).
remember_last_attach_type Yes - Sets the default of the ATTACH TYPE menu of the last options
picked.
remember_replaced_compon Set to "Yes" this option will preserve a dependency to the replaced,
ents
outgoing, component. Set to "No" the dependency will, when possible, be
removed.
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Default Value
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Category
Without category

Without category
Without category
Without category
Without category
Without category

Without category
Without category
Without category
Without category

Name
Description
replace_comp_notes_method Specify treatment of notes when components are replaced. Transfer transfer to new component. Remove - remove the notes. Preserve - save
notes in case component is restored.
reroute_affected_children
Affected children when setting Current solution.
restricted_val_definition
Specify name and path of the file contained restricted values definition.
retrieve_display
retrieve_merge_ref_parts
rmv_xsec_unlinked_cosm_fe
ats

Controls whether or not graphics data is loaded in the background.
Automatic reference parts retrieval for dependent Merge.
Specify whether to automatically try to delete, or to detach from the feature
list, the internal sketch features which were unlinked from offset cross
sections, and whether to do it only upon sketch unlinking, or upon model
retrieval too.
round_prewf5_displayed_dim Rounds the displayed value
_val
save_view_states_method
Setup the method used on saving view states changes.

Values
transfer, remove, preserve

Default Value
transfer

none, auto, selective

selective

background, foreground
yes, no, ignore_missing
none, detach_on_unlink,
delete_on_unlink,
detach_on_both,
delete_on_both
round all, round none,
calculated
prompt, save changes, discard
changes
yes, no
yes, no

background
no
detach_on_unlink

calculated
prompt

shade_with_edge_tangent
Display Tangent edges in Shade with Edge view mode.
show_affected_children_dialo Do not invoke dialog for setting Current solution.
g
show_axes_by_view_scope Determines the scope of the Show Model Annotations tool when showing top_model_only,
model datums and selecting a drawing view. For large assembly drawings, all_sub_models
use top_model_only to improve performance by restricting the set of axes
to be shown.
show_description_view_mgr Yes - show a column for Description field for all tabs in view manager.
yes, no

yes
yes

Without category

show_object_type_in_taskbar Yes - Displays the icon of the open PTC Creo object in the taskbar and
yes, no
window title bar. For all PTC Creo applications except PTC Creo
Parametric, icons include a letter indicating the application name. No Displays the PTC Creo application icon in the taskbar and window title bar.

no

Without category

show_sketch_dims_in_featur Sets the default display state of internal sketch dimensions in the feature
e
definition environment.
simprep_column_display
Controls display of Simplified Representations columns in Model Tree,
'Automatic'-'Current Rep' column is shown automatically when a rep is
activated, 'Manual' visibility of the column is fully controlled by user, preWildfire 6 behavior.

yes, no

no

automatic, manual

automatic

Without category

Without category

Without category

PTC Inc.

91

top_model_only

no
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Category
Without category

Name
simprep_column_format

Without category

simprep_default_cnfg_asm

Without category
Without category

Retrieves a CSA model in a specified representation. Yes - uses Open
Rep dialog. No - retrieves the Master representation. Specified Name retrieves the model in the specified representation name if it exists or the
Default representation.
simprep_ondemand_activatio Enables retrieving on-demand the Master rep of an activated model.
n
When an assembly is activated the Assembly only rep is retrieved.
simprep_ondemand_cleanup Determines if a model retrieved on demand should be removed or
erased. Disabled - the model will not be removed and will remain in the
assembly. Removed - the model will be removed. Remove_Erase - The
model will be removed and erased from memory.

Without category

simprep_ondemand_editing

Without category
Without category
Without category

simprep_ondemand_regener
ation
single_side_surf_color
sketcher_curve_color_synch

Without category

sketcher_palette_path

Without category
Without category
Without category

sketcher_rel_accuracy
sketcher_strngthn_to_def_de
c_pl
snap_single_constraints

Without category

spin_with_orientation_center

Without category

style_state_transparency

Without category
Without category

PTC Inc.

Description
Specifies simplified representation model tree column format.

Enables on demand retrieval of an edited item and its parent references.
Configuration tools (Family Tables, Relations, etc) will retrieve required
models accordingly. Automatic - Retrieves the minimum rep required to
perform the operation.
Enables on demand retrieval of required models during regeneration.
Can affect regeneration performance.
Allow application of color to a single side of a surface.
Synchronize color assignment between sketched curves and their
sketches.
Sets the default directory for the user sketcher shape library. Use the full
path name to avoid problems.
Enter a sketcher relative accuracy.
This option enable the user to keep a highly precise value during creation
or convertion strong dimension.
When dynamically dragging components during component placement,
allow to snap to references one constraint at a time.
Display orientation center while reorienting.

Values
names only, icons only, icons
and names

last stored

yes, no

yes

disable, restore,
restore_and_erase

restore

automatic, master, disable,
master_with_ancestors

automatic

automatic, master, disable

automatic

yes, no
yes, no

no
yes

yes, no

1
yes

yes, no

yes

yes, no

yes

Set the value of transparency for components set to "Transparent" in style
state. Value must be between 0 and 100.
suppress_dim_ghost_with_ct Suppress the ghost image of dimension when CTRL is pressed. It allows yes, no
rl
better visibility while selecting further dimension references.
template_cnfg_asm
Specifies the default configurable assembly template file. Use full
pathname to avoid problems.
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Default Value
icons and names

70
no
inlbs_csa.asm
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Category
Without category

Without category
Without category

Description
Specifies the designated template ESR assembly. Use full path to avoid
problems.
template_layout
Specifies the default layout template file. Use full pathname to avoid
problems.
tk_enable_ribbon_custom_sa Enable storing the Auxiliary Application User Interface customization
ve
tool_mgr_save_pocket_in_x Determines whether the tool position should be saved in a XML file (*.txf)
ml
created in tool manager dialog.
travel_bounds_display
Enable travel bounds display.
travel_bounds_transparency Transparency value for machine bound display.

Without category

trngrv_roundtool_nobackcut

Without category
Without category
Without category

Without category

Without category
Without category
Without category
Without category
Without category
Without category
Without category
Without category
Without category
Without category
Without category
Without category

PTC Inc.

Name
template_esrasm

Values

Default Value
inlbs_asm_esr.asm

yes, no

no

yes, no

yes

yes, no

no
0.8

Yes - Groove turning using round tool generates no back cut motion for
yes, no
profile pass.
upd_param_on_retr_mark_m Allows/disallows mark model as changed if as a result of mass
yes, no
odified
properties/relations calculation during retrieval some parameter values are
changed.
use_master_for_bad_disp_re Yes to retrieve master rep when graphics rep has no display data.
yes, no
ps
use_strict_ui_trail
Perform extra validation of user interface actions when playing back trail
yes, no
files.
use_temp_interface_for_past Yes - Enables use of interfaces for multiple placement of components
yes, no
e
during paste.
use_web_page_font_in_repor Controls whether HTML reports use the browser's standard fonts.
yes, no
ts
visible_recent_files
Number of visible recent files. The possible range is 1 - 30.
web_enable_javascript
Enables or disables Pro/Web.Link in the embedded browser.
off, on
web_max_mail_size
Set the maximum email attachment size in kilobytes.
weld_fillet_preferences_file
Sets the path and name of the fillet weld preferences file.
weld_general_preferences_fil Sets the path and name of the general weld preferences file.
e
weld_groove_preferences_fil Sets the path and name of the groove weld preferences file.
e
weld_plug_slot_preferences_ Sets the path and name of the plug/slot weld preferences file.
file
weld_spot_preferences_file Sets the path and name of the spot weld preferences file.

no
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no

no
yes
yes
no
21
off
5000
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Category
Assembly
Assembly
Assembly

Creo Simulate

Data Exchange

Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange

PTC Inc.

Name
Status
allow_freeze_failed_assy_co NEW
mp
auto_backup_new_placemnt DELETED
_refs
freeze_failed_assy_comp
DELETED

Description
Allow freezing failed assembly components.

Values

Yes - Create Component Reference Backup, No - Do not
Create Component Reference Backup.
No - Requires an action to fix the assembly or freeze the
component that fails retrieval. Yes - Freezes any
component failing retrieval at its last known assembly
location.
sim_hyperelastic_material_fit CHANGED Sets the default method for calculating coefficients for
hyperelastic materials. If set to "normalized", normalized
stresses will be used. If set to "non-normalized", nonnormalized stresses will be used.)
---------Sets the default method for calculating coefficients for
hyperelastic materials. If set to "normalized", normalized
stresses will be used. If set to "non-normalized", nonnormalized stresses will be used.
afx_enabled
CHANGED Loads EFX application.
---------Loads AFX application.
atb_show_foreign_name
NEW
Displays foreign source model name in the model tree
for imported models.
board_bend_notes_dflt_displ NEW
Define the default state of bend note display (board
ay
mode)
board_bend_notes_direction NEW
Defines the down direction symbol for board bend notes.
_down
board_bend_notes_direction NEW
Defines the up direction symbol for board bend notes.
_up
board_bend_notes_order
NEW
Defines the fields order for board bend notes.
board_bend_notes_type_for NEW
Defines the formed symbol for board bend notes.
med
board_bend_notes_type_roll NEW
Defines the rolled symbol for board bend notes.
ed
board_bend_table_directory NEW
Will be used to set the bend allowance table only. Sets
the default directory of the board bend allowance table
files. If not set, the system supplied bend tables are
used. Use the full name and path to avoid problems.
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Default Value

yes, no

no

yes, no

no

yes, no

no

normalized, nonnormalized

normalized

yes, no

yes, no

no
---------yes
yes

yes, no

yes
default

&type&direction&angle
default
default
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Category
Data Exchange

Name
Status
board_design_rules_director NEW
y

Data Exchange

board_drive_bend_by_param NEW
eters

Data Exchange

NEW

Data Exchange

board_drive_tools_by_param
eters
board_flange_shape_sketch
es_dir
board_flat_shape_sketches_
dir
board_parameters_directory

Data Exchange

dwg_export_format

CHANGED Provides the ability to choose DWG file version when
exporting from Creo Parametric drawing.

Data Exchange

dxf_export_format

CHANGED Provides the ability to choose DXF file version when
exporting from Creo Parametric drawing.

Data Exchange

dxf_in_proxy_entity

DELETED

Data Exchange

ecad_edmd_out_version

CHANGED Set the EDMD output version.

Data Exchange

ecad_outline_ents_enhanced CHANGED Enhanced export of special entities to ECAD formats.
_exp
Yes - Attempt to approximate arcs and lines. No - Use
part accuracy to approximate lines.
ecadcollab_accept_color
NEW
ECAD Collaboration Accept color
ecadcollab_auto_redef_area NEW
Automatically redefine ECAD Areas affected by
s
collaboration changes

Data Exchange
Data Exchange

Data Exchange
Data Exchange

PTC Inc.

NEW

Description
Will be used to set the design rules file folder only. Will
be used by the design rules manager. Sets the default
directory of the board design rules files. Use the full
name and path to avoid problems.
Board bend radius and bend angle values and bend
dimension location will be driven by feature-level
relations to board parameters.
Drives the board options and values by feature-level
relations to board parameters.
Sets path to directory that contains the Flange shapes.

NEW

Sets path to directory that contains the Flat shapes.

NEW

Specifies the directory to save/retrieve board parameters
files. Use full name and path to avoid problems.

Controls the input support for ACAD_PROXY_ENTITY.
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Values

Default Value

yes, no

no

yes, no

yes

14, 2000, 2004, 2007,
2010
---------14, 2000, 2004, 2007,
2010, 2013
12, 13, 14, 2000, 2004,
2007, 2010
---------12, 13, 14, 2000, 2004,
2007, 2010, 2013
yes, no

2007
---------2013

2.0, 1.2
---------2.0, 1.2, 3.0
yes, no

2

yes, no

2007
---------2013

yes

no
---------yes
0.0 255.0 0.0
yes
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Category
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange
Data Exchange

Data Exchange

Data Exchange

Data Exchange

PTC Inc.

Name
Status
ecadcollab_auto_redef_com NEW
ps
ecadcollab_auto_redef_holes NEW
ecadcollab_preview_after_co
lor
ecadcollab_preview_before_
color
ecadcollab_preview_level
ecadcollab_reject_color
ecadcollab_scan_des_on_ar
ea_chg
ecadcollab_scan_des_on_br
d_chg
ecadcollab_scan_des_on_co
mp_chg
ecadcollab_scan_des_on_ho
le_chg
ecadcollab_supp_failed_feat
s
ecadcollab_suppress_cuts

NEW

Description
Automatically redefine components affected by
collaboration changes
Automatically redefine holes affected by collaboration
changes
ECAD Collaboration Preview After color

NEW

ECAD Collaboration Preview Before color

NEW
NEW
NEW

ECAD Collaboration preview Level
ECAD Collaboration Reject color
Check for affected objects resulting from ECAD Areas
collaboration changes
Check for affected objects resulting from board
collaboration changes
Check for affected objects resulting from components
collaboration changes
Check for affected objects resulting from holes
collaboration changes
Suppress of failed features on Object changes

NEW
NEW
NEW
NEW
NEW

Values
yes

yes, no

yes
255.0 127.0 0.0
0.0 76.0 255.0

Automatically suppress cut features in case of board
collaboration changes
initial_board_bend_y_factor NEW
Specifies a value used to determine the neutral bend line
for a board part. This value is always used for noncylindrical bends. It is used for regular bends only when
no bend table is specified
intf_ug_version
CHANGED Sets the version of Unigraphics interface.
---------Sets the version of NX interface.
intf2d_in_acad_expl_unsupp NEW
Yes - ACAD_PROXY_ENTITY and REGION entities are
_ents
imported as set of draft entities, No ACAD_PROXY_ENTITY and REGION entities are
ignored.
intf2d_in_mi_brk_unsupp_di NEW
Yes - Breaks unsupported MI dimension types to
m
separate entities, No - Imports unsupported MI
dimension types as different type dimensions that can
look differently.
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Default Value

yes, no

full, partial, light
yes, no

partial
255.0 127.0 127.0
yes

yes, no

yes

yes, no

yes

yes, no

yes

yes, no

yes

yes, no

yes
0.5

nx6, nx7, nx8

nx6

yes, no

yes

yes, no

no
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Category
Data Exchange

Name
intf2d_in_mi_lay_parts

Data Exchange

intf2d_in_mi_sym_parts

Data Exchange

intf2d_in_mi_view_parts

Data Exchange

intf2d_out_old_quilt_priority

Data Exchange

intf3d_in_lock_redisplay

Data Exchange

pro_gplug_dir

Status
NEW

Description
Yes - Maps MI drafting parts to layers, No - Imports MI
drafting parts as separate entities.
NEW
Yes - Maps MI symbol parts to symbols, No - Imports MI
symbol parts as separate entities.
NEW
Yes - Maps MI annotation views to 2D views, No Imports MI annotation views as separate entities.
NEW
Yes - quilt lines have lower priority than hidden lines
when exporting or plotting a drawing. No - quilt lines
have higher priority than hidden lines.
NEW
Gives the option to prevent redisplay of the model while
they are in transitional state during Creo Elements Direct
file import.
CHANGED Specifies the directory in which Granite application plugins are located. Use the full pathname to avoid problems.

Data Exchange
pro_stheno_command
Data Management dm_hide_virtual_default_ws

DELETED
NEW

Data Management dm_simple

DELETED

Data Management dm_user_presence

DELETED

Drawing
Drawing

PTC Inc.

Specifies the command for Stheno launch.
Yes - When there is at least one workspace created in
any context in selected server, default workspaces that
were never used, will not be listed. No - (Default value)
Default workspaces will be listed for each context that
has no workspace defined.
Activate Simple Windchill Interaction

Enable user presence indicator and actions. This
capability requires a connection with a PDM server and
requires an installed and running Microsoft
communicator client.
allow_vert_select_in_dim_cr NEW
Allow highlight of model vertices during dimension
eate
placement in drawings
bom_format
CHANGED Sets the BOM format file to be used for a customized
BOM. Specify name and path.
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Values

Default Value

yes, no

yes

yes, no

yes

yes, no

yes

yes, no

no

yes, no

no

<creo2.0_loadpoint>\x86e_win64\gpl
ugs\
---------<creo3.0_loadpoint>\x86e_win64\gpl
ugs\
yes, no

no

yes, no

no

yes, no

yes

yes, no

yes
<creo2.0_loadpoint>\text\format.bft
---------<creo3.0_loadpoint>\text\format.bft
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Category
Drawing

Name
drawing_setup_file

Drawing

pro_palette_dir

Status
Description
CHANGED Sets the default drawing setup file option values for your
Creo Parametric session, otherwise, the system uses the
default drawing setup file option values. Certain
parameters in the file are valid only if you have a license
for Pro/DETAIL.
CHANGED Sets the default directory for drawing symbol palette files.

Values

Drawing

snap_drw_entity_to_snap_lin CHANGED Yes - Enable snapping of drawing and report entities to yes, no
e
snap lines. No - Disable snapping of drawing and report
entities to snap lines.
---------Yes - Enable snapping of drawing and report entities to
snap lines. No - disable snapping of drawing and report
entities to snap lines.
Education & Social enable_sociallink
DELETED Allow Windchill SocialLink to connect with Creo
yes, no
Tools
Parametric. When enabled SocialLink commands will be
added to the Application Menu and the Ribbon bar. Enter
"Yes" to enable SocialLink, and "No" to disable it
Electromechanical bundle_transition_create_me NEW
thod
Electromechanical cable_bundle_transition_leng NEW
th
Electromechanical update_loom_bundle_data

NEW

Environment

activate_window_automatical NEW
ly

Environment

des_exp_confirm_on_save

PTC Inc.

NEW

Control whether bundle transitions are created
automatically. Default is automatic.
Transition length is controlled by the formula Larger
Diameter X <percentile>. Default value is
50&#91;0...250]%.
Setup whether to update loom bundle data from old
harnesses.
Yes - Execute Activate command automatically after a
window is selected. No - Don't execute Activate
command automatically after a window is selected.

automatic, manual

When you use a `Save` command during a Design
Exploration session, it does not save the session, it
prompts to add a new checkpoint.
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Default Value
<creo2.0_loadpoint>\text\prodetail.dtl
---------<creo3.0_loadpoint>\text\prodetail.dtl

<creo2.0_loadpoint>\symbols\palette
\
---------<creo3.0_loadpoint>\symbols\palette
\
yes

no

0.5

yes, no

no

yes, no

yes

yes, no

yes
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Category
Environment

Name
des_exp_create_auto_cps

Status
NEW

Description
Set the maximum number of automatically created
checkpoints allowed. Additional checkpoints override
previous checkpoints. Type a value from 1 to 99. Type 0
to prevent automatic checkpoint creation.

Environment

des_exp_create_backups

NEW

Environment

des_exp_data_path

NEW

Back up all models in session when starting Design
yes, no
Exploration and all models opened and modified during
the session. When backup is on, starting a Design
Exploration session might take some time.
Sets the directory for the Design Exploration session.
The default location is in a default system folder. Type a
valid file path to change the directory to a user defined
one. Data from only one session is stored.

Environment

des_exp_display_type

NEW

Environment

Environment
Environment

Features

Features

PTC Inc.

Set the default display of the Checkpoint Tree. 'Tree' Displays all branches in the Checkpoint Tree. 'Timeline' Displays checkpoints in chronological order
(des_exp_display_type).
des_exp_show_cp_props_di NEW
Open the Checkpoint Properties dialog box when you
alog
add a new checkpoint, or turn an automatic checkpoint
into a regular one.
intelligent_fastener_enabled NEW
Enables Intelligent Fastener. You must restart Creo for
the setting to take effect.
prehighlight_tree
CHANGED Default value for "Preselection Highlighting" option in the
model tree, layer tree and detail tree. When enabled,
selectable items are highlighted prior to being selected in
the tree.
---------Default value for "Preselection Highlighting" option in the
model tree, layer tree, detail tree and layout tree. When
enabled, selectable items are highlighted prior to being
selected in the tree.
auto_add_remove
CHANGED Allows Creo Parametric to automatically switch from add
to remove of material for solid extrude and revolve
during feature creation.
flex_maintain_solution_topol NEW
Initial value for the "Maintain solution topology" option in
ogy
created flexible modeling features.
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Values

Default Value

no

tree, timeline

tree

yes, no

yes

yes, no

yes

yes, no

no

yes, no

no
---------yes
no

yes, no
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Category
File Storage &
Retrieval

Name
pro_font_dir

Status
Description
CHANGED Sets the default font directory (Creo Parametric will load
all fonts in this directory into the drawing regardless of
the contents of the system and working directories).

File Storage &
Retrieval

pro_surface_finish_dir

CHANGED Sets the default directory for your user-defined surface
finish symbols. Use the full pathname to avoid problems.

File Storage &
Retrieval

save_dialog_for_existing_mo CHANGED Controls whether the Save dialog is shown for models
dels
whose storage location is already known.

File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
File Storage &
Retrieval
---------Update Control
Freestyle Feature

save_file_iterations

Layout

layout_feat_copied_geom_thi NEW
ck
enable_param_n_tool_upd_d CHANGED Enables UI for modification of manufacturing parameters
ialog
and tools during "paste special" and UDF placement
procedures.
---------Enable parameters and tool updation dialog.
mfg_tool_preview_by_pick
CHANGED Enables preview of a milling tool at a specified location
on the tool path or geometry of the part.

Manufacturing

Manufacturing

PTC Inc.

Values

yes, no

NEW

Yes - Iterations of a file will be saved. No - Iterations of a yes, no
file will not be saved.
template_boardpart
NEW
Specify the model to use as the default new ECAD board
template.
template_new_ecadasm
NEW
Specify the model to use as the default new ECAD
assembly template.
retrieve_data_sharing_ref_pa CHANGED Automatic reference parts retrieval for dependent data
yes, no, ignore_missing
rts
sharing features.

freestyle_drag_performance NEW

Yes - Improve performance during drag by temporarily
reducing graphics quality. No - No reduction in graphics
quality during drag.
Layout feature - Copied geometry thickness.

100

yes, no

Default Value
<creo2.0_loadpoint>\text\fonts\
---------<creo3.0_loadpoint>\text\fonts\
<creo2.0_loadpoint>\symbols\surffin
s\
---------<creo3.0_loadpoint>\symbols\surffin
s\
yes
---------no
yes

no

yes

1, 3, 2, 4, 5, 1.5, 2.5, 3.5, 1.5
4.5
yes, no
yes

yes, no

no
---------yes
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Category
Manufacturing

Name
ncmdl_bar_stock_part_path

Manufacturing

ncmdl_billet_stock_part_path CHANGED Sets path for storage and retrieval of stock instances for
creating workpiece in NC Model. Specify full path,
including part name, to avoid problems.

Manufacturing
Manufacturing

use_strict_cl_file_names
workpiece_instances

DELETED Use strict cl file names.
yes, no
CHANGED Cut out are created in Workpiece but not the family table none, operations
instances.
---------none, operations, steps,
operations_and_steps

Miscellaneous

conf_mouse_anim

DELETED

Model Display

blended_transparency

Model Display

datum_point_symbol

Model Display

enable_ambient_occlusion

Model Display

max_image_dimension

Model Display

model_detail_options_file

PTC Inc.

Status
Description
CHANGED Sets path for storage and retrieval of stock instances for
creating workpiece in NC Model. Specify full path,
including part name, to avoid problems.

Display the presenter's mouse motions when observing
a shared Creo Parametric session.
CHANGED Yes - Transparent colors will appear using alpha
blending (if supported) when the model is shaded.

Values

yes, no

no

yes, no, independent

yes
---------independent
cross

CHANGED Specifies the shape of datum point symbols displayed in cross, circle, triangle,
Part or Assembly mode.
square
---------dot, cross, circle, triangle,
square
NEW
Enable ambient occlusion. This simulates the effect of
yes, no
light radiating from a real model by darkening the
occluded areas.
CHANGED Set the upper bound dimension on images loaded into
4096, 1024, 2048, 8192,
Creo Parametric. Images larger than this limit will be
16384
rescaled to this upper bound during loading.
CHANGED Sets the path to the file which contains the default model
detail option values for new models.
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Default Value
<creo2.0_loadpoint>\text\ncmdl_data
\ncmdl_bar.prt
---------<creo3.0_loadpoint>\text\ncmdl_data
\ncmdl_bar.prt
<creo2.0_loadpoint>\text\ncmdl_data
\ncmdl_billet.prt
---------<creo3.0_loadpoint>\text\ncmdl_data
\ncmdl_billet.prt
no
none

no

4096
---------16384
<creo2.0_loadpoint>\text\3d_inch.dtl
---------<creo3.0_loadpoint>\text\3d_inch.dtl
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Category
Model Display
Model Display

Name
smooth_lines
update_old_appearance

Status
DELETED
NEW

Notification
Manager
Notification
Manager
Notification
Manager
Notification
Manager
Notification
Manager
Notification
Manager
Notification
Manager
Notification
Manager
Notification
Manager

nmgr_affected_by_dma

NEW

nmgr_dont_show_all

NEW

nmgr_failed

NEW

Description
Choose whether to smooth lines by default or not.
Update pre-Creo 3.0 appearances to their latest values.
Always - update without warning, Never - do not update,
Prompt - issue a warning dialog allowing users to choose
to update or not.
Show notifications for models/features that are affected
by Creo direct modifications.
Ignore current configurations and do not display any
notifications.
Show notifications for failed features/components.

nmgr_misssing_mdl
nmgr_modified_in_dma

Notification
Manager
Notification
Manager
Photorender

PTC Inc.

Values
yes, no
never, always, prompt

no
always

yes, no

yes

yes, no

no

yes, no

yes

NEW

Show notifications for models that could not be reterived. yes, no

yes

NEW

yes, no

yes

yes, no

yes

yes, no

yes

yes, no

yes

yes, no

yes

yes, no

yes

yes, no

no

Show notifications for models/features that were
modified in Creo Direct.
nmgr_outdated_mathcad
NEW
Show notifications for models that contain MathCad
Sheet with values different from Creo values.
nmgr_outdated_non-native NEW
Show notifications for non-native models that are not upto-date with respect to source.
nmgr_outdated_pdm
NEW
Show notifications for models that are not up-to-date with
recent PDM model version.
nmgr_pending_dma
NEW
Models that were modified in Creo Direct and not
reviewed. The changes should be accepted or rejected
in the View Creo Changes dialog
nmgr_reference_changed
NEW
Show notifications for models/features whose references
were changed since last regeneration.
nmgr_reference_out_of_sess NEW
Show notifications for models/features with references
ion
not in session.
default_scene_filename
CHANGED Complete path to the scene file to be used as default
scene file.

102

Default Value

<creo2.0_loadpoint>\graphiclibrary\scenes\/creo_default_scene.s
cn
---------<creo3.0_loadpoint>\graphiclibrary\scenes\/creo_default_scene.s
cn
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Category
Piping

Name
isogen_attribute_map_file

Status
Description
CHANGED Specifies the mapping between isogen parameter and
attribute name.

Piping

isogen_endtype_map_file

CHANGED Specify name of file mapping Pro/Piping endtypes with
ISOGEN endtypes

Piping

isogen_nominal_size_map_fi CHANGED Specify name of file mapping Pro/Piping Size with
le
Nominal Sizes in MM and Inches

Piping

isogen_symbol_map_file

Piping

pipeline_assembly_library_di CHANGED Sets the default pipeline assembly library directory.
r

PTC Inc.

CHANGED Specify name of file for mapping Pro/Piping selection
names with ISOGEN symbol keys (SKEY)s
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Values

Default Value
<creo2.0_loadpoint>\text\piping_data
\isodata\isogen_attribute_map.ptd
---------<creo3.0_loadpoint>\text\piping_data
\isodata\isogen_attribute_map.ptd

<creo2.0_loadpoint>\text\piping_data
\isodata\isogen_endtype_map.ptd
---------<creo3.0_loadpoint>\text\piping_data
\isodata\isogen_endtype_map.ptd

<creo2.0_loadpoint>\text\piping_data
\isodata\isogen_nominal_size_map.p
td
---------<creo3.0_loadpoint>\text\piping_data
\isodata\isogen_nominal_size_map.p
td
<creo2.0_loadpoint>\text\piping_data
\isodata\isogen_symbol_map.ptd
---------<creo3.0_loadpoint>\text\piping_data
\isodata\isogen_symbol_map.ptd

<creo2.0_loadpoint>\text\piping_data
\pipelinelib\
---------<creo3.0_loadpoint>\text\piping_data
\pipelinelib\
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Category
Piping

Name
Status
Description
piping_appearance_map_file CHANGED Sets the default piping appearance map filename.

Piping

piping_bolt_nut_select_file

Piping

piping_end_compatibility_file CHANGED Sets the default piping end compatibility filename.

Piping

piping_fitt_category_map_file CHANGED Sets the default piping fitting category map filename.

Piping

piping_fitt_library_dir

PTC Inc.

CHANGED Piping bolts and nuts selection file.

CHANGED Sets the default piping fitting library directory.
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Values

Default Value
<creo2.0_loadpoint>\text\piping_data
\master_catalog\piping_appearance.
map
---------<creo3.0_loadpoint>\text\piping_data
\master_catalog\piping_appearance.
map
<creo2.0_loadpoint>\text\piping_data
\master_catalog\piping_bolt_nut_sel
ect.ptd
---------<creo3.0_loadpoint>\text\piping_data
\master_catalog\piping_bolt_nut_sel
ect.ptd
<creo2.0_loadpoint>\text\piping_data
\master_catalog\piping_end_compati
bility.ptd
---------<creo3.0_loadpoint>\text\piping_data
\master_catalog\piping_end_compati
bility.ptd
<creo2.0_loadpoint>\text\piping_data
\sample_project\piping_fitt_category
_map.ptd
---------<creo3.0_loadpoint>\text\piping_data
\sample_project\piping_fitt_category
_map.ptd
<creo2.0_loadpoint>\text\piping_data
\fittinglib\
---------<creo3.0_loadpoint>\text\piping_data
\fittinglib\
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Category
Piping

Name
piping_insulation_dir_file

Status
Description
CHANGED Sets the default piping insulation directory filename.

Piping

piping_manufacture_dir_file

CHANGED Sets the default piping manufacture directory filename.

Piping

piping_material_file

CHANGED Sets the default piping material filename.

Piping

piping_mcat_dir

CHANGED Sets the default piping master catalog directory.

Piping

piping_mcat_dir_file

CHANGED Sets the default piping master catalog directory filename.

Piping

piping_project_data_dir

CHANGED Sets the default Project data directory.

PTC Inc.
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Default Value
<creo2.0_loadpoint>\text\piping_data
\sample_project\piping_insulation_dir
.ptd
---------<creo3.0_loadpoint>\text\piping_data
\sample_project\piping_insulation_dir
.ptd
<creo2.0_loadpoint>\text\piping_data
\master_catalog\piping_manufacture
_dir.ptd
---------<creo3.0_loadpoint>\text\piping_data
\master_catalog\piping_manufacture
_dir.ptd
<creo2.0_loadpoint>\text\piping_data
\master_catalog\piping_material.ptd
---------<creo3.0_loadpoint>\text\piping_data
\master_catalog\piping_material.ptd

<creo2.0_loadpoint>\text\piping_data
\master_catalog\
---------<creo3.0_loadpoint>\text\piping_data
\master_catalog\
<creo2.0_loadpoint>\text\piping_data
\master_catalog\piping_mcat_dir.ptd
---------<creo3.0_loadpoint>\text\piping_data
\master_catalog\piping_mcat_dir.ptd

<creo2.0_loadpoint>\text\piping_data
\sample_project\
---------<creo3.0_loadpoint>\text\piping_data
\sample_project\
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Category
Piping

Name
piping_spec_dir_file

Status
Description
CHANGED Sets the default piping specification directory filename.

Piping

units_system_dic_file

CHANGED Specifies the file containing the mapping for MCAT
filename and units.

Printing & Plotting

u3d_create_color_surfaces

NEW

Reference Control

allow_direct_ref_to_layout_fil NEW
e
def_comp_ref_ctrl_exception NEW

Reference Control

Reference Control

def_multiple_backup_prompt NEW
_num

Reference Control

def_obj_feat_refs_to_backup NEW

Reference Control

def_obj_place_refs_to_back NEW
up

Reference Control

def_obj_ref_ctrl_exception

PTC Inc.

NEW

YES- Exports color of each surface of model. NOExports one color per model. Default NO.
Allow direct references to layout files through layout
feature.
Default setting for newly created components that
allows/disallows referencing entities forbidden by
Reference Control settings.
Number of selected components that will invoke
confirmation before multi-component backing up
placement references.
Default setting that controls the level of feature backup
for newly created models. Other_models: all references
to other models will be backed up, Non_permitted: only
references that were created despite the initial
restrictions will be backed up.
Default setting that controls the level of placement
backup for newly created models. Other_models: all
references to other models will be backed up,
Non_permitted: only references that were created
despite the initial restrictions will be backed up.
Default setting for newly created models that
allows/disallows referencing entities forbidden by
Reference Control settings.
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Default Value
<creo2.0_loadpoint>\text\piping_data
\sample_project\piping_spec_dir.ptd
---------<creo3.0_loadpoint>\text\piping_data
\sample_project\piping_spec_dir.ptd

yes, no

<creo2.0_loadpoint>\text\piping_data
\master_catalog\piping_units_system
_dic_file.ptd
---------<creo3.0_loadpoint>\text\piping_data
\master_catalog\piping_units_system
_dic_file.ptd
no

yes, no

no

yes, no

yes
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none, other_models,
non_permitted

non_permitted

all, none, other_models,
non_permitted

non_permitted

yes, no

yes
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Category
Reference Control

Name
default_comp_invalid_refs

Status
DELETED

Reference Control

default_object_invalid_refs

DELETED

Reference Control

feat_references_to_backup

NEW

Reference Control
Reference Control

placement_references_to_ba NEW
ckup
ref_control_allow_exceptions NEW

Reference Control

scope_invalid_refs

DELETED

Sheetmetal
Sketcher

NEW
NEW

Sketcher
Sketcher

die_models_directory
dma_sketcher_guide_width_f
actor
sketcher_disp_guides
sketcher_snap_sensitivity

Style Feature
System

style_merge_surfaces
csv_format_delimeter

NEW
Merge surfaces on exit from the Style Feature
CHANGED Define the delimiter character in BOM format file:
Comma, TAB, Semicolon, Space or other user-defined.
---------Define the delimeter character in BOM format file:
Comma, TAB, Semicolon, Space or other user-defined

PTC Inc.

Description
Set the specified handling method of out-of-scope
Accessible references to newly added components.
Sets default condition for reference handling. Prohibit System will abort all attempts to create ext. reference
that violates scope. Copy - System will issue warning
upon all attempts to create ext. reference that violates
scope.
Level of backup for feature references
Level of backup for placement references

Values
copy, prohibit

copy

copy, prohibit

copy

none, other_models,
non_permitted
all, none, other_models,
non_permitted
yes, no

non_permitted

Check to allow referencing components that are not
permitted by the above setting
Prohibit - System will abort all attempts to create external copy, prohibit
reference violating the scope. Backup - Warning
appears. Abort reference creation or declare as out-ofscope reference. If you declare, backup copies to
part/assembly and backup is referenced.
Sets path to directory that contains the die models.
Guide width as a proportion of sketched line width

non_permitted
yes
copy

0.75

NEW
Shows guides when sketching.
CHANGED sketcher snap sensitivity
---------Adjusts the sensitivity of the snapping to geometry.
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Default Value

yes, no
high, medium, low,
very_high, very low, very
high, very_low
---------high, medium, low,
very_high, very_low
yes, no
comma, tab, semicolon,
space

yes
very high
---------very_high

yes
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Category
System

Name
web_browser_homepage

Status
Description
CHANGED Enter location of Creo Parametric browser home page.

System

windows_browser_type

CHANGED Select the type of embedded browser to use.

Update Control

NEW

Update Control

child_of_layout_backup_upd
ate
copied_feat_refs_update_sta
te
copied_place_refs_update_st
ate
direct_child_of_layout_updat
e
individual_child_update

Update Control

new_cg_update_state

NEW

Update Control
User Interface

new_layout_feature_update_ NEW
state
drm_policy_server
DELETED

User Interface

initial_drm_warning

DELETED

Without category

accessory_window_above

CHANGED Yes - Displays and keep the accessory window above
the active window. No - Does not keep the accessory
window above the active window.
---------Yes - Displays and keeps the accessory window above
the active window. No - Does not keep the accessory
window above the active window.

Update Control
Update Control
Update Control

PTC Inc.

NEW

Set the default update state for a child referencing the
layout feature's geometry.
Copied Feature References Update

NEW

Copied Placement References Update

NEW

Set the default update state for a child directly
referencing the layout model through layout feature.
Allow individual update control for children of layout
feature.
Set the default update state for newly created Copy
Geometry features relative to the reference model.
Define the default update state of a new DSF created.

NEW

ie_in_process,
ie_in_sep_process,
mozilla_based_browser
---------ie_browser
manual, auto, notify

Allows a user to preset the server policy that is to be
used when Apply Policy command is utilized.
Warns the user that they are initiating a DRM session.
When set to "no", this warning dialog will be skipped.
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Values

Default Value
<creo2.0_loadpoint>\help\usascii\res
ource_center_index.html
---------<creo3.0_loadpoint>\help\usascii\res
ource_center_index.html
ie_in_process
---------ie_browser

auto

manual, auto, notify,
no_dependency
manual, auto, notify,
no_dependency
manual, auto, notify

auto

yes, no

yes

manual, auto, notify

auto

manual, auto, notify

notify

yes, no

yes

yes, no

no

auto
notify
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Category
Without category

Without category

Without category
Without category
Without category

Without category

Without category

Without category

Without category
Without category
Without category
Without category

PTC Inc.

Name
auto_center_dimension

Status
NEW

Description
Automatically centers the dimension text between
witness lines. For common reference dimensions,
controls the centering of the first dimension only.
backup_reference_informatio NEW
Yes-Backup the reference information of a feature once
n
the feature regenerates successfully. No- Do not save
the reference information of a feature.
comp_placement_legacy_mo NEW
Show the legacy Move tab in the Component Placement
ve
dashboard
confirm_on_edit_foreign_mo NEW
Provides a confirmation dialog when attempting to make
dels
design changes to foreign models
des_exp_folder
NEW
Sets the directory for the Design Exploration session.
The default location is in a default system folder. Type a
valid file path to change the directory to a user defined
one.
edge_tess_quality
CHANGED Set the accuracy level for arc tessllation.
---------Set the accuracy level for arc tessellation.
flex_display_dflt_bounding_e NEW
Turns on/off highlighted display of default bounding
dge
edges in flexible modeling features that can have
multiple solutions.
flex_dma_reduce_solution_n NEW
Reduces the number of default solutions found in Flex
umber
features, when modifying geometry with mixed convexity
contours.
flex_tan_propagation_default NEW
Defines default state of the Tangency Propagation option
in Flexible Modeling features.
intf_nx_version
NEW
Sets the version of NX interface.
intf3d_out_nx_version
NEW
Allows the user to switch between the default and
alternate converter version for export to NX
layout_smart_constraints
CHANGED
---------To improve the user experience, specific entity types are
appropriately constrained by default (i.e. - fillets with
tangency constraints). Yes - specific entity types will be
created with appropriate constraints by default; No constraints will never be automatically created for any
entity type.
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Values

Default Value

yes, no

no

yes, no

yes

yes, no

yes

yes, no

no

high, medium, low

low

yes, no

yes

yes, no

yes

off, on

off

6, 7, 8
3, 5, 7

6
3

yes, no

yes
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Category
Without category

Name
measure_ref_option_status

Without category

pro_design_test_mode_dir

Without category

ptc_manikin_library_path

Without category

Without category

Without category

Without category
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Status
Description
Values
CHANGED Determine AsObject (AsCenter et al.) checkbox option
default, all_on, all_off,
behavior in Measure Tool
keep_last
---------Determine As Object (As Center et al.) checkbox option
behavior in Measure Tool
DELETED Sets the default directory for the Design Test mode data.
If not specified, your current working directory is the
default. Use the full pathname to avoid problems.

CHANGED Sets the default directory for the Creo Parametric
manikin library (or custom manikin libraries you built
containing the proper index menu files). Use the full path
name to avoid problems. You must restart Creo
Parametric for the change to take effect.
relations_ang_eval_diff_chec NEW
Check for differences in the evaluation of relation sets
k
evaluated and saved in versions of Creo 2.0 prior to
M110. Warn_message Check and give a warning in the
message area. Warn_dialog Check and give a warning
in a message window. Ignore Skip the check and
warning.
show_axes_by_view_scope CHANGED Determines the scope of the Show Model Annotations
tool when showing model datums and selecting a
drawing view. For large assembly drawings, use
top_model_only to improve performance by restricting
the set of axes to be shown.
suppress_dim_ghost_with_ct NEW
rl

<creo2.0_loadpoint>\manikin_lite\
---------<creo3.0_loadpoint>\manikin_lite\

ignore, warn_message,
warn_dialog

warn_message

top_model_only,
all_sub_models

all_sub_models
---------top_model_only

Suppress the ghost image of dimension when CTRL is
yes, no
pressed. It allows better visibility while selecting further
dimension references.
tool_mgr_save_pocket_in_x CHANGED Determines whether tool position should be saved in a
yes, no
ml
XML file (*.txf) created in tool manager dialog.
---------Determines whether the tool position should be saved in
a XML file (*.txf) created in tool manager dialog.
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Default Value
default

no

no
---------yes
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Category
Without category

Name
visible_recent_files

Without category
---------Assembly
Without category
---------Data Exchange

new_wf5_simp_rep_ui

Without category
---------Data Exchange
Without category
---------Data Exchange
Without category
---------Data Exchange
Without category
---------Data Exchange
Without category
---------Data Exchange
Without category
---------Drawing
Without category
---------Electromechanical

Status
Description
Values
CHANGED Number of visible recent files. The possible range is 1 25.
---------Number of visible recent files. The possible range is 1 30.
CHANGED Yes - Use Component Chooser base Simp Rep UI, No - yes, no
Use old Simp Rep definition UI.

Default Value
13
---------21

yes

ecad_load_filtered_holes_to_ CHANGED Controls whether "ECAD import holes configs"
yes, no
ui
(ecad_pin_hole_import & ecad_via_hole_import) will
remove holes completely from the import (default) or just
pre-set the holes filter UI condition.
ecad_outline_holes_exp_met CHANGED Select how holes that are placed on the board outline be default, arcs
hod
exported.

no

intf_pdf_u3d_create_u3d_file CHANGED YES - When exporting a Creo Parametric model as PDF yes, no
s
U3D file, create a U3D file of the same name as the PDF
file.
intf2d_out_blanked_layers
CHANGED Enables export of blanked layer entities. If an entity is
yes, no
placed on a layer that is blanked and this option is set to
YES, the entity will be exported.
intf3d_out_jt_config_name
CHANGED Name of JT configuration file.

no

default

no

intf3d_out_jt_config_path

CHANGED Path to JT configuration file.

warn_if_iso_tol_missing

CHANGED Yes - Returns the user to the dimension properties dialog yes, no
to select a different table. No - Applies the tolerance
according to existing functionality.
CHANGED Yes - Uses the extract bundle algorithm. No - Does not yes, no
use the extract bundle algorithm.

no

Without category
ignore_bundles_in_find_cabl CHANGED Include bundles and overbraids in the query results when yes, no
---------es
the model or logical data is queried for unrouted items.
Electromechanical

no

PTC Inc.

boeing_extract_bundle
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no
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Category
Name
Status
Description
Without category
smaller_bundle_min_bend_r CHANGED Setup whether to consider the thickness of the bundle
---------ad
when set up the minimum bend radius.
Electromechanical

Values

Default Value

yes, no

no

Without category
trace_thru_splice_connector CHANGED Report the from/to connectors of cables passing through yes, no
---------splices correctly.
Electromechanical

no

Without category
---------Layers
Without category
---------Piping
Without category
---------Reference Control

save_hidden_items_w_statu CHANGED The items on the "Hidden Items" temporary layer are
s
stored permanently when layer display status is saved
with Save Status command.
pipe_3d_bend_theor_int_pts CHANGED Yes - Displays theoretical intersections and bends in
three-dimensional models.

yes, no

yes

yes, no

no

default_ext_ref_scope

CHANGED Set default scope for externally referenced models. All Any model. None - Only current model and children.
Skeletons - Any component in model's assembly and
higher skeletons on branch. Subassembly - Only
components and children in model's assembly.

all, none, subassemblies, all
skeleton_model

Without category
---------System

display_ie8_warning_dialog

CHANGED Show/Hide the warning dialog related to Internet Explorer yes, no
8 running in Compatibility Mode

PTC Inc.
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yes
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